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Getting Started with Windows and Windows
Mobile Development

Use advanced Sybase® Unwired Platform features to create applications for Windows and
Windows Mobile devices. The audience is advanced developers who may be new to Sybase
Unwired Platform.

This guide describes requirements for developing a device application for the platform, how to
generate application code, and how to customize the generated code using the Client Object
API. Also included are task flows for the development options, procedures for setting up the
development environment, and Client Object API documentation.

Companion guides include:

• Sybase Unwired WorkSpace – Mobile Business Object Development
• Tutorial: Windows Mobile Application Development, where you create the SUP101

sample project referenced in this guide.
Complete the tutorials to gain a better understanding of Unwired Platform components
and the development process.

• Troubleshooting for Sybase Unwired Platform.
• A complete Client Object API reference is available in the Unwired Platform installation

directory <UnwiredPlatform_InstallDir>\MobileSDK213\ObjectAPI
\apidoc\cs.

• Fundamentals contains high-level mobile computing concepts, and a description of how
Sybase Unwired Platform implements the concepts in your enterprise.

Object API Applications
Object API applications are customized, full-featured mobile applications that use mobile
data model packages, either using mobile business objects (MBOs) or Data Orchestration
Engine, to facilitate connection with a variety of enterprise systems and leverage
synchronization to support offline capabilities.

The Object API application model enables developers to write custom code — C#, Java, or
Objective-C, depending on the target device platform — to create device applications.

Development of Object API applications provides the most flexibility in terms of leveraging
platform specific services, but each application must be provisioned individually after being
compiled, even for minor changes or updates.

Development involves both server-side and client-side components. Unwired Server brokers
data synchronization and transaction processing between the server and the client
components.

Getting Started with Windows and Windows Mobile Development
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• Server-side components address the interaction between the enterprise information
system (EIS) data source and the data cache. EIS data subsets and business logic are
encapsulated in artifacts, called mobile business object packages, that are deployed to
Unwired Server.

• Client-side components are built into the mobile application and address the interaction
between the data cache and the mobile device data store. This can include synchronizing
data with the server, offline data access capabilities, and data change notification.

These applications:

• Allow users to connect to data from a variety of EIS systems, including SAP® systems.
• Build in more complex data handling and logic.
• Leverage data synchronization to optimize and balance device response time and need for

real-time data.
• Ensure secure and reliable transport of data.

Best Uses for Object API Applications
Synchronization applications provide operation replay between the mobile device, the
middleware, and the back-end system. Custom native applications are designed and built to
suit specific business scenarios from the ground up, or start with a bespoke application and be
adapted with a large degree of customization.

Cache Synchronization
Cache synchronization allows mapping mobile data to SAP Remote Function Calls (RFCs)
using Java Connector (JCO) and to other non-SAP data sources such as databases and Web
services. When Sybase Unwired Platform is used in a stand-alone manner for data
synchronization (without Data Orchestation Engine), it utilizes an efficient bulk transfer and
data insertion technology between the middleware cache and the device database.

In an Unwired Platform standalone deployment, the mobile application is designed such that
the developer specifies how to load data from the back end into the cache and then filters and
downloads cache data using device-supplied parameters. The mobile content model and the
mapping to the back end are directly integrated.

This style of coupling between device and back-end queries implies that the back end must be
able to respond to requests from the middleware based on user-supplied parameters and serve
up mobile data appropriately. Normally, some mobile-specific adaptation is required within
SAP Business Application Programming Interfaces (BAPI). Because of the direct nature of
application parameter mapping and RBS protocol efficiencies, Sybase Unwired Platform
cache synchronization deployment is ideal:

• With large payloads to devices (may be due to mostly disconnected scenarios)
• Where ad hoc data downloads might be expected

Getting Started with Windows and Windows Mobile Development
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• For SAP® or non-SAP back ends

Large payloads, for example, can occur in task worker (service) applications that must access
large product catalogs, or where service occurs in remote locations and workers might
synchronize once a day. While Sybase Unwired Platform synchronization does benefit from
middleware caching, direct coupling requires the back end to support an adaptation where
mobile user data can be determined.

Client Runtime Architecture
The goal of synchronization is to keep views (that is, the state) of data consistent among
multiple tiers. The assumption is that if data changes on one tier (for example, the enterprise
system of record), all other tiers interested in that data (mobile devices, intermediate staging
areas/caches and so on) are eventually synchronized to have the same data/state on that
system.

The Unwired Server synchronizes data between the device and the back-end by maintaining
records of device synchronization activity in its cache database along with any cached data
that may have been retrieved from the back-end or pushed from the device. The Unwired
Server employs several components in the synchronization chain.

Mobile Channel Interfaces
Mobile channel interfaces provide a conduit for transporting data to and from remote devices.
Two main channel interfaces provide messaging and replication.

• The messaging channel serves as the abstraction to all device-side notifications
(BlackBerry Enterprise Service, Apple Push Notification Service, and others) so that
when changes to back-end data occur, devices can be notified of changes relevant for their
application and configuration.
The messaging channel sends these types of notifications:
• Change notifications - when Unwired Server detects changes in the back-end EIS,

Unwired Server can send a notification to the device. By default, sending change
notifications is disabled, but you can enable sending change notifications per
synchronization group.
To capture change notifications, you can register an onSynchronize callback. The
synchronization context in the callback has a status you can retrieve.

• When synchronizing, operation replay records are sent to the Unwired Server and the
messaging channel sends a notification of replayFinished. The application must
call another synchronize method to retrieve the result.

• The synchronization channel sends data to keep the Unwired Server and client
synchronized. The synchronization is bi-directional.

Mobile Middleware Services
Mobile middleware services (MMS) arbitrate and manage communications between device
requests from the mobile channel interfaces in the form that is suitable for transformation to a

Getting Started with Windows and Windows Mobile Development

Developer Guide: Windows and Windows Mobile Object API Applications 3



common MBO service request and a canonical form of enterprise data supplied by the data
services.

Data Services
Data services is the conduit to enterprise data and operations within the firewall or hosted in
the cloud. Data services and mobile middleware services together manage the cache database
(CDB) where data is cached as it is synchronized with client devices.

Once a mobile application model is designed, it can be deployed to the Unwired Server where
it operates as part of a specialized container-managed package interfacing with the mobile
middleware services and data services components. Cache data and messages persist in the
databases in the data tier. Changes made on the device are passed to the mobile middleware
services component as an operation replay and replayed against the data services interfaces
with the back-end. Data that changes on the back- end as a result of device changes, or those
originating elsewhere, are replicated to the device database.

Documentation Roadmap for Unwired Platform
Sybase® Unwired Platform documents are available for administrative and mobile
development user roles. Some administrative documents are also used in the development and
test environment; some documents are used by all users.

See Documentation Roadmap in Fundamentals for document descriptions by user role.
Fundamentals is available on the Sybase Product Documentation Web site.

Check the Sybase Product Documentation Web site regularly for updates: access http://
sybooks.sybase.com/nav/summary.do?prod=1289, then navigate to the most current version.

Getting Started with Windows and Windows Mobile Development
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Development Task Flow for Object API
Applications

Describes the overall development task flow for Object API applications, and provides
information and procedures for setting up the development environment, and developing
device applications.

This diagram illustrates how you can develop a device application directly from mobile
business objects (MBOs), using the Object API and custom device application coding. This is
how you create device applications with sophisticated UI interaction, validation, business
logic, and performance.

The Object API provides the core application services described in the diagram.

The Authentication APIs provide security by authenticating the client to the Unwired Server.

The Synchronization APIs allow you to synchronize mobile business objects (MBOs) based
on synchronization parameters, for individual MBOs, or as a group, based on the group's
synchronization policy.

The Application and Connection APIs allow clients to register with and connect to the
Unwired Server. The Callback Handler and Listener APIs, and the Target Change Notification
APIs provide notifications to the client on operation success or failure, or changes in data.

With non-DOE-based applications, connectivity uses the MobiLink channel and notifications
use the Messaging channel.

Development Task Flow for Object API Applications
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Installing the Windows Mobile Development Environment
Install and configure components required for Windows Mobile development.

Configuring Windows Mobile Device Center
Before using the Windows Mobile Device Emulator, you need to change the settings of
Windows Mobile Device Center.

1. Open Windows Mobile Device Center.

2. Click Mobile Device Settings.

3. Click Connection Settings.

4. Click on the Allow connections to one of the following checkbox.

5. Select DMA in the combobox.

6. On the This computer is connected to combobox, select The Internet if you want to
allow the Windows Mobile device to access the Internet using Pocket IE.

7. Start the Windows Mobile Device Emulator.

Enabling Network Access from the Windows Mobile Device Emulator
This task enables the emulator's connectivity.

You can start the Windows Mobile Device Emulator from Visual Studio or from the Device
Emulator Manager.

1. To start the Emulator from Visual Studio 2008:

a) Select Tools > Device Emulator Manager.

2. If a Device Emulator is not yet connected:

a) Select a Device Emulator from the list and select Connect.

3. Right-click the current Emulator in Device Emulator Manager and select Cradle.

ActiveSync starts. Once the connection is established, you should be able to access your
PC and the Web from the Device Emulator.

Installing Microsoft Synchronization Software
Install and configure Microsoft synchronization software so you can deploy and run a mobile
application on a Windows Mobile emulator.

Note: Microsoft ActiveSync is for Windows XP. If you are using Windows Vista, Windows 7,
or Windows 2008, install Virtual PC 2007 SP1 and Windows Mobile Device Center to manage
synchronization settings. Download the Windows Mobile Device Center from http://
www.microsoft.com/windowsmobile/en-us/downloads/microsoft/device-center-
download.mspx.

Development Task Flow for Object API Applications
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1. Download Microsoft ActiveSync from http://www.microsoft.com/windowsmobile/en-
us/help/synchronize/device-synch.mspx. Save it to your local machine. Windows XP
requires ActiveSync version 4.5.

2. In Windows Explorer, double-click setup.msi.

3. When installation is complete, restart your machine.

ActiveSync starts automatically, and its icon appears in the Windows toolbar.

4. Double-click the ActiveSync icon.

5. Select File > Connection Settings.

6. Select Allow Connections to One of the Following, then select DMA.

7. Under This Computer is Connected to, select Work Network.

8. Click OK.

Installing X.509 Certificates on Windows Mobile Devices and
Emulators

Install the .p12 certificate on the Windows Mobile device or emulator and select it during
authentication. A certificate provides an additional level of secure access to an application,
and may be required by an organization's security policy.

1. Launch the simulator or device.

2. Start the Windows synchronization software and cradle the device.

3. Use File Explorer to copy the *.p12 certificate to the simulator or device.

4. Navigate to and double-click the certificate.

5. Enter the password at the prompt and click Done.

An informational window indicates the certificate installed successfully.

Development Task Flow for Object API Applications
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Generating C# Object API Code
Generate object API code containing mobile business object (MBO) references, which allows
you to use APIs to develop device applications for Windows or Windows Mobile devices. You
can generate code either in Sybase Unwired WorkSpace, or by using a command-line utility
for generating code.

Generating C# Object API Code Using Sybase Unwired WorkSpace
Use Sybase Unwired WorkSpace to generate object API code containing mobile business
object (MBO) references.

Prerequisites

Develop the MBOs that will be referenced in the device applications you are developing. A
mobile application project must contain at least one non-online MBO. You must have an active
connection to the datasources to which the MBOs are bound.

Task
Unwired Platform provides the Code Generation wizard for generating object API code. Code
generation creates the business logic, attributes, and operations for your mobile business
object.

1. Launch the Code Generation wizard.

From Action

Mobile Application
Diagram

Right-click within the Mobile Application Diagram and select
Generate Code.

WorkSpace
Navigator

Right-click the Mobile Application project folder that contains
the mobile objects for which you are generating API code, and
select Generate Code.

2. (Optional; this page of the code generation wizard is seen only if you are using the
Advanced developer profile) Enter the information for these options, then click Next:

Development Task Flow for Object API Applications
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Option Description

Code generation
configuration

A table lists all existing named configurations plus the most recently used
configuration. You can select any of these, click Next, and proceed. Ad-
ditionally, you can:
• Create new configuration – click Add and enter the Name and optional

Description of the new configuration and click OK to save the con-
figuration for future sessions. You can also select Copy from to copy
an existing configuration which can then be modified.

• Most recent configuration – if you click Next the first time you gen-
erate code without creating a configuration, the configuration is saved
and displays as the chosen configuration the next time you invoke the
code generation wizard. If the most recent configuration used is a
named configuration, it is saved as the first item in the configuration
table, and also "Most recent configuration", even though it is still listed
as the original named configuration.

3. Click Next.

4. In Select Mobile Objects, select all the MBOs in the mobile application project or select
MBOs under a specific synchronization group, whose references, metadata, and
dependencies (referenced MBOs) are included in the generated device code.

Dependent MBOs are automatically added (or removed) from the Dependencies section
depending on your selections.

Unwired WorkSpace automatically computes the default page size after you choose the
MBOs based on total attribute size. If an MBO's accumulated attribute size is larger than
the page size setting, a warning displays.

5. Enter the information for these configuration options:

Option Description

Language Select C#.

Platform Select the platform ( target device) for which
the device client code is intended.
• C#

• .NET Framework for Windows
• .NET Compact Framework 3.5 for

Windows Mobile

Unwired Server Specify a default Unwired Server connection
profile to which the generated code connects at
runtime.

Development Task Flow for Object API Applications

Developer Guide: Windows and Windows Mobile Object API Applications 9



Option Description

Server domain Choose the domain to which the generated code
will connect. If you specified an Unwired Serv-
er to which you previously connected success-
fully, the first domain in the list is chosen by
default. You can enter a different domain man-
ually.

Note: This field is only enabled when an Un-
wired Server is selected.

Page size (Optional) Select the page size for the gener-
ated client code. If the page size is not set, the
default page size is 4KB at runtime. The default
is a proposed page size based on the selected
MBO's attributes. The maximum page size is
16KB.

The page size should be larger than the sum of
all attribute lengths for any MBO that is inclu-
ded with all the MBOs selected, and must be
valid for the database. If the page size is
changed, but does not meet these guidelines,
object queries that use string or binary attrib-
utes with a WHERE clause may fail.

A binary length greater than 32767 is converted
to a binary large object (BLOB), and is not in-
cluded in the sum; a string greater than 8191 is
converted to a character large object (CLOB),
and is also not included). If an MBO attribute's
length sum is greater than the page size, some
attributes automatically convert to BLOB or
CLOB, and therefore cannot be put into a
WHERE clause.

Note: This field is only enabled when an Un-
wired Server is selected.

Destination Specify the destination of the generated device
client files. Enter (or Browse) to either a
Project path (Mobile Application project) lo-
cation or File system path location. Select
Clean up destination before code generation
to clean up the destination folder before gener-
ating the device client files.

6. Select Generate metadata classes to generate metadata for the attributes and operations
of each generated client object.

Development Task Flow for Object API Applications
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The Including object manager classes option is only available if you select Generate
metadata classes.

7. Select Including object manager classes to generate both the metadata for the attributes
and operations of each generated client object and an object manager for the generated
metadata.

The Including object manager classes option is enabled only for BlackBerry and C# if
you select Generate metadata classes. The object manager allows you to retrieve the
metadata of packages, MBOs, attributes, operations, and parameters during runtime using
the name instead of the object instance.

8. Click Finish.

9. Examine the generated code location and contents.

10. Validate the generated code.

Generating Object API Code Using the Code Generation Utility
Use the Code Generation Utility to generate object API code containing mobile business
object (MBO) references. This method of generating code allows you to automate the process
of code generation, for example through the use of scripts.

Prerequisites

• Use Unwired WorkSpace to develop and package your mobile business objects. See
Sybase Unwired WorkSpace - Mobile Business Object Development > Develop >
Developing a Mobile Business Object.

• Deploy the package to Unwired Server, creating files required for code generation from
the command line. See Sybase Unwired WorkSpace - Mobile Business Object
Development > Develop > Packaging and Deploying Mobile Business Objects
>Automated Deployment of Unwired WorkSpace Projects

Task

1. Locate <domain name>_package.jar in your mobile project folder. For the
SUP101 example, the project is deployed to the default domain, and the deploy jar file is in
the following location: SUP101\Deployment\.pkg.profile
\My_Unwired_server\default_package.jar.

2. Make sure that the JAR file contains this file:

• deployment_unit.xml
3. Use a utility to extract the deployment_unit.xml file to another location.

4. From <UnwiredPlatform_InstallDir>\MobileSDK\ObjectAPI\Utils
\bin, run the codegen.bat utility, specifying the following parameters:

codegen.bat -cs -client -ul deployment_unit.xml [-output 
<output_dir>] [-doc]

Development Task Flow for Object API Applications
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• The -output parameter allows you to specify an output directory. If you omit this
parameter, the output goes into the <UnwiredPlatform_InstallDir>
\MobileSDK\ObjectAPI\Utils\genfiles directory, assuming
codegen.bat is run from the <UnwiredPlatform_InstallDir>\MobileSDK
\ObjectAPI\Utils\genfiles directory.

• The -doc parameter specifies that documentation is generated for the generated code.

Ignore these warnings:
log4j:WARN No appenders could be found for logger ...
log4j:WARN Please initialize the log4j system properly.

Generated Code Location and Contents
If you generated code in Unwired WorkSpace, generated object API code is stored by default
in the "Destination" location you specified during code generation. If you generated code with
the Code Generation Utility, generateed object API code is stored in the
<UnwiredPlatform_InstallDir>\UnwiredPlatform\MobileSDK
\ObjectAPI\Utils\genfiles folder after you you generate code .

The contents of the folder is determined by the options you selected in the Generate Code
wizard in Unwired WorkSpace, or specified in the Code Generation Utility. The contents
include generated class (.cs) files that contain:

• MBO – class which handles persistence and operation replay of your MBOs.
• Synchronization parameters – any synchronization parameters for the MBOs.
• Personalization parameters – personalization parameters used by the package.
• Metadata – Metadata class that allow you to query meta data including MBOs, their

attributes, and operations, in a persistent table at runtime..

Validating Generated Code
Validation rules are enforced when generating client code. Define prefix names in the Mobile
Business Object Preferences page of the Code Generation wizard to correct validation errors.

Sybase Unwired WorkSpace validates and enforces identifier rules and checks for keyword
conflicts in generated code, for example, by displaying error messages in the Properties view
or in the wizard. Other than the known name conversion rules (converting '.' to '_', removing
white space from names, and so on), there is no other language-specific name conversion. For
example, cust_id is not changed to custId.

You can specify the prefix string for mobile business object, attribute, parameter, or operation
names from the Mobile Business Object Preferences page. This allows you to decide what
prefix to use to correct any errors generated from the name validation.

1. Select Window  > Preferences.

2. Expand Sybase, Inc > Mobile Development.

3. Select Mobile Business Object.

Development Task Flow for Object API Applications
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4. Add or modify the Naming Prefix settings as needed.

The defined prefixes are added to the names (object, attribute, operation, and parameter)
whenever these are autogenerated, for example, when you drag and drop a data source onto the
Mobile Application Diagram.

Creating a Project
Build a device application project.

Creating a Project in Visual Studio
Create a project for your Windows or Windows Mobile device application in Visual Studio.

1. From the Visual Studio main menu select File > New > Project.

2. Select:

• Target platform:
• Windows Mobile 6.0, 6.1, and 6.5 Professional
• Windows

• Library version – .NET version 3.5
• Language – the language used in the resource DLLs, to be included in the generated

project.

Different sets of DLLs are included in the project based on your selections. The project
contains all assemblies and runtime support DLLs required to access the Object API.

3. Click OK to generate the Visual Studio Project.

4. Build the Solution. From the Visual Studio main menu select Build > Build Solution.

The DLLs are copied to the target directory and the directory structure is flattened.

Once generated and built, you can write custom mobile applications based on your
selections.

5. Develop the mobile business objects (MBOs) that implement the business logic.

See these online help topics:
• Sybase Unwired Platform > Sybase Unwired Workspace – Eclipse Edition > Develop

> Developing a Mobile Business Object

6. Use the Code Generation wizard to generate the C# Object API code for the mobile
business object.

7. Add the generated code to the new project you created from the template.

For more information, see Rebuilding the Generated Solution in Visual Studio.
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Rebuilding the Generated Solution in Visual Studio
After generating the C# Object API code for a Mobile Application project, you can modify the
code in Visual Studio.

Prerequisites
Visual Studio must be installed.

Task

When you generate the Object API code for a Windows Mobile device using the Mobile
Application project Code Generation wizard, the Visual Studio solution is saved to the folder
you specified.

Note: If you generate 32-bit Windows code on a 64-bit machine, in the Visual Studio
Configuration Manager for building and deploying the active solution, change the Active
Solution Platform from "AnyCPU" to "x86" before deploying and running the application.

1. In Visual Studio, select File > Open > Project/Solution.

2. Browse to the solution file (.sln) you want to open and double-click the file.

3. In Solution Explorer, right-click the solution and select Rebuild Solution.

4. Select File > Save.
You can now open the form for which you want to modify the code.

Generating Online Help for Visual Studio
You can generate online help for your mobile application project using the .xml file that is
generated with the Object API code.

When you generate the C# Object API code for the mobile application project, an .xml file is
generated for the mobile business objects. You can use the generated .xml file to build online
help for the mobile application project in Visual Studio.

1. Use the Code Generation wizard to generate the C# Object API Code.

2. Build the generated solution in Visual Studio:

a) In Visual Studio, select File > Open > Project/Solution.
b) Browse to the solution file (.sln) you want to open and double-click the file.
c) In Solution Explorer, right-click the solution and select Rebuild Solution.
d) Select File > Save.

The source .xml file for building online help is included with the generated project,
which contains all assemblies and runtime support DLLs required to access the object
API.

Development Task Flow for Object API Applications
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3. There are different tools available for building online help. This procedure uses the free
tool called Sandcastle Help File Builder. You can download Sandcastle Help File Builder
installer from http://shfb.codeplex.com.

4. Create a SandCastle Helpfile builder project (.shfb) in Sand Castle File Builder by
specifying the assemblies and the generated xml file as input.

5. Use the .shfb project file in the daily build script to build the document. For example:

<Target Name="Documentation">
  <Exec Command="$(SandCastleHelpBuilderPath) 
Infrastructure.Core.shfb" />
</Target>

Integrating Help into a Project
When you generate MBOs or client applications for Windows Mobile from Unwired
WorkSpace, an XML file is generated for the MBOs. The generated Visual Studio project for
the forms can also generate a XML file. When you compile a project, an XML file is
generated. You can use these XML files to generate online help.

To generate online help for Visual Studio 2008, you can use Sandcastle and Sandcastle Help
File Builder. You can download and install Sandcastle and Sandcastle Help File Builder from
these locations:

• http://sandcastle.codeplex.com/Wikipage
• http://shfb.codeplex.com/releases

To integrate help into your project build:

1. Add the /doc option in your project build, so that it can generate an XML file from the
comments. You can also configure this option in the Visual Studio project properties. On
the Build tab, select XML documentation and provide a file name.

2. Create a SandCastle Help File Builder project (.shfb file). Specify the assemblies and the
XML file generated from the comments as input. You can also specify other help
properties.

3. Use the .shfb project file in a script to build the document. For example:

<Target Name="Documentation"> 
   <Exec Command="$(SandCastleHelpBuilderPath) <shfb project 
file>.shfb" /> 
</Target> 

Client Application Dependencies
To build device clients, some files, which are provided in the Unwired Platform installation,
are required in certain situations, such as when using a secure port for synchronization.

The client API assembly DLL dependencies are installed under the
<UnwiredPlatform_InstallDir>\MobileSDK\ObjecttAPI directory. The
contents of the directory are:
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• WM and Win32 –  Binaries of the framework classes for .NET.

• WM: files for use on Windows CE based systems such as Windows Mobile 6.
• Win32: files for use on full Windows based systems like Windows XP.

• WM\Ultralite and Win32\Ultralite – .NET Data Persistence Library and
client database (UltraLite®) assemblies. This is used for replication-based
synchronization client applications on Windows Mobile or Windows.

The .NET assemblies listed above support Compact Framework 3.5+ on Visual Studio 2008.
These project types are supported:

• Full .NET Framework 3.5+ Application
• Windows CE .NET CF 3.5+ Application
• Pocket PC .NET CF 3.5+ Application
• Smartphone .NET CF 3.5+ Application

If required, copy the following .dll files to the location used for referencing them in the
Visual Studio application source project.

Platform Location Files Notes

Windows Mobile Pro-
fessional 6.0, 6.1, and
6.5

<UnwiredPlat-
form_Install-
Dir>\Mobi-
leSDK\Objec-
tAPI\DOE\WM

• sup-cli-
ent.dll

• SQLite.In-
terop.
065.DLL (native

DLL)

• System.Da-
ta.SQLite.d
ll (assembly)

Development Task Flow for Object API Applications
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Platform Location Files Notes

• <Unwired-
Platform_In-
stallDir>
\MobileSDK
\ObjectAPI
\DOE\WM
\PocketPC, or

• <Unwired-
Platform_In-
stallDir>
\MobileSDK
\ObjectAPI
\DOE\WM
\Smartphone

CMessaging-
Client.dll

<UnwiredPlat-
form_Install-
Dir>\Mobi-
leSDK\Objec-
tAPI\DOE\WM
\Ultralite

• ulnet12.dll
• ulnet-

cli-
ent12.dll

• mlcrsa12.dl
l

• mlczlib12.d
ll

The
mlcrsa12.dll
file is needed only if
you are using a secure
port (HTTPS) for syn-
chronization.

<UnwiredPlat-
form_Install-
Dir>\Mobi-
leSDK\Objec-
tAPI\DOE\WM
\Ultralite
\<language>

iAnywhere.Da-
ta.Ultra-
Lite.resour-
ces.dll

Copy from the respec-
tive locale-specific
folders.
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Platform Location Files Notes

Windows XP, Vista,
Windows 7

<UnwiredPlat-
form_Install-
Dir>\Mobi-
leSDK\Objec-
tAPI\DOE
\Win32

• sup-cli-
ent.dll

• System.Da-
ta.SQLite.d
ll (assembly)

• ECTrace.dll
• CMessaging-

Client.dll
• Traveler-

Lib.dll
• zlib1.dll
• li-

beay32.dll
• ssleay32.dl

l

<UnwiredPlat-
form_Install-
Dir>\Mobi-
leSDK\Objec-
tAPI\DOE
\Win32\Ultra-
lite

• iAny-
where.Da-
ta.Ultra-
Lite.dll

• ulnet12.dll
• mlcrsa12.dl

l
• mlczlib12.d

ll

The
mlcrsa12.dll
file is required only if
you are using a secure
port (HTTPS) for syn-
chronization.

<UnwiredPlat-
form_Install-
Dir>\Mobi-
leSDK\Objec-
tAPI\DOE
\Win32\Ultra-
lite\<lan-
guage>

iAnywhere.Da-
ta.Ultra-
Lite.resour-
ces.dll

Copy from the respec-
tive locale-specific
folders.
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Adding References to a Mobile Application Project
This describes how to add the required libraries as references in the Visual Studio project.

You can use this method to add references to your client projects.

1. Add the following libraries for the appropriate device platform as references in the Visual
Studio project:

For Windows Mobile:
• sup-client.dll – from <UnwiredPlatform_InstallDir>

\MobileSDK\ObjectAPI\WM.

• iAnywhere.Data.UltraLite.dll – from
<UnwiredPlatform_InstallDir>\MobileSDK\ObjectAPI\WM
\Ultralite.

• iAnywhere.Data.UltraLite.resources.dll (several languages are
supported) – from <UnwiredPlatform_InstallDir>\MobileSDK
\ObjectAPI\WM\Ultralite\<language>.

For Windows:
• sup-client.dll – from <UnwiredPlatform_InstallDir>

\MobileSDK\ObjectAPI\Win32.

• iAnywhere.Data.UltraLite.dll – from
<UnwiredPlatform_InstallDir>\MobileSDK\ObjectAPI
\Win32\Ultralite.

• iAnywhere.Data.UltraLite.resources.dll (several languages are
supported) – from <UnwiredPlatform_InstallDir>\MobileSDK
\ObjectAPI\Win32\Ultralite\<language>.

2. Add the following libraries for the appropriate device platform as items in the Visual
Studio project. Set "Build Action" to "Content" and "Copy to Output Directory" to Copy
always.

For Windows Mobile:
• ulnet12.dll – from <UnwiredPlatform_InstallDir>\MobileSDK

\ObjectAPI\WM\Ultralite.

• mlcrsa12.dll (if HTTPS protocol is used) – from
<UnwiredPlatform_InstallDir>\MobileSDK\ObjectAPI\WM
\Ultralite.

• mlczlib12.dll (if HTTPS protocol is used) – from
<UnwiredPlatform_InstallDir>\MobileSDK\ObjectAPI\WM
\Ultralite.
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• CMessagingClient.dll – from <UnwiredPlatform_InstallDir>
\MobileSDK\ObjectAPI\WM\<DeviceType>. <DeviceType> can be
PocketPC or Smartphone as applicable.

For Windows:
• ulnet12.dll – from <UnwiredPlatform_InstallDir>\MobileSDK

\ObjectAPI\Win32\Ultralite.

• mlcrsa12.dll (if HTTPS protocol is used) – from
<UnwiredPlatform_InstallDir>\MobileSDK\ObjectAPI
\Win32\Ultralite.

• mlczlib12.dll (if using compression) - from
<UnwiredPlatform_InstallDir>\MobileSDK\ObjectAPI
\Win32\Ultralite.

• CMessagingClient.dll – from <UnwiredPlatform_InstallDir>
\MobileSDK\ObjectAPI\Win32.

• ECTrace.dll – from <UnwiredPlatform_InstallDir>\MobileSDK
\ObjectAPI\Win32.

• TravelerLib.dll – from <UnwiredPlatform_InstallDir>
\MobileSDK\ObjectAPI\Win32.

• zlib1.dll – from <UnwiredPlatform_InstallDir>\MobileSDK
\ObjectAPI\Win32.

• libeay32.dll – from <UnwiredPlatform_InstallDir>\MobileSDK
\ObjectAPI\Win32.

• ssleay32.dll – from <UnwiredPlatform_InstallDir>\MobileSDK
\ObjectAPI\Win32.
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Development Task Flow for DOE-based Object
API Applications

Describes the overall development task flow for DOE-based native applications, and provides
information and procedures for setting up the development environment, and developing
DOE-based device applications.

This diagram illustrates how you can develop a device application directly from mobile
business objects (MBOs), using the Object API and custom device application coding. This is
how you create device applications with sophisticated UI interaction, validation, business
logic, and performance.

The Object API provides the core application services described in the diagram.

The Authentication APIs provide security by authenticating the client to the Unwired Server.

The Synchronization APIs allow you to synchronize mobile business objects (MBOs) based
on synchronization parameters, for individual MBOs, or as a group, based on the group's
synchronization policy.

The Application and Connection APIs allow clients to register with and connect to the
Unwired Server. The Callback Handler and Listener APIs, and the Target Change Notification
APIs provide notifications to the client on operation success or failure, or changes in data.

With non-DOE-based applications, connectivity uses the MobiLink channel and notifications
use the Messaging channel.
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Installing the Windows Mobile Development Environment
Install and configure components required for Windows Mobile development.

Configuring Windows Mobile Device Center
Before using the Windows Mobile Device Emulator, you need to change the settings of
Windows Mobile Device Center.

1. Open Windows Mobile Device Center.

2. Click Mobile Device Settings.

3. Click Connection Settings.

4. Click on the Allow connections to one of the following checkbox.

5. Select DMA in the combobox.

6. On the This computer is connected to combobox, select The Internet if you want to
allow the Windows Mobile device to access the Internet using Pocket IE.

7. Start the Windows Mobile Device Emulator.

Enabling Network Access from the Windows Mobile Device Emulator
This task enables the emulator's connectivity.

You can start the Windows Mobile Device Emulator from Visual Studio or from the Device
Emulator Manager.

1. To start the Emulator from Visual Studio 2008:

a) Select Tools > Device Emulator Manager.

2. If a Device Emulator is not yet connected:

a) Select a Device Emulator from the list and select Connect.

3. Right-click the current Emulator in Device Emulator Manager and select Cradle.

ActiveSync starts. Once the connection is established, you should be able to access your
PC and the Web from the Device Emulator.

Installing Microsoft Synchronization Software
Install and configure Microsoft synchronization software so you can deploy and run a mobile
application on a Windows Mobile emulator.

Note: Microsoft ActiveSync is for Windows XP. If you are using Windows Vista, Windows 7,
or Windows 2008, install Virtual PC 2007 SP1 and Windows Mobile Device Center to manage
synchronization settings. Download the Windows Mobile Device Center from http://
www.microsoft.com/windowsmobile/en-us/downloads/microsoft/device-center-
download.mspx.
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1. Download Microsoft ActiveSync from http://www.microsoft.com/windowsmobile/en-
us/help/synchronize/device-synch.mspx. Save it to your local machine. Windows XP
requires ActiveSync version 4.5.

2. In Windows Explorer, double-click setup.msi.

3. When installation is complete, restart your machine.

ActiveSync starts automatically, and its icon appears in the Windows toolbar.

4. Double-click the ActiveSync icon.

5. Select File > Connection Settings.

6. Select Allow Connections to One of the Following, then select DMA.

7. Under This Computer is Connected to, select Work Network.

8. Click OK.

Installing X.509 Certificates on Windows Mobile Devices and
Emulators

Install the .p12 certificate on the Windows Mobile device or emulator and select it during
authentication. A certificate provides an additional level of secure access to an application,
and may be required by an organization's security policy.

1. Launch the simulator or device.

2. Start the Windows synchronization software and cradle the device.

3. Use File Explorer to copy the *.p12 certificate to the simulator or device.

4. Navigate to and double-click the certificate.

5. Enter the password at the prompt and click Done.

An informational window indicates the certificate installed successfully.
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Generating C# Object API Code
Use the Code Generation Utility to generate object API code, which allows you to use APIs to
develop device applications for Windows or Windows Mobile devices.

Prerequisites

• Generate and download the ESDMA bundle for you application.
• Run the ESDMA Converter utility to turn your ESDMA into an Unwired Platform

package.
• Deploy the package to Unwired Server.

See Create, Generate, and Download the ESDMA Bundle, Convert the ESDMA Bundle into
an Unwired Platform Package, and Deploy the Unwired Platform Package in Mobile Data
Models: Using Data Orchestration Engine.

Task

1. Make sure that your <ESDMA_dir>\META-INF directory contains these three files:

• afx-esdma.xml
• ds-doe.xml
• sup-db.xml

2. From <UnwiredPlatform_InstallDir>\UnwiredPlatform\MobileSDK
\ObjectAPI\Utils\bin, run the codegen.bat utility, specifying the following
parameters:
codegen -cs -client -doe -sqlite 
[-output <output_dir>] [-doc] <ESDMA_dir>\META-INF\sup-db.xml
• The -output parameter allows you to specify an output directory. If you omit this

parameter, the output goes into the <UnwiredPlatform_InstallDir>
\UnwiredPlatform\MobileSDK\ObjectAPI\Utils\genfiles
directory, assuming codegen.bat is run from the
<UnwiredPlatform_InstallDir>\UnwiredPlatform\MobileSDK
\ObjectAPI\Utils\bin directory.

• The -doc parameter specifies that documentation is generated for the generated code.

Ignore these warnings:
log4j:WARN No appenders could be found for logger ...
log4j:WARN Please initialize the log4j system properly.
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Generated Code Location and Contents
The location of the generated Object API code is the location you specified when you
generated the code using codegen.bat at the command line.

The contents of the folder is determined by the parameters you pass to codegen.bat in the
command line, and include generated class (.cs) files that contain:

• DatabaseClass – package level class that handles subscription, login, synchronization, and
other operations for the package.

• MBO – class which handles persistence and operation replay of your MBOs.
• Personalization parameters – personalization parameters used by the package.
• Metadata – Metadata class that allows you to query meta data including MBOs, their

attributes, and operations, in a persistent table at runtime..

Creating a Project
Build a device application project.

Creating a Project in Visual Studio
Create a project for your Windows or Windows Mobile device application in Visual Studio.

1. From the Visual Studio main menu select File > New > Project.

2. Select:

• Target platform:
• Windows Mobile 6.0, 6.1, and 6.5 Professional
• Windows

• Library version – .NET version 3.5
• Language – the language used in the resource DLLs, to be included in the generated

project.

Different sets of DLLs are included in the project based on your selections. The project
contains all assemblies and runtime support DLLs required to access the Object API.

3. Click OK to generate the Visual Studio Project.

4. Add all necessary dlls and assemblies:

a) Choose Project > Add Reference and add <UnwiredPlatform_InstallDir>
\MobileSDK\ObjectAPI\DOE\WM\sup-client.dll and
<UnwiredPlatform_InstallDir>\MobileSDK\ObjectAPI\DOE\WM
\System.Data.SQLite.dll.

b) Choose Project > Add Existing Item and add
<UnwiredPlatform_InstallDir>\MobileSDK\ObjectAPI\DOE\WM
\SQLite.Interop.065.DLL and <UnwiredPlatform_InstallDir>
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\MobileSDK\ObjectAPI\DOE\WM\PocketPC
\CMessagingClient.dll.

c) In the Solution window, open SQLite.Interop.065.DLL and change the
property Copy to Output Directory to Copy always.

d) In the Solution window, open CMessagingClient.dll and change the property
Copy to Output Directory to Copy always.

5. Build the Solution. From the Visual Studio main menu select Build > Build Solution.

The DLLs are copied to the target directory and the directory structure is flattened.

Once generated and built, you can write custom mobile applications based on your
selections.

6. Develop the mobile business objects (MBOs) that implement the business logic.

See these online help topics:
• Sybase Unwired Platform > Sybase Unwired Workspace – Eclipse Edition > Develop

> Developing a Mobile Business Object

7. Use the Code Generation wizard to generate the C# Object API code for the mobile
business object.

8. Add the generated code to the new project you created from the template.

For more information, see Rebuilding the Generated Solution in Visual Studio.

Rebuilding the Generated Solution in Visual Studio
After generating the C# Object API code for a Mobile Application project, you can modify the
code in Visual Studio.

Prerequisites
Visual Studio must be installed.

Task

When you generate the Object API code for a Windows Mobile device using the Mobile
Application project Code Generation wizard, the Visual Studio solution is saved to the folder
you specified.

Note: If you generate 32-bit Windows code on a 64-bit machine, in the Visual Studio
Configuration Manager for building and deploying the active solution, change the Active
Solution Platform from "AnyCPU" to "x86" before deploying and running the application.

1. In Visual Studio, select File > Open > Project/Solution.

2. Browse to the solution file (.sln) you want to open and double-click the file.

3. In Solution Explorer, right-click the solution and select Rebuild Solution.

4. Select File > Save.
You can now open the form for which you want to modify the code.
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Generating Online Help for Visual Studio
You can generate online help for your mobile application project using the .xml file that is
generated with the Object API code.

When you generate the C# Object API code for the mobile application project, an .xml file is
generated for the mobile business objects. You can use the generated .xml file to build online
help for the mobile application project in Visual Studio.

1. Use the Code Generation wizard to generate the C# Object API Code.

2. Build the generated solution in Visual Studio:

a) In Visual Studio, select File > Open > Project/Solution.
b) Browse to the solution file (.sln) you want to open and double-click the file.
c) In Solution Explorer, right-click the solution and select Rebuild Solution.
d) Select File > Save.

The source .xml file for building online help is included with the generated project,
which contains all assemblies and runtime support DLLs required to access the object
API.

3. There are different tools available for building online help. This procedure uses the free
tool called Sandcastle Help File Builder. You can download Sandcastle Help File Builder
installer from http://shfb.codeplex.com.

4. Create a SandCastle Helpfile builder project (.shfb) in Sand Castle File Builder by
specifying the assemblies and the generated xml file as input.

5. Use the .shfb project file in the daily build script to build the document. For example:

<Target Name="Documentation">
  <Exec Command="$(SandCastleHelpBuilderPath) 
Infrastructure.Core.shfb" />
</Target>

Integrating Help into a Project
When you generate MBOs or client applications for Windows Mobile from Unwired
WorkSpace, an XML file is generated for the MBOs. The generated Visual Studio project for
the forms can also generate a XML file. When you compile a project, an XML file is
generated. You can use these XML files to generate online help.

To generate online help for Visual Studio 2008, you can use Sandcastle and Sandcastle Help
File Builder. You can download and install Sandcastle and Sandcastle Help File Builder from
these locations:

• http://sandcastle.codeplex.com/Wikipage
• http://shfb.codeplex.com/releases

To integrate help into your project build:
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1. Add the /doc option in your project build, so that it can generate an XML file from the
comments. You can also configure this option in the Visual Studio project properties. On
the Build tab, select XML documentation and provide a file name.

2. Create a SandCastle Help File Builder project (.shfb file). Specify the assemblies and the
XML file generated from the comments as input. You can also specify other help
properties.

3. Use the .shfb project file in a script to build the document. For example:

<Target Name="Documentation"> 
   <Exec Command="$(SandCastleHelpBuilderPath) <shfb project 
file>.shfb" /> 
</Target> 

Client Application Dependencies
To build device clients, some files, which are provided in the Unwired Platform installation,
are required in certain situations, such as when using a secure port for synchronization.

The client API assembly DLL dependencies are installed under the
<UnwiredPlatform_InstallDir>\MobileSDK\ObjecttAPI\DOE directory.
The contents of the directory are:

• WM and Win32 –  Binaries of the framework classes for .NET.

• WM: files for use on Windows CE based systems such as Windows Mobile 6.
• Win32: files for use on full Windows based systems like Windows XP.

The .NET assemblies listed above support Compact Framework 3.5+ on Visual Studio 2008.
These project types are supported:

• Full .NET Framework 3.5+ Application
• Windows CE .NET CF 3.5+ Application
• Pocket PC .NET CF 3.5+ Application
• Smartphone .NET CF 3.5+ Application

If required, copy the following .dll files to the location used for referencing them in the
Visual Studio application source project.
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Platform Location Files Notes

Windows Mobile Pro-
fessional 6.0, 6.1, and
6.5

<UnwiredPlat-
form_Install-
Dir>\Mobi-
leSDK\Objec-
tAPI\DOE\WM

• sup-cli-
ent.dll

• SQLite.In-
terop.
065.DLL (native

DLL)

• System.Da-
ta.SQLite.d
ll (assembly)

• <Unwired-
Platform_In-
stallDir>
\MobileSDK
\ObjectAPI
\DOE\WM
\PocketPC, or

• <Unwired-
Platform_In-
stallDir>
\MobileSDK
\ObjectAPI
\DOE\WM
\Smartphone

CMessaging-
Client.dll
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Platform Location Files Notes

Windows XP, Vista,
Windows 7

<UnwiredPlat-
form_Install-
Dir>\Mobi-
leSDK\Objec-
tAPI\DOE
\Win32

• sup-cli-
ent.dll

• System.Da-
ta.SQLite.d
ll (assembly)

• ECTrace.dll
• CMessaging-

Client.dll
• Traveler-

Lib.dll
• zlib1.dll
• li-

beay32.dll
• ssleay32.dl

l

Adding References to a Mobile Application Project
This describes how to add the required libraries as references in the Visual Studio project.

You can use this method to add references to your client projects.

1. Add the following libraries for the appropriate device platform as references in the Visual
Studio project. Set Build Action to Content and Copy to Output Directory to Copy
always:

For Windows Mobile:
• sup-client.dll – from <UnwiredPlatform_InstallDir>

\MobileSDK\ObjectAPI\WM.

• CMessagingClient.dll – from <UnwiredPlatform_InstallDir>
\MobileSDK\ObjectAPI\DOE\WM\PocketPC or
<UnwiredPlatform_InstallDir>\MobileSDK\ObjectAPI\DOE\WM
\Smartphone.

• SQLite.Interop.065.DLL – from <UnwiredPlatform_InstallDir>
\MobileSDK\ObjectAPI\DOE\WM\.

• iAnywhere.Data.UltraLite.resources.dll (several languages are
supported) – from <UnwiredPlatform_InstallDir>\MobileSDK
\ObjectAPI\DOE\WM\Ultralite\<language>.

For Windows:
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• sup-client.dll – from <UnwiredPlatform_InstallDir>
\MobileSDK\ObjectAPI\DOE\Win32.

• ECTrace.dll – from <UnwiredPlatform_InstallDir>\MobileSDK
\ObjectAPI\DOE\Win32.

• CMessagingClient.dll – from <UnwiredPlatform_InstallDir>
\MobileSDK\ObjectAPI\DOE\Win32.

• Traveler.dll – from <UnwiredPlatform_InstallDir>\MobileSDK
\ObjectAPI\DOE\Win32.

• zlib1.dll – from <UnwiredPlatform_InstallDir>\MobileSDK
\ObjectAPI\DOE\Win32.

• libeay32.dll – from <UnwiredPlatform_InstallDir>\MobileSDK
\ObjectAPI\Win32.

• ssleay32.dll – from <UnwiredPlatform_InstallDir>\MobileSDK
\ObjectAPI\Win32.

2. Add the following libraries for the appropriate device platform as items in the Visual
Studio project. Set "Build Action" to "Content" and "Copy to Output Directory" to Copy
always.

For Windows Mobile:
• ulnet12.dll – from <UnwiredPlatform_InstallDir>\MobileSDK

\ObjectAPI\DOE\WM\Ultralite.

• ulnetclient12.dll – from <UnwiredPlatform_InstallDir>
\MobileSDK\ObjectAPI\DOE\WM\Ultralite.

• mlcrsa12.dll (if HTTPS protocol is used) – from
<UnwiredPlatform_InstallDir>\MobileSDK\ObjectAPI\DOE\WM
\Ultralite.

• mlczlib12.dll (if HTTPS protocol is used) – from
<UnwiredPlatform_InstallDir>\MobileSDK\ObjectAPI\DOE\WM
\Ultralite.

For Windows:
• ulnet12.dll – from <UnwiredPlatform_InstallDir>\MobileSDK

\ObjectAPI\DOE\Win32\Ultralite.

• mlcrsa12.dll (if HTTPS protocol is used) – from
<UnwiredPlatform_InstallDir>\MobileSDK\ObjectAPI\DOE
\Win32\Ultralite.

• mlczlib12.dll (if using compression) - from
<UnwiredPlatform_InstallDir>\MobileSDK\ObjectAPI\DOE
\Win32\Ultralite.
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Customizing the Application Using the Object
API

Use the Object API to customize the application. An application consists of building blocks
which the developer uses to start the application, perform functions needed for the application,
and shutdown and uninstall the application.

Initializing an Application
Initialize the application when it starts the first time and subsequently.

Initially Starting an Application
Starting an application the first time.

Setting Up Application Properties
The Application instance contains the information and authentication credentials needed to
register and connect to the Sybase Unwired Platform server.

The following code illustrates how to set up the minimum required fields:
// Initialize Application settings
Application app = Application.GetInstance();

// The identifier has to match the application ID deployed to the SUP 
server
app.ApplicationIdentifier = "SUP101";

// ConnectionProperties has the infomation needed to register
// and connect to SUP server
ConnectionProperties connProps = app.ConnectionProperties;
connProps.ServerName = "supserver.mycompany.com";
connProps.PortNumber = 5001;
// Other connection properties need to be set when connecting through 
relay server

// provide user credentials
LoginCredentials loginCred = new LoginCredentials("supAdmin", 
"supPwd");
connProps.LoginCredentials = loginCred;

// Initialize generated package database class with this Application 
instance
SUP101DB.SetApplication(app);
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Registering an Application
Each device must register with the server before establishing a connection.

To register the device with the server during the initial application startup, use the
RegisterApplication method in the Sybase.Mobile.Application class. You
do not need to use the RegisterApplication method for subsequent application
startups.To start the connection to complete the registration process, use the
Application.StartConnection method.

Call the generated database's SetApplication method before starting the connection or
registering the device.

The following code shows how to register the application and device.
// Initialize Application settings
Application app = Application.GetInstance();
        
// The identifier has to match the 
// application ID deployed to the SUP server
app.ApplicationIdentifier = "SUP101";
IApplicationCallback appCallback = new MyApplicationCallback();
app.ApplicationCallback = appCallback;

// set connection properties, login credentials, etc
...

SUP101DB.SetApplication(app);

if (app.RegistrationStatus != RegistrationStatus.REGISTERED) 
{
   // If the application has not been registered to the server,
   // register now
   app.RegisterApplication(<timeout_value>);
}
else
{        
   // start the connection to server
   app.StartConnection(<timeout_value>);
}

Setting Up the Connection Profile
The Connection Profile stores information detailing where and how the local database is
stored, including location and page size. The connection profile also contains UltraLiteJ
runtime tuning values.

Set up the connection profile before the first database access, and check if the database exists
by calling the DatabaseExists method in the generated package database class. Any
settings you establish after the connection has already been established will not go into effect.
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The generated database class automatically contains all the default settings for the connection
profile. You may add other settings if necessary. For example, you can set the database to be
stored in an SD card or set the encryption key of the database.

Use the Sybase.Persistence.ConnectionProfile class to set up the locally
generated database. Retrieve the connection profile object using the Sybase Unwired Platform
database's GetConnectionProfile method.

// Initialize the device database connection profile (if needed)
ConnectionProfile connProfile = SUP101DB.GetConnectionProfile();

// encrypt the database
connProfile.SetEncryptionKey("your encryption key"); //Encryption 
key can be of arbitary length, but generally the longer, the better.

// use 100K for cache size
connProfile.CacheSize = 102400;

// Store the database in a location other than the default location
connProfile.SetProperty("databaseFile", "/MyDatabases/
SUP1011_0.ulj");

You can also automatically generate a encryption key and store it inside a data vault.

Setting Up Connectivity
Store connection information to the Sybase Unwired Server data synchronization channel.

Setting Up the Synchronization Profile
You can set Unwired Server synchronization channel information by calling the
synchronization profile's setter method. By default, this information includes the server host,
port, domain name, certificate and public key that are pushed by the message channel during
the registration process.

Settings are automatically provisioned from the Unwired Server. The values of the settings are
inherited from the application connection template used for the registration of the application
connection (automatic or manual). You must make use of the connection and security settings
that are automatically used by the Object API.

Typically, the application uses the settings as sent from the Unwired Server to connect to the
Unwired Server for synchronization so that the administrator can set those at the application
deployment time based on their deployment topology (for example, using relay server, using
e2ee security, or a certificate used for the intermediary, such as a Relay Server Web server).
See the Applications and Application Connection Templates topics in System
Administration.

Set up a secured connection using the ConnectionProfile object.
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1. Retrieve the synchronization profile object using the Sybase Unwired Platform database's
GetSynchronizationionProfile method.

ConnectionProfile cp = SUP101DB.GetSynchronizationProfile();
2. Set the connection fields in the ConnectionProfile object.

cp.ServerName = "SUP_Host";
cp.PortNumber = 2481;            
cp.StreamParams.Trusted_Certificates = "rsa_public_cert.crt";
cp.NetworkProtocol = "https";

Creating and Deleting a Device's Local Database
There are methods in the generated package database class that allow programmers to delete
or create a device's local database. A device local database is automatically created when
needed by the Object API. The application can also create the database programatically by
calling the CreateDatabase method. The device's local database should be deleted when
uninstalling the application.

1. Connect to the generated database by calling the generated database instance's
OpenConnection method.

SUP101DB.OpenConnection();

If the database does not already exist, the OpenConnection method creates it.

2. Optionally, you can include code in your application to check if an instance of the
generated database exists by calling the generated database instance's
DatabaseExists method.

If an instance of a the generated database does not exist, call the generated database
instance's CreateDatabase method.

if (!SUP101DB.DatabaseExists())
    {
        SUP101DB.CreateDatabase();
    }

3. When the local database is no longer needed, delete it by calling the generated database
instance's DeleteDatabase method.

SUP101DB.DeleteDatabase();

Logging In
Use online authentication with the server.

Normally, the user is authenticated through the RegisterApplication and
StartConnection methods in the Application class. Once this is done there is no
need to authenticate again. However, the user can authenticate directly with the server at any
time during the application's execution by calling the generated database instance's
OnlineLogin method.
Use the SynchronizationProfile to store the username and password.

ConnectionProfile syncProfile = 
SUP101DB.GetSynchronizationProfile();
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syncProfile.UserName = "user";
syncProfile.Password = "password";
SUP101DB.OnlineLogin();

Check Network Connection Before Login
If a device does not establish a network connection, the login process does not return a result
until after a long timeout occurs. To avoid this delay, check the network connection before
performing a login.

Search for Detect and Verify a Network Connection on the .NET Framework Developer
Center at http://msdn.microsoft.com/en-us/netframework for information on verifying
connections to network resources required by an application.

Turn Off API Logger
In production environments, turn off the API logger to improve performance.

SUP101DB.GetLogger().SetLogLevel(LogLevel.OFF);

Setting Up Callbacks
When your application starts, it can register database and MBO callback listeners, as well as
synchronization listeners.

Callback handler and listener interfaces are provided so your application can monitor changes
and notifications from Sybase Unwired Platform:

• The Sybase.Mobile.IApplicationCallback class is used for monitoring
changes to application settings, messaging connection status, and application registration
status.

• The Sybase.Persistence.ICallbackHandler interface is used to monitor
notifications and changes related to the database. Register callback handlers at the package
level use the RegisterCallbackHandler method in the generated database class.
To register for a particular MBO, use the RegisterCallbackHandler method in the
generated MBO class.

• The Sybase.Persistence.SyncStatusListener class is used for debugging
and performance measures when monitoring stages of a synchronization session, and can
be used in the user interface to indicate synchronization progress.

Setting Up Callback Handlers
Use the callback handlers for event notifications.

Use the Sybase.Persistence.ICallbackHandler API for event notifications
including login for synchronization and replay. If you do not register your own
implementation of the Sybase.Persistence.ICallbackHandler interface, the
generated code will regsiter a new default callback handler.

1. The generated database class contains a method called
RegisterCallbackHandler. Use this method to install your implementation of
ICallbackHandler.
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For example:
SUP101DB.RegisterCallbackHandler(new MyCallbackHandler());

2. Each generated MBO class also has the same method to register your implementation of
the ICallbackHandler for that particular type. For example, if Customer is a
generated MBO class, you can use the following code:
Customer.RegisterCallbackHandler(new 
MyCustomerMBOCallbackHandler());

Create a Custom Callback Handler
If an application requires a callback (for example, to allow the client framework to provide
notification of synchronization results) create a custom callback handler.

public class Test
{
  public static void Main(String[] args)
  {
  ...
    SUP101DB.RegisterCallbackHandler(new MyCallbackHandler());
    ...
    GenericList<ISynchronizationGroup> sgs = new 
GenericList<ISynchronizationGroup>();
    sgs.Add(SUP101DB.GetSynchronizationGroup("sg1"));
    sgs.Add(SUP101DB.GetSynchronizationGroup("sg2"));
    SUP101DB.BeginSynchronize(sgs, "my test synchronization 
context");
  }
}

public class MyCallbackHandler : 
Sybase.Persistence.DefaultCallbackHandler
{
  public override Sybase.Persistence.SynchronizationAction 
OnSynchronize(Sybase.Collections.GenericList<Sybase.Persistence.ISy
nchronizationGroup> groups, 
Sybase.Persistence.SynchronizationContext context)
  {

    if (context == null
    {
      return Sybase.Persistence.SynchronizationAction.CANCEL;
    }

    if ("my test synchronization 
context".Equals(context.UserContext))
    {
      return base.OnSynchronize(groups, context);
    }

    switch (context.Status)
    {
      case SynchronizationStatus.STARTING:
        if (WaitForMoreChanges())
        {
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          return SynchronizationAction.CANCEL;
        }
        else
        {
          return SynchronizationAction.CONTINUE;
        }
      default:
        return SynchronizationAction.CONTINUE;
    }
    return SynchronizationAction.CONTINUE;
  }
}

Asynchronous Operation Replay
Upload operation replay records asynchronously.

When an application calls SubmitPending on an MBO on which a create, update, or delete
operation is performed, an operation replay record is created on the device local database.

When Synchronize is called, the operation replay records are uploaded to the server. The
method returns without waiting for the backend to replay those records. The Synchronize
method downloads all the latest data changes and the results of the previously uploaded
operation replay records that the backend has finished replaying in the background. If you
choose to disable asynchronous operation replay, each Synchronize call will wait for the
backend to finish replaying all the current uploaded operation replay records.

This feature is enabled by default. You can enable or disable the feature by setting the
asyncReplay property in the synchronization profile. The following code shows how to
disable asynchronous replay:
SUP101DB.GetSynchronizationProfile().AsyncReplay = false;

You can specify an upload-only synchronization where the client sends its changes to the
server, but does not download other changes from the server. This type of synchronization
conserves device resources when receiving changes from the server.
public static void 
BeginSynchronize(Sybase.Collections.GenericList<Sybase.Persistence.
ISynchronizationGroup> sgs,object context, bool uploadOnly)

When asynchronous replay is enabled and the replay is finished, the OnSynchronize callback
method is invoked with a SynchronizationStatus value of
SynchronizationStatus.ASYNC_REPLAY_COMPLETED. Use this callback
method to invoke a synchronize call to pull in the results, as shown in the following callback
handler.
public virtual SynchronizationAction OnSynchronize( 
  Sybase.Collections.GenericList<ISynchronizationGroup> groups,
  SynchronizationContext context)
{
  switch(context.Status)
  {
    case SynchronizationStatus.ASYNC_REPLAY_UPLOADED:
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      LogMessage("AsyncReplay uploaded");
      break;
    case SynchronizationStatus.ASYNC_REPLAY_COMPLETED:
      // operation replay finished
      if (busy)
      {
        // if busy, don't do synchronize now
        return SynchronizationAction.CANCEL;
      }
      break;
    default:
      break;
  }
            return SynchronizationAction.CONTINUE;
}

Synchronize Status Listener
Retrieve the synchronization status.

Synchronize Status Listener is mainly for debugging and performance measuring purposes to
monitor stages of a synchronize session. It could also be used in UI for synchronization
progress status. Below is a sample Synchronize Status Listener.
public class MySyncStatusListener : SyncStatusListener
  {
    long start;

    public MySyncStatusListener()
    {
      start = DateTime.Now.Ticks;
    }

    public virtual bool ObjectSyncStatus(ObjectSyncStatusData 
statusData) 
    {

      long now = DateTime.Now.Ticks;
      long interval = now - start;
      start = now;
      String infoMessage;

      SyncStatusState syncState = statusData.State;

      switch (syncState) {
        case SyncStatusState.SyncStarting:
          infoMessage = "START [" + interval + "]";
          break;
        case SyncStatusState.ApplicationDataUploading:
          infoMessage = "DATA UPLOADING [" + interval + "] " +
            statusData.CurrentMBO + ": (S>" +
            statusData.SentBytes + " R<" +
            statusData.ReceivedBytes + ")";
          break;
        case 
SyncStatusState.ApplicationDataUploadingAcknowledgementReceived:
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          infoMessage = "RECEIVING UPLOAD ACK [" + interval + "]";
          break;
        case SyncStatusState.ApplicationDataUploadingDone:
          infoMessage = "UPLOAD DONE [" + interval + "] " +
            statusData.CurrentMBO + ": (S>" +
            statusData.SentBytes + " R<" +
            statusData.ReceivedBytes + ")";
          break;
        case SyncStatusState.ApplicationDataDownloading:
          infoMessage = "DATA DOWNLOADING[" + interval + "] " +
            statusData.CurrentMBO + ": (S>" +
            statusData.SentBytes + " R<" +
            statusData.ReceivedBytes + ")";
          break;
        case SyncStatusState.ApplicationSyncDisconnecting:
          infoMessage = "DISCONNECTING [" + interval + "]";
          break;
        case SyncStatusState.ApplicationSyncCanceled:
          infoMessage = "SYNC CANCELED [" + interval + "]";
          break;
        case SyncStatusState.ApplicationDataDownloadingDone:
          infoMessage = "DATA DOWNLOADING DONE [" + interval + "]";
          break;
        case SyncStatusState.ApplicationSyncDone:
          infoMessage = "DONE [" + interval + "]";
          break;
        default:
          infoMessage = "STATE" + syncState + "[" + interval + "]";
          break;
    }
    LogMessage(infoMessage);
    return false;
  }
}

Connecting to the Device Database
Establish a connection to the database on the device.

After completing the device registration, call the generated database's OpenConnection
method to connect to the UltraLite/UltraLiteJ database on the device. If no device database
exists, the OpenConnection method creates one.

Synchronizing Applications
Synchronize package data between the device and the server.

The generated database provides you with synchronization methods that apply to either all
synchronization groups in the package or a specified list of groups.

For information on synchronizing DOE-based applications, see Message-Based
Synchronization APIs in the Client Object API Usage section of this document.
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Configuring Data Synchronization Using SSL Encryption
Enable SSL encryption by configuring the synchronization HTTPS port.

1. In the left navigation pane of Sybase Control Center for Unwired Platform, expand the
Servers node and click the server name.

2. Click Server Configuration.

3. In the right administration pane, click the Replication tab.

4. Select Secure synchronization port 2481 as the protocol used for synchronization, and
configure the certificate properties. In the optional properties section, specify the security
certificate file, the public security certificate file using the fully qualified path to the file,
along with the password you entered during certificate creation.

Nonblocking Synchronization
An example that illustrates the basic code requirements for connecting to Unwired Server,
updating mobile business object (MBO) data, and synchronizing the device application from a
device application based on the Client Object API.

Subscribe to the package using synchronization APIs in the generated database class, specify
the groups to be synchronized, and invoke the asynchronous synchronization method
(BeginSynchronize).

1. If you have not yet synchronized with Unwired Server, perform a synchronization.
SUP101DB.Synchronize("system")

2. Set the synchronization parameters if there are any.

3. Make a blocking synchronize call to Unwired Server to pull in all MBO data:
SUP101DB.Synchronize();

4. List all customer MBO instances from the local database using an object query, such as
FindAll, which is a predefined object query.

GenericList<Customer> customers = Customer.FindAll();
foreach (Customer customer in customers)
{
  Console.WriteLine("customer: " + customer.Fname + " " + 
customer.Lname 
    + " " + customer.Id  + customer.City);
}

5. Find and update a particular MBO instance, and save it to the local database.
Customer cust = Customer.FindByPrimaryKey(100);
cust.Address = "1 Sybase Dr.";
cust.Phone = "9252360000";
cust.Save();//or cust.Update();

6. Submit the pending changes. The changes are ready for upload, but have not yet been
uploaded to the Unwired Server.
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cust.SubmitPending();
7. Use non-blocking synchronize call to upload the pending changes to the Unwired Server.

The previous replay results and new changes are downloaded to the client device in the
download phase of the synchronization session.
ISynchronizationGroup sg = SUP101DB.GetSynchronizationGroup("my-
sychronization-group");
GenericList<ISynchronizationGroup> syncGroups = new 
GenericList<ISynchronizationGroup>();
syncGroups.Add(sg);
SUP101DB.BeginSynchronize(syncGroups, "my-context");

Enabling Change Notifications
A synchronization group can enable or disable its change notifications.

By default, change notifications are disabled for synchronization groups. To enable change
notifications, you must synchronize, then call the SynchronizationGroup object's
SetEnableSIS method.

Sybase.Persistence.ISynchronizationGroup sg = 
SUP101DB.GetSynchronizationGroup("PushEnabled");

if (!sg.EnableSIS)
{
  sg.EnableSIS = true; 
  sg.Interval = 2; // 2 minutes
  sg.Save();
  SUP101DB.Synchronize("PushEnabled");
}

Specifying Personalization Parameters
Use personalization parameters to provide default values used with synchronization,
connections with back-end systems, MBO attributes, or EIS arguments. The
PersonalizationParameters class is within the generated code for your project.

1. To instantiate a PersonalizationParameters object, call the generated database
instance's GetPersonalizationParameters method:

PersonalizationParameters pp = 
SUP101DB.GetPersonalizationParameters();

2. Assign values to the PersonalizationParameters object:

pp.PKCity = "New York";
3. Save the PersonalizationParameters value to the local database:

pp.Save();

Note: If you define a default value for a personalization key that value will not take effect,
unless you call pp.Save().

4. Synchronize the PersonalizationParameters value to the Unwired Server:

SUP101DB.Synchronize();
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Specifying Synchronization Parameters
Use synchronization parameters within the mobile application to download filtered MBO
data.

Assign the synchronization parameters of an MBO before a synchronization session. The next
synchronize sends the updated synchronization parameters to the server. The
SynchronizationParameters class is within the generated code for your project.

Note: If you do not save the SynchronizationParameters, no data is downloaded to
the device even if there are default values set for those SynchronizationParameters.
Call the Save method for all SynchronizationParameters and for all MBOs when
the application is first started. Do this after application registration and the first
synchronization.

1. Retrieve the synchronization parameters object from the MBO instance. For example, if
you have an MBO named Customer, the synchronization parameters object is accessed
as a public field and returned as a CustomerSynchronizationParameters
object:
CustomerSynchronizationParameters sp = 
Customer.SynchronizationParameters;

2. Assign values to the synchronization parameter. For example, if the Customer MBO
contains a parameter named cityname, assign the value to the
CustomerSynchronizationParameters object's Cityname field:

sp.Cityname = "Kansas City";
3. Save your changes by calling the synchronization parameters object's Save method:

sp.Save();
SUP101DB.Synchronize();

Once you have set the synchronization parameters, you do not need to set them again in
subsequent synchronizations, unless you want to change them.

Note: If you defined a default value or bound a PersonalizationParameters in the
SynchronizationParameters, then that value will not take effect unless you call
sp.save().

Modifying Synchronization Parameters
If you want to replace the old values in the synchronization parameters with new values, clear
the previous synchronization parameter values before retrieving data from an MBO during a
synchronization session.

CustomerSynchronizationParameters sp = 
Customer.SynchronizationParameters;
sp.Delete();
sp = Customer.SynchronizationParameters;//Must re-get 
synchronization parameter instance.
sp.Cityname = "New City";
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sp.Save();
SUP101DB.Synchronize();  

Subsequently Starting an Application
Subsequent start-ups are different from the first start-up.

Starting an application on subsequent occasions:

1. Use the RegistrationStatus API in the Application class to determine if the
application has already been registered. if it has been registered, then only perform the
following steps:
a. Get the application instance.
b. Set the applicationIdentifier. The applicationIdentifier must be

the same as the one used for initial registration. 
c. Initialize the generated package database class with this application instance.

Note: Once the application is registered, changes to any of the application connection
properties are not saved. To modify the connection properties, unregister the application,
change the connection properties and then register again. Unregistering the application
removes the user from the server.

2. Set up the connection profile properties if needed for database location and tuning
parameters.

3. Set up the synchronization profile properties if needed for SSL or a relay server.
4. Start the application connection to the server using the existing connection parameters and

registration information.
5. Open the database connection.

You can open the database connection in parallel with starting the application connection to
the server.
// Calls non-blocking StartConnection
// This call will return immediately.
application.StartConnection();

// Open the device database connection while establishing
// the messaging channel connection in the background
SUP101DB.OpenConnection();

// Once the device database connection has been opened, check
// whether the messaging channel is connected using the 
// ApplicationCallback interface or the 
Application.GetConnectionStatus() API

Accessing MBO Data
Use MBO object queries to retrieve lists of MBO instances, or use dynamic queries that return
results sets or object lists.
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Object Queries
Use the generated static methods in the MBO classes to retrieve MBO instances.

1. To find all instances of an MBO, invoke the static findAll method contained in that
MBO. For example, an MBO named Customer contains a method such as public
static Sybase.Collections.GenericList<MBO> FindAll().

2. To find a particular instance of an MBO using the primary key, invoke
MBO.FindByPrimaryKey(...). For example, if a Customer has the primary key
"id" as int, the Customer MBO would contain the public static Customer
FindByPrimaryKey(int id) method, which performs the equivalent of Select
x.* from Customer x where x.id = :id.

If the return type is a list, additional methods are generated for you to further process the result,
for example, to use paging. For example, consider this method, which returns a list of MBOs
containing the specified city name:
com.sybase.collections.GenericList<SUP101.Customer>
findByCity(String city, int skip, int take);. The skip parameter
specifies the number of rows to skip, and the take parameter specifies the maximum number
of rows to return.

Dynamic Queries
Build queries based on user input.

Use the Sybase.Persistence.Query class to retrieve a list of MBOs.

1. Specify the where condition used in the dynamic query.
Query query = new Query();

AttributeTest aTest = new AttributeTest();

aTest.Attribute = "state";
aTest.Value = "NY";
aTest.Operator  = AttributeTest.EQUAL;
query.TestCriteria = aTest;

SortCriteria sort = new SortCriteria();
sort.Add("lname", SortOrder.ASCENDING);
sort.Add("fname", SortOrder.ASCENDING);
query.SetSortCriteria(sort);

2. Use the FindWithQuery method in the MBO to dynamically retrieve a list of MBOs
acccording to the specified attributes.
GenericList<MyMBO> mbos = MyMBO.FindWithQuery(query);

3. Use the generated database’s executeQuery method to query multiple MBOs through
the use of joins.
Query query = new Query();
query.Select("c.fname,c.lname,s.order_date,s.id");
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query.From("Customer", "c");
query.Join("Sales_order", "s", "s.cust_id", "c.id");

AttributeTest ts = new AttributeTest();
ts.Attribute = "lname";
ts.Value = "Smith";
ts.Operator = AttributeTest.EQUAL;

query.TestCriteria = ts;

QueryResultSet qrs = SUP101DB.ExecuteQuery(query);

while (qrs.Next())
{
  string fname = qrs.GetString(1);
  string lname = qrs.GetString(2);
  int orderId = qrs.GetInt(4);
   // ...
}

MBOs with Complex Types
Mobile business objects are mapped to classes containing data and methods that support
synchronization and data manipulation. You can develop complex types that support
interactions with backend data sources such as SAP® and Web services. When you define an
MBO with complex types, Sybase Unwired Platform generates one class for each complex
type.

Using a complex type to create an MBO instance.

1. Suppose you have an MBO named SimpleCaseList and want to use a complex data
type called AuthenticationInfo to its Create method's parameter. Begin by
creating the complex datatype:
AuthenticationInfo authen = new AuthenticationInfo(); // Complex 
structure
authen.UserName = "Demo";

2. Instantiate the MBO object:
SimpleCaseList newCase = new SimpleCaseList();
newCase.Case_Type = "Incident";
newCase.Category = "Networking";
newCase.Create_Time = System.DateTime.Now;

3. Call the create method of the SimpleCaseList MBO with the complex type parameter as
well as other parameters, and call submitPending() to submit the create operation
to the operation replay record. Subsequent synchronizations upload the operation replay
record to the Unwired Server and get replayed.
  
newCase.Create (authen, "Other", "Other", "false", "work log");
newCase.SubmitPending();
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Relationships
The Object API supports one-to-one, one-to-many, and many-to-one relationships.

Navigate between MBOs using relationships.

1. Suppose you have one MBO named Customer and another MBO named
SalesOrder. This code illustrates how to navigate from the Customer object to its
child SalesOrder objects:

Customer customer = Customer.FindById (101);
Sybase.Collections.GenericList<SalesOrder> orders = 
customer.Orders;

2. To filter the returned child MBO's list data, use the Query class:

Query props = new Query();
// set query parameters
Sybase.Collections.GenericList<SalesOrder> orders = 
customer.GetOrdersFilterBy(props);

3. For composite relationship, you can call the parent's SubmitPending method to submit
the entire object tree of the parent and its children. Submitting the child MBO also submits
the parent and the entire object tree. (If you have only one child instance, it would not make
any difference. To be efficient and get one transaction for all child operations, it is
recommened to submit the parent MBO once, instead of submitting every child).

If the primary key for a parent is assigned by the EIS, you can use a multilevel insert
cascade operation to create the parent and child objects in a single operation without
synchronizing multiple times. The returned primary key for the parent's create
operation populates the children prior to their own creation.

The following example illustrates how to submit the parent MBO which also submits the
child's operation:
Customer cust = Customer.FindById(101);
Sales_order order = new Sales_order();
order.Id = 1001;
order.Customer = cust;
order.Order_date = Date.ValueOf("1996-03-14");
order.Fin_code_id = "r1";
order.Region = "Eastern";
order.Sales_rep = 101;
order.Save(); // or order.create();
cust.Save();
cust.SubmitPending();

Manipulating Data
Create, update, and delete instances of generated MBO classes.

You can create a new instance of a generated MBO class, fill in the attributes, and call the
Create method for that MBO instance.
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You can modify an object loaded from the database by calling the Update method for that
MBO instance.

You can load an MBO from the database and call the Delete method for that instance.

Creating, Updating, and Deleting MBO Records
Perform create, update, and delete operations on the MBO instances that you have created.

You can call the Create, Update, and Delete methods for MBO instances.

Note: For MBOs with custom create or update operations with parameters, you should use the
custom operations, rather than the default and operations. See MBOs with Complex Types.

1. Suppose you have an MBO named Customer. To create an instance within the database,
invoke its Create method, which causes the object to enter a pending state. Then call the
MBO instance's SubmitPending method. Finally, synchronize with the generated
database:
Customer newcustomer = new Customer();
//Set the required fields for the customer
// …

newcustomer.Create();
newcustomer.SubmitPending();
SUP101DB.Synchronize();

2. To update an existing MBO instance, retrieve the object instance through a query, update
its attributes, and invoke its Update method, which causes the object to enter a pending
state. Then call the MBO instance's SubmitPending method. Finally, synchronize with
the generated database:
Customer customer = Customer.FindByPrimary(myCustomerId) //find 
by primary key
customer.City = "Dublin"; //update any field to a new value
customer.Update();
customer.SubmitPending();
SUP101DB.Synchronize(); 

3. To delete an existing MBO instance, retrieve the object instance through a query and
invoke its Delete method, which causes the object to enter a pending state. Then call the
MBO instance's SubmitPending method. Finally, synchronize with the generated
database:
Customer newcustomer = new Customer();
Customer customer = Customer.FindByPrimary(myCustomerId) //find 
by primary key
customer.Delete();
customer.SubmitPending();
SUP101DB.Synchronize();
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Other Operations
Use operations other than create, update, or delete.

In this example, a customized operator is used to perform a sum operation.

1. Suppose you have an MBO that has an operator that generates a customized sum. Begin by
creating an object instance and assigning values to its attributes, specifying the "Add"
operation:
SUP101AddOperation op = new SUP101AddOperation(); //MBOName + 
OperationName + "Operation"

op.Operand1 = 12;
op.Operand2 = 23;
op.Operator = "Add";
op.Save();

2. Call the MBO instance's SubmitPending method and synchronize with the generated
database:
op.SubmitPending();
SUP101DB.Synchronize();

Using SubmitPending and SubmitPendingOperations
You can submit a single pending MBO, all pending MBOs of a single type, or all pending
MBOs in a package. Once those pending changes are submitted to the server, the MBOs enter
a replay pending state.

Note that submitPendingOperations APIs are expensive. Sybase recommends using the
submitPending API with the MBO instance whenever possible.

Database Classes
Submit pending operations for all entities in the package or synchronization group, cancel all
pending operations that have not been submitted to the server, and check if there are pending
oprations for all entities in the package.

1. To submit pending operations for all pending entities in the package, invoke the generated
database's SubmitPendingOperations method.

Note that submitPendingOperations APIs are expensive. Sybase recommends using the
submitPending API with the MBO instance whenever possible.

2. To submit pending operations for all pending entities in the specified synchronization
group, invoke the generated database's SubmitPendingOperations (string
synchronizationGroup) method.

3. To cancel all pending operations that have not been submitted to the server, invoke the
generated database's CancelPendingOperations method.
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Generated MBOs
Submit pending operations for all entities for a given MBO type or a single instance, and
cancel all pending operations that have not been submitted to the server for the MBO type or a
single entity.

1. To submit pending operations for all pending entities for a given MBO type, invoke the
MBO class' static SubmitPendingOperations method.

Note that submitPendingOperations APIs are expensive. Sybase recommends using the
submitPending API with the MBO instance whenever possible.

2. To submit pending operations for a single MBO instance, invoke the MBO object's
SubmitPending method.

3. To cancel all pending operations that have not been submitted to the server for the MBO
type, invoke the MBO class' static CancelPendingOperations method.

4. To cancel all pending operations for a single MBO instance, invoke the MBO object's
CancelPending method.

Shutting Down the Application
Shut down an application and clean up connections.

Closing Connections
Clean up connections from the generated database instance prior to application shutdown.

1. To release an opened application connection, stop the messaging channel by invoking the
application instance's StopConnection method.

app.StopConnection(<timeout_value>);
2. Use the CloseConnection method to close all database connections for this package

and release all resources allocated for those connections. This is recommended to be part
of the application shutdown process.

Uninstalling the Application
Uninstall the application and clean up all package- and MBO-level data.

Deleting the Database and Unregistering the Application
Delete the package database, and unregister the application.
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1. Unregister the application by invoking the Application instance's
UnregisterApplication method.

app.UnregisterApplication(<time out value>);
2. To delete the package database, call the generated database's DeleteDatabase

method.
SUP101DB.DeleteDatabase();
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Testing Applications

Test native applications on a device or simulator.

Testing an Application Using a Simulator
Run and test the application on a simulator and verify that the application automatically
registers to Unwired Server using the default application connection template.

1. In Visual Studio, choose Tools > Device Emulator Manager.

2. Scroll down to the entry for Windows Mobile 6 Professional, right-click that entry and
select Connect.

3. Right-click the entry for Windows Mobile 6 Professional again and select Cradle.

4. In the Solution Explorer of Visual Studio, right-click the C# project and select Deploy.

5. In the Windows Mobile emulator go to Start > Programs > File Explorer.

6. Navigate to the installed path by going in Program Files > <Application>.

7. Start the application.

8. In Sybase Control Center verify that the application connection was created in
Applications > Application Connections.
When the application has successfully registered, the application connection displays a
value of zero in the Pending Items column.

9. Test the functionality of the application. Use debug tools as necessary, setting breakpoints
at appropriate places in the application.

Client-Side Debugging
Identify and resolve client-side issues while debugging the application.

Problems on the device client side that may cause client application problems:

• Unwired Server connection failed - use your device browser to check the connectivity of
your device to the server.

• Data does not appear on the client device - check if your synchronization and
personalization parameters are set correctly. If you are using queries, check if your query
conditions are correctly constructed and if the device data match your query conditions.

• Physical device problems, such as low memory - implement
ApplicationCallback.onDeviceConditionChanged to be notified if
device storage gets too low, or recovers from an error.

To find out more information on the device client side:
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• If you have implemented debugging in your generated or custom code (which Sybase
recommends), turn on debugging and review the debugging information. See the API
Reference information about using the Logger class to add logs to the client log record
and synchronize them to the server (viewable in Sybase Control Center).

• Check the log record on the device. Use the DatabaseClass.GetLogRecords
(Sybase.Persistence.Query) or Entity.GetLogRecords methods.

This is the log format
level,code,eisCode,message,component,entityKey,operation,requestI
d,timestamp

This log format generates output similar to:
level code eisCode message component entityKey operation requestId 
timestamp
 5,500,'','java.lang.SecurityException:Authorization failed: 
Domain = default Package = end2end.rdb:1.0 mboName = 
simpleCustomer action = 
delete','simpleCustomer','100001','delete','100014','2010-05-11 
14:45:59.710'
            

• level – the log level currently set. Values include: 1 = TRACE, 2 = DEBUG, 3 =
INFO, 4 = WARN, 5 = ERROR, 6 = FATAL, 7 = OFF.

• code – Unwired Server administration codes.

• Synchronization codes:
• 200 – success.
• 500 – failure.

• eisCode – maps to HTTP error codes. If no mapping exists, defaults to error code
500 (an unexpected server failure).

• message – the message content.

• component – MBO name.

• entityKey – MBO surrogate key, used to identify and track MBO instances and
data.

• operation – operation name.

• requestId – operation replay request ID or messaging-based synchronization
message request ID.

• timestamp – message logged time, or operation execution time.

• If you have implemented
ApplicationCallback.OnConnectionStatusChanged for synchronization
in the CallbackHandler, the connection status between Unwired Server and the
device is reported on the device. See the CallbackHandler API reference
information. The device connection status, device connection type, and connection error
message are reported on the device:
• 1 – current device connection status.
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• 2 – current device connection type.
• 3 – connection error message.

• For other issues, you can use tracing on the device side to trace Client Object API activity.
Sybase Unwired Platform supports three levels of tracing:
• 1 = Tracing is disabled
• 3 = SQL Trace without payload
• 5 = SQL Trace with payload (values displayed)
There are two ways to enable tracing on the client side:
• Via Sybase Control Center through the Applications folders:

1. Click on the Applications folder in the Unwired Platform Cluster frame.
2. In the Applications tab, select the application you wish to enable tracing for.
3. Select the Application Connections tab and select the user you wish to enable

tracing for.
4. Click on the Properties button to open the Application Connection Properties

window.
5. Click on Device Advanced to display advanced connection properties.
6. Change the value of the Device Level Trace property to the appropriate level.
7. Click OK to save your changes.

• Via code by calling the appropriate API. In the SUPConnectionProfile class,
there are two APIs that can be used:
- EnableTrace(bool enable)
- EnableTrace(bool enable, bool withPayload)

The application in the initialization code can invoke these APIs to enable/disable
tracing:
ConnectionProfile cp = SampleDB.GetConnectionProfile();

// To enable trace of client database operations (SQL 
statements, etc.)
cp.EnableTrace(true);

// To enable trace of client database operations with values 
also displayed
cp.EnableTrace(true, true);

// To disable trace of client database operations
cp.EnableTrace(false);

Note: Once the trace level is set, the application must be restarted for the tracing to take
effect. SQL tracing (level 3 and 5) can cause significant performance degradation, so it
should be used with caution. SQL tracing should only be enabled via Sybase Control
Center long enough for the device application to capture relevant tracing. When finished,
you should shut down the application and relaunch it to run with tracing disabled.
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Server-Side Debugging
Identify and resolve server-side issues while debugging the application.

Problems on the Unwired Server side may cause device client problems:

• The domain or package does not exist. If you create a new domain, with a default status of
disabled, it is unavailable until enabled.

• Authentication failed for the application user credentials.
• The operation role check failed for the synchronizing user.
• Back-end authentication failed.
• An operation failed on the remote, replication database back end, for example, a table or

foreign key does not exist.
• An operation failed on the Web Service, REST, or SAP® back end.

To find out more information on the Unwired Server side:

• Check the Unwired Server log files.
• For message-based synchronization mode, you can set the log level to DEBUG to obtain

detailed information in the log files:
1. Set the log level using Sybase Control Center. See Sybase Control Center for Unwired

Platform > Administer > Server Log > Configuring Server Log Setting.

Note: Return to INFO mode as soon as possible, since DEBUG mode can affect system
performance.

• Obtain DEBUG information for a specific device:
• In the SCC administration console:

1. Set the DEBUG level to a higher value for a specified device:
a. In SCC, select Application Connections, then select Properties... > Device

Advanced.
b. Set the Debug Trace Level value.

2. Set the TRACE file size to be greater than 50KB.
3. View the trace file through SCC.

• Check the <server_install_folder>\UnwiredPlatform\Servers
\UnwiredServer\logs\ClientTrace directory to see the mobile device
client log files for information about a specific device.

Note: Return to INFO mode as soon as possible, since DEBUG mode can affect system
performance.
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Localizing Applications

Localize a Windows Mobile application by generating resource files, adding a resource file
template and strings, and localizing the application code.

Generating Resource Files
Generate resource files for localizing controls and captions for each locale.

1. In Visual Studio, select the Form you want to localize, and open it in View Designer.

2. In the Properties window, set the form's Localizable property to true.

3. Set the form's Language property to the language of the locale. For example, Chinese
(Simplified).

4. Set the text for the form and the Text property for all buttons to the appropriate text for the
locale.

Note: You can resize a button to accommodate a longer string, if necessary. The button size
is persisted in the resource file.

5. Repeat steps 3 and 4 to add more languages, as required.

6. Save and build the solution.

7. Expand Customers.cs.

The resource files appear under Customers.cs. Customers.resx is the resource file for
the default culture, which is built into the main assembly. Resource files for other locales
include a language code, and, optionally, a country code. Language and country codes are
specified in ISO-639 and ISO-3166, respectively.

For example, Customers.ch-CHS.resx is the resource file for Chinese as spoken in
Chinese (Simplified).

Adding a Resource File Template and String Variables
Add a resource file template to the project and then edit the template with the XML Designer
to define localizable strings that appear in dialog boxes and error messages.

1. In the Project menu, select Add New Item.

2. In the Templates box, select the Resources File template. Enter the file name
"SampleApp.resx" in the Name box.

The resources file template contains resources that are accessed when the application
cannot find resources appropriate to the user interface culture.
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The file gets added to your project in Solution Explorer and automatically opens in the
XML Designer in Data view.

3. In the Data pane, select an empty row and enter "strDatabaseDeleted" in the name column
and "Database deleted" in the value column.

4. Add rows for other strings, as required.

Note: You do not need to specify the type or mimetype for a string; strings are used for
objects. The type specifier holds the data type of the object being saved. The MIME
type specifier holds the base type (base64) of the binary information stored, if the object
consists of binary data.

5. In the File menu, select Save SampleApp.resx.

6. Repeat this procedure to create resource files for the other languages.
For example, we may create an additional resource file named "SampleApp.zh-
CHS.resx". That file is to contain resources that are specific to Chinese as spoken in
Chinese (Simplified).

Localizing the Application Code
Provide access to the manually added resources.

1. In the Code Editor, import the System.Resources namespace at the beginning of the
code module.
using System.Resources;

2. Add the following code at the beginning of the class. The ResourceManager constructor
takes two arguments. The first is the root name of the resources — that is, the name of the
resource file without the culture and .resx suffixes. The second argument is the main
assembly.
ResourceManager LocRM = new 
ResourceManager("SampleApp.SampleApp", 
typeof(Customer).Assembly);

3. Modify the code to use the ResourceManager GetString() method to replace hard-
coded strings. For example, modify:
AddString("Database deleted");

to:
AddString(LocRM.GetString("strDatabaseDeleted"));

Note: By default, the ResourceManager object is case-sensitive. If you want to perform
case-insensitive lookups you can set the resource manager's IgnoreCase property to
true. However, for performance reasons, specify the correct case for your resource names.

4. Repeat the localization procedures for Customer Details.cs.
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Validating the Localization Changes
Test that your changes appear in your application.

1. Launch the application on a device or emulator that supports the language for the locale.

2. Launch your application and verify that it is localized.
The application appears with the appropriate user interface language for the operating
system of the device or emulator.
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Packaging Applications

Package applications according to your security or application distribution requirements.

You can package all libraries into one package. This packaging method provide more security
since packaging the entire application as one unit reduces the risk of tampering of individual
libraries.

You may package and install modules separately only if your application distribution strategy
requires sharing libraries between Sybase Unwired Platform applications.

Signing
Code signing is required for applications to run on physical devices.

You can run unsigned modules, which will result in warnings.

Compiling an Application in Visual Studio
Deploy applications to a Device Emulator or connected device.

1. To deploy an application from Visual Studio, compile the project and deploy the
application to the emulator or physical device.

2. If you are using a Device Emulator, define a shared folder and copy the file in that folder
from your machine so the Emulator can access it.

3. Using Windows and a connected device, use the Virtual folder on your machine to copy the
application's .cab file to the device or memory card.
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Client Object API Usage

The Sybase Unwired Platform Client Object API consists of generated business object classes
that represent mobile business objects (MBOs) that are designed and built in the Unwired
WorkSpace development environment. Device applications use the Client Object API to
retrieve data and invoke mobile business object operations.

Refer to these sections for more information on using the APIs described in Developer Guide:
Windows and Windows Mobile Object API Applications > Customizing the Application
Using the Object API.

Client Object API Reference
Use the Sybase Client Object APIC# docs as a Client Object API reference.

Review the reference details in the Client Object API documentation, located in the Unwired
Platform installation directory <UnwiredPlatform_InstallDir>\MobileSDK
\ObjectAPI\apidoc.

There is a subdirectory for cs.

Application APIs
The Application class, in the Sybase.Mobile namespace, manages mobile
application registrations, connections and context.

Note: Sybase recommends that you use the Application API operations with no timeout
parameter, and register an ApplicationCallback to handle completion of these
operations.

Application
Methods or properties in the Application class.

GetInstance
Retrieves the Application instance for the current mobile application.

Syntax
public static Application GetInstance()

Client Object API Usage

Developer Guide: Windows and Windows Mobile Object API Applications 63



Returns

GetInstance returns a singleton Application object.

Examples

• Get the Application Instance

Application app = Application.GetInstance();

GetInstance (String)
Return a named Application instance for the current mobile application. Named
application instances are intended to support performance tests, where multiple instances of
an application are running simultaneously as separate processes on the same computer. This
operation is currently only provided for Windows C# applications

Syntax
public static Application GetInstance(string instanceID)

Returns

GetInstance returns a singleton Application object.

Examples

• Get the Application Instance

Application app = Application.GetInstance(123);

ApplicationIdentifier Property
Identifier for the current application. The property must be set before calling startConnection,
registerApplication or unregisterApplication.

Syntax
public string ApplicationIdentifier { get; set; }

Examples

• Get the Status

application.ApplicationIdentifier = "SUP101";

RegistrationStatus property
Retrieves the current status of the mobile application registration.
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Syntax
public int RegistrationStatus { get; set; }

Returns

RegistrationStatus returns one of the values defined in the
RegistrationStatus class.

public class RegistrationStatus {

public static final int REGISTERED = 203;
public static final int REGISTERING = 202;
public static final int REGISTRATION_ERROR = 201;
public static final int UNREGISTERED = 205; 
public static final int UNREGISTERING = 204;
}

Examples

• Get the Registration Status – Registers the application if it is not already registered.

if (app.RegistrationStatus != RegistrationStatus.REGISTERED)
{
   // If the application has not been registered to the server,
   // register now
   app.RegisterApplication();
}
else
{        
   // start the connection to server
   app.StartConnection();
}

RegisterApplication
Creates the registration for this application and starts the connection. This method is
equivalent to calling RegisterApplication(0).

Syntax
public void RegisterApplication()

Parameters

None.

Examples

• Register an Application – Start registering the application and return at once.
app.RegisterApplication();
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Usage

You must set up the ConnectionProperties and ApplicationIdentifier
before you can invoke registerApplication.

Application app = Application.GetInstance();

// set Application ID - need to match as the server side Application 
ID
app.ApplicationIdentifier = "SUP101";
ConnectionProperties props = app.ConnectionProperties;
props.ServerName = "supserver.mycompany.com";
props.PortNumber = 5001;
LoginCredentials loginCred = new LoginCredentials("supAdmin", 
"supPwd");
props.LoginCredentials = loginCred;

SUP101DB.SetApplication(app);

if (app.RegistrationStatus != RegistrationStatus.REGISTERED) 
{
// If the application has not been registered to the server,
// register now
app.RegisterApplication();
}

RegisterApplication (int timeout)
Creates the registration for this application and starts the connection. An
ApplicationTimeoutException is thrown if the method does not succeed within the
number of seconds specified by the timeout.

If a callback handler is registered and network connectivity is available, the sequence of
callbacks as a result of calling RegisterApplication is:

OnRegistrationStatusChanged(RegistrationStatus.REGISTERING, 0, "")
OnConnectionStatusChanged(ConnectionStatus.CONNECTING, 0, "")
OnConnectionStatusChanged(ConnectionStatus.CONNECTED, 0, "")
OnRegistrationStatusChanged(RegistrationStatus.REGISTERED, 0, "")
 

When the connectionStatus of CONNECTED has been reached and the application's
applicationSettings have been received from the server, the application is now in a suitable
state for database subscriptions and/or synchronization. If a callback handler is registered and
network connectivity is unavailable, the sequence of callbacks as a result of calling
registerApplication is:
OnRegistrationStatusChanged(RegistrationStatus.REGISTERING, 0, "")
OnRegistrationStatusChanged(RegistrationStatus.REGISTRATION_ERROR, 
code, message)

In such a case, the registration process has permanently failed and will not continue in the
background. If a callback handler is registered and network connectivity is available for the
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start of registration but becomes unavailable before the connection is established, the
sequence of callbacks as a result of calling registerApplication is:
OnRegistrationStatusChanged(RegistrationStatus.REGISTERING, 0, "")
OnConnectionStatusChanged(ConnectionStatus.CONNECTING, 0, "")
OnConnectionStatusChanged(ConnectionStatus.CONNECTION_ERROR, code, 
message)

In such a case, the registration process has temporarily failed and will continue in the
background when network connectivity is restored.

Syntax
public void RegisterApplication(int timeout)

Parameters

• timeout – Number of seconds to wait until the registration is created. If the the timeout is
greater than zero and the registration is not created within the timeout period, an
ApplicationTimeoutException is thrown (the operation might still be
completing in a background thread). If the timeout value is less than or equal to 0, then this
method returns immediately without waiting for the registration to finish (a non-blocking
call). If the timeout value is less than or equal to 0, then this method returns immediately
without waiting for the registration to finish (a non-blocking call).

Examples

• Register an Application – Registers the application with a one minute waiting period.
app.RegisterApplication(60);

Usage

You must set up the ConnectionProperties and ApplicationIdentifier
before you can invoke registerApplication.

Application app = Application.GetInstance();
// set Application ID - need to match as the server side Application 
ID
app.ApplicationIdentifier = "MyPackage";
app.ApplicationCallback = new MyApplicationCallbackHandler();
ConnectionProperties props = app.ConnectionProperties;
props.ServerName = "supserver.mycompany.com";
props.PortNumber = 5001;
LoginCredentials loginCred = new LoginCredentials("supAdmin", 
"supPwd");
props.LoginCredentials = loginCred;

MyPackageDB.SetApplication(app);

if (app.RegistrationStatus != RegistrationStatus.REGISTERED)
{
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app.RegisterApplication();
}

ApplicationCallback Property
Callback for the current application. It is optional (but recommended) to set a callback, so that
the application can respond to changes of connection status, registration status and application
settings.

For information on the IApplicationCallback class, see Developer Guide for
Windows and Windows Mobile > Client Object API Usage > Callback and Listener APIs >
IApplicationCallback API.

Syntax
public IApplicationCallback ApplicationCallback { get; set; }

Examples

• Get the Status

application.ApplicationCallback = new MyApplicationCallback();

StartConnection
Starts the connection for this application. This method is equivalent to calling
StartConnection(0), but is a non-blocking call which returns immediately. Use
getConnectionStatus or the ApplicationCallback to retrieve the connection
status.

Syntax
public void StartConnection()

Returns

None.

Examples

• Start the Application

StartConnection()

StartConnection (int timeout)
Starts the connection for this application. If the connection was previously started, then this
operation has no effect. You must set the appropriate connectionProperties before
calling this operation. An ApplicationTimeoutException is thrown if the method
does not succeed within the number of seconds specified by the timeout.

If connection properties are improperly set, a ConnectionPropertyException is
thrown. You can set the applicationCallback before calling this operation to receive
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asynchronous notification of connection status changes. If a callback handler is registered and
network connectivity is available, the sequence of callbacks as a result of calling
StartConnection is:

onConnectionStatusChanged(ConnectionStatus.CONNECTING, 0, "")
 onConnectionStatusChanged(ConnectionStatus.CONNECTED, 0, "") 

If a callback handler is registered and network connectivity is unavailable, the sequence of
callbacks as a result of calling StartConnection is:

onConnectionStatusChanged(ConnectionStatus.CONNECTING, 0, null)
 onConnectionStatusChanged(ConnectionStatus.CONNECTION_ERROR, code, 
message) 

After a connection is successfully established, it can transition at any later time to
CONNECTION_ERROR status or NOTIFICATION_WAIT status and subsequently back to
CONNECTING and CONNECTED when connectivity resumes.

Note: The application must have already been registered for the connection to be established.
See registerApplication for details.

Syntax
public void StartConnection(int timeout)

Parameters

• timeout – The number of seconds to wait until the connection is started. If the timeout is
greater than zero and the connection is not started within the timeout period, an
ApplicationTimeoutException is thrown (the operation may still be completing
in a background thread). If the timeout value is less than or equal to 0, then this method
returns immediately without waiting for the registration to finish (a non-blocking call).

Returns

None.

Examples

• Start the Application

StartConnection(int timeout)

ConnectionStatus Property
This property represents the current status of the mobile application connection, one of the
ConnectionStatus class values.

Syntax
public int ConnectionStatus { get; set; }
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Returns

ConnectionStatus has the following possible values:

• ConnectionStatus.CONNECTED – The connection has been successfully started.
• ConnectionStatus.CONNECTING – The connection is currently being started.
• ConnectionStatus.CONNECTION_ERROR – The connection could not be started, or

was previously started and subsequently an error occurred. Use
onConnectionStatusChanged to capture the associated errorCode and
errorMessage.

• ConnectionStatus.DISCONNECTED –  The connection been sucessfully stopped, or
there was no previous connection.

• ConnectionStatus.DISCONNECTING – The connection is currently being stopped.
• ConnectionStatus.NOTIFICATION_WAIT – The connection has been suspended and

is awaiting a notification from the server. This is a normal situation for those platforms
which can keep connections closed when there is no activity, since the server can reawaken
the connection as needed with a notification.

Examples

• Get the Status

if (app.ConnectionStatus != ConnectionStatus.CONNECTED)
{
  // start the connection to server
  app.StartConnection(100);
}

GetConnectionProperties
Retrieves the connection parameters from the application's connection properties instance.
You must set connection properties before calling StartConnection,
RegisterApplication or UnregisterApplication.

Syntax
public ConnectionProperties ConnectionProperties

Parameters
None.

Returns

Returns the connection properties instance.
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ApplicationSettings Property
Return application settings that have been received from the Unwired Server after application
registration and connection.

Syntax
Sybase.Mobile.ApplicationSettings ApplicationSettings { get; set; } 

Returns
Application settings that have been received from the Unwired Server.

Examples

• Get the Application Settings

Sybase.Mobile.ApplicationSettings applicationSettings = 
Application.GetInstance().ApplicationSettings 

StopConnection
Stops the connection for this application. This method is equivalent to calling
StopConnection(0).

Syntax
public void StopConnection()

Returns

None.

Examples

• Stop the Connection for the Application

StopConnection();

StopConnection (int timeout)
Stop the connection for this application. An ApplicationTimeoutException is
thrown if the method does not succeed within the number of seconds specified by the timeout.

If no connection was previously stopped, then this operation has no effect. You can set the
applicationCallback before calling this operation to receive asynchronous notification of
connection status changes.

If a callback handler is registered, the sequence of callbacks as a result of calling
StopConnection is:
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• OnConnectionStatusChanged(ConnectionStatus.DISCONNECTING, 0, "")
• OnConnectionStatusChanged(ConnectionStatus.DISCONNECTED, 0, "")

Syntax
public void StopConnection(int timeout)

Parameters

• timeout – The number of seconds to wait until the connection is stopped. If the timeout
value is less than or equal to 0, then this method returns immediately without waiting for
the registration to finish (a non-blocking call).

Returns

None.

Examples

• Stop the Application

StopConnection(60)

UnregisterApplication
Delete the registration for this application, and stop the connection. If no registration was
previously created, or a previous registration was already deleted, then this operation has no
effect. This method is equivalent to calling UnregisterApplication(0), but is a non-
blocking call which returns immediately. You can set the applicationCallback before calling
this operation to receive asynchronous notification of registration status changes.

Syntax
UnregisterApplication()

Parameters
None.

Examples

• Unregister an Application – Unregisters the application.
app.UnregisterApplication();

UnregisterApplication(int timeout)
Delete the registration for this application, and stop the connection. If no registration was
previously created, or a previous registration was already deleted, then this operation has no
effect. You must set the appropriate connectionProperties before calling this operation. You
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can set the applicationCallback before calling this operation to receive asynchronous
notification of registration status changes.

If a callback handler is registered and network connectivity is available, the sequence of
callbacks as a result of calling unregisterApplication should be:

• OnConnectionStatusChanged(ConnectionStatus.DISCONNECTING, 0, "")
• OnConnectionStatusChanged(ConnectionStatus.DISCONNECTED, 0, "")
• OnRegistrationStatusChanged(RegistrationStatus.UNREGISTERING, 0, "")
• OnRegistrationStatusChanged(RegistrationStatus.UNREGISTERED, 0, "")

If a callback handler is registered and network connectivity is unavailable, the sequence of
callbacks as a result of calling unregisterApplication should be:

• OnConnectionStatusChanged(ConnectionStatus.DISCONNECTING, 0, "")
• OnConnectionStatusChanged(ConnectionStatus.DISCONNECTED, 0, "")
• OnRegistrationStatusChanged(RegistrationStatus.UNREGISTERING, 0, "")
• OnRegistrationStatusChanged(RegistrationStatus.REGISTRATION_ERROR, code,

message)

Syntax
UnregisterApplication(int timeout)

Parameters

• timeout – Number of seconds to wait until the application is unregistered. If the timeout
value is less than or equal to 0, then this method returns immediately without waiting for
the registration to finish (a non-blocking call).

Examples

• Unregister an Application – Unregisters the application with a one minute waiting
period.
app.UnregisterApplication(60);

ConnectionProperties
A class that supports the configuration of properties to enable application registrations and
connections.

NetworkProtocol
Retrieves or sets the network protocol for the server connection URL, which is also known as
the URL scheme. Defaults to HTTP.
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Syntax
public string NetworkProtocol

Parameters
None.

Returns

Returns the network protocol for the server connection URL.

LoginCertificate
Retrieve the login certificate, or set this property to enable authentication by a digital
certificate.

Syntax
public LoginCertificate LoginCertificate

Parameters
None.

Returns

Returns the login certificate.

LoginCredentials
Retrieve the login credentials, or set this property to enable authentication by username and
password..

Syntax
public LoginCredentials LoginCredentials

Parameters
None.

Returns

Returns the login credentials.

PortNumber
Retrieve or set the port number for the server connection URL.
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Syntax
public int PortNumber

Parameters
None.

Returns

Returns the port number.

ServerName
Retrieve or set the server name for the server connection URL.

Syntax
public string ServerName

Parameters
None.

Returns

Returns the server name.

SecurityConfiguration
Retrieve or set the security configuration for the connection profile. If not specified, the server
selects the correct security configuration by matching an application connection template
with the applicationIdentifier.

Syntax
public string SecurityConfiguration

Parameters
None.

Returns

Returns the security configuration.

UrlSuffix
Retrieve or set the URL suffix for the server connection URL. This optional property is only
used when connecting through a proxy server or Relay Server.
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Syntax
public string UrlSuffix

Parameters
None.

Returns

Returns the URL suffix.

FarmId
Retrieve or set the Farm ID for the server connection URL. This optional property is only used
when connecting through a proxy server or Relay Server.

Syntax
public string FarmId

Parameters
None.

Returns

Returns the Farm ID.

HttpHeaders
Retrieve or set any custom headers for HTTP network communications with a proxy server or
Relay Server.

Syntax
public StringProperties HttpHeaders

Parameters
None.

Returns

Returns the HTTP headers.

HttpCookies
Retrieve or set any custom HTTP cookies for network communications with a proxy server or
Relay Server.

Client Object API Usage

76 Sybase Unwired Platform



Syntax
public StringProperties HttpCookies 

Parameters
None.

Returns

Returns the HTTP cookies.

HttpCredentials
Retrieve or set the credentials for HTTP basic authentication with a proxy server or Relay
Server.

Syntax
public LoginCredentials HTTPCredentials

Parameters
None.

Returns

Returns credentials for HTTP basic authentication with a proxy server or Relay Server.

ApplicationSettings
Methods or properties in the ApplicationSettings class.

IsApplicationSettingsAvailable
Checks whether the application settings are available from the Unwired Server.

Syntax
public bool IsApplicationSettingsAvailable()

Parameters
None.

Returns
Returns true if the application settings are available.
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Examples

• Check if application settings are available

bool isSettingsAvailable  = 
Sybase.Mobile.Application.GetInstance().ApplicationSettings.IsApp
licationSettingsAvailable();

GetStringProperty
Retrieves a string property from the applicationSettings.

Syntax
public String GetStringProperty(ConnectionPropertyType type)

Parameters

• type – Type of ConnectionPropertyType.

Returns

Returns a string property value.

Examples

• Get string property –
string user_name =  
appSettings.GetStringProperty(ConnectionPropertyType.UserName);

GetIntegerProperty
Retrieves an integer property from the applicationSettings.

Syntax
public int? GetIntegerProperty(ConnectionPropertyType type) 

Parameters

• type – Type of ConnectionPropertyType.

Returns
Returns an integer property value.
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Examples

• Get integer property

int? min_length = 
appSettings.GetIntegerProperty(ConnectionPropertyType.PwdPolicy_L
ength);

GetBooleanProperty
Retrieves a boolean property from the applicationSettings.

Syntax
public bool? GetBooleanProperty(ConnectionPropertyType type) 

Parameters

• type – Type of ConnectionPropertyType.

Returns
Returns a boolean property value.

Examples

• Get boolean property –
bool? pwdpolicy_enabled = 
appSettings.GetBooleanProperty(ConnectionPropertyType.PwdPolicy_E
nabled);

Custom1
A custom application setting for use by the application code.

Syntax
public String Custom1 

Parameters
None.

Returns

Returns a custom application setting.

Custom2
A custom application setting for use by the application code.

Syntax
public String Custom2 
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Parameters
None.

Returns

Returns a custom application setting.

Custom3
A custom application setting for use by the application code.

Syntax
public String Custom3 

Parameters
None.

Returns

Returns a custom application setting.

Custom4
A custom application setting for use by the application code.

Syntax
public String Custom4 

Parameters
None.

Returns

Returns a custom application setting.

DomainName

Syntax
public String DomainName  

Parameters
None.

Returns

Returns the domain name.
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ConnectionId

Syntax
public String ConnectionId 

Parameters
None.

Returns

Returns a Connection ID for this application setting.

ConnectionPropertyType
Methods or properties in the ConnectionPropertyType class.

PwdPolicy_Enabled
Indicates whether the password policy is enabled.

Syntax
ConnectionPropertyType PwdPolicy_Enabled 

Parameters
None.

Returns

Examples

• PwdPolicy_Enabled

bool? pwdpolicy_enabled = 
appSettings.GetBooleanProperty(ConnectionPropertyType.PwdPolicy_E
nabled);

PwdPolicy_Default_Password_Allowed
 Indicates whether the client application is allowed to use the default password for the data
vault. 

Syntax
ConnectionPropertyType PwdPolicy_Default_Password_Allowed 
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Parameters
None.

Returns

None.

Examples

• PwdPolicy_Default_Password_Allowed

bool? default_password_allowed = 
appSettings.GetBooleanProperty(ConnectionPropertyType.PwdPolicy_D
efault_Password_Allowed);

PwdPolicy_Length
Defines the minimum length for a password. 

Syntax
ConnectionPropertyType PwdPolicy_Length 

Parameters
None.

Returns

Returns an integer value for the minimum length for a password.

Examples

• PwdPolicy_Length

int? min_length = 
appSettings.GetIntegerProperty(ConnectionPropertyType.PwdPolicy_L
ength);

PwdPolicy_Has_Digits
Indicates if the password must contain digits. 

Syntax
ConnectionPropertyType PwdPolicy_Has_Digits 

Parameters
None.
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Returns

Returns true if the password must contain digits.

Examples

• PwdPolicy_Has_Digits

bool? has_digits = 
appSettings.GetBooleanProperty(ConnectionPropertyType.PwdPolicy_H
as_Digits);

PwdPolicy_Has_Upper
Indicates if the password must contain at least one upper case character. 

Syntax
ConnectionPropertyType PwdPolicy_Has_Upper 

Parameters
None.

Returns

Returns true if the password must contain at least one upper case character.

Examples

• PwdPolicy_Has_Upper

bool? has_upper = 
appSettings.GetBooleanProperty(ConnectionPropertyType.PwdPolicy_H
as_Upper);

PwdPolicy_Has_Lower
Indicates if the password must contain at least one lower case character.

Syntax
ConnectionPropertyType PwdPolicy_Has_Lower 

Parameters
None.

Returns

Returns true if the password contains at least one lower case character.
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Examples

• PwdPolicy_Has_Lower

bool? has_lower = 
appSettings.GetBooleanProperty(ConnectionPropertyType.PwdPolicy_H
as_Lower);

PwdPolicy_Has_Special
Indicates if the password must contain at least one special character. A special character is a
character in the set "~!@#$%^&*()-+". 

Syntax
ConnectionPropertyType PwdPolicy_Has_Special 

Parameters
None.

Returns

Returns true if the password must contain at least one special character.

Examples

• PwdPolicy_Has_Special

bool? has_special = 
appSettings.getBooleanProperty(ConnectionPropertyType.PwdPolicy_H
as_Special);

PwdPolicy_Expires_In_N_Days
Specifies the number of days in which the password expires from the date of setting the
password. 

Syntax
ConnectionPropertyType PwdPolicy_Expires_In_N_Days 

Parameters
None.

Returns

Returns an integer value for the number of days in which the password expires.
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Examples

• PwdPolicy_Expires_In_N_Days

int? expires_in_n_days = 
appSettings.getIntegerProperty(ConnectionPropertyType.PwdPolicy_E
xpires_In_N_Days);

PwdPolicy_Min_Unique_Chars
Specifies the minimum number of unique characters in the password. 

Syntax
ConnectionPropertyType PwdPolicy_Min_Unique_Chars 

Parameters
None.

Returns

An integer specifying the minimum number of unique characters in the password.

Examples

• PwdPolicy_Min_Unique_Characters

int? min_unique_characters = 
appSettings.getIntegerProperty(ConnectionPropertyType.PwdPolicy_M
in_Unique_Chars);

PwdPolicy_Lock_Timeout
Specifies the timeout value (in seconds) after which the vault is locked from the unlock time. A
value of 0 indicates no timeout.

Syntax
ConnectionPropertyType PwdPolicy_Lock_Timeout 

Parameters
None.

Returns

An integer specifying the timeout value.
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Examples

• PwdPolicy_Lock_Timeout

int? lock_timeout = 
appSettings.getIntegerProperty(ConnectionPropertyType.PwdPolicy_L
ock_Timeout);

PwdPolicy_Retry_Limit
Specifies the number of failed unlock attempts after which the data vault is deleted. A value of
0 indicates no retry limit.

Syntax
ConnectionPropertyType PwdPolicy_Retry_Limit 

Parameters
None.

Returns

An integer specifying the number of failed unlock attempts after which the data vault is
deleted.

Examples

• PwdPolicy_Retry_Limit

int? retry_limit = 
appSettings.GetIntegerProperty(ConnectionPropertyType.PwdPolicy_R
etry_Limit);

Connection APIs
The Connection APIs contain methods for managing local database information, establishing
a connection with the Unwired Server, and authenticating.

ConnectionProfile
The ConnectionProfile class manages local database information. Set its properties,
including the encryption key, during application initialization, and before creating or
accessing the local client database.

By default, the database class name is generated as "packageName"+"DB".
ConnectionProfile cp = SUP101DB.GetConnectionProfile();
cp.EncryptionKey = "Your encryption key"; //Encryption key could be 
of arbitrary length. Generally the longer, the better.
cp.Save();
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You can also generate an encryption key by calling the generated database's
GenerateEncryptionKey method, and then store the key inside a DataVault object.
The GenerateEncryptionKey method automatically sets the encryption key in the
connection profile.

You can use the cacheSize connection property to control the size of the memory cache
used by the database.
public int CacheSize {get; set; } 

Managing Device Database Connections
Use the OpenConnection() and CloseConnection() methods generated in the
package database class to manage device database connections.

Note: Any database operation triggers the establishment of the database connection. You do
not need to explicitly call the openConnection API.

The OpenConnection() method checks that the package database exists, creates it if it
does not, and establishes a connection to the database. This method is useful when first starting
the application: since it takes a few seconds to open the database when creating the first
connection, if the application starts up with a login screen and a background thread that
performs the OpenConnection() method, after logging in, the connection is most likely
already established and is immediately available to the user.

All ConnectionProfile properties should be set before the first access to database,
otherwise they will not take effect.

The CloseConnection() method closes all database connections for this package and
releases all resources allocated for those connections. This is recommended to be part of the
application shutdown process.

Improving Device Application Performance with One Writer Thread and
Multiple Database Access Threads
The maxDbConnections property improves device application performance by allowing
multiple threads to access data concurrently from the same local database.

Connection management allows you to have at most one writer thread concurrent with
multiple reader threads. There can be other reader threads at the same time that the writer
thread is writing to the database. The total number of threads are controlled by the
maxDbConnections property.

In a typical device application such as Sybase Mobile CRM, a list view lists all the entities of a
selected type. When pagination is used, background threads load subsequent pages. When the
device application user selects an entry from the list, the detail view of that entry appears, and
loads the details for that entry.

Prior to the implementation of maxDbConnections, access to the package on the local
database was serialized. That is, an MBO database operation, such as, create, read, update, or
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delete (CRUD) operation waited for any previous operation to finish before the next was
allowed to proceed. In the list view to detail view example, when the background thread is
loading the entire list, and a user selects the details of one entry for display, the loading of
details for that entry must wait until the entire list is loaded, which can be a long while,
depending on the size of the list.

You can specify the number of total threads using maxDbConnections.

The ConnectionProfile class in the persistence package includes the
maxDbConnections property, which you set before performing any operation in the
application. The default value (maximum number of concurrent read threads) is 2.

ConnectionProfile connectionProfile = 
SUP101DB.GetConnectionProfile();

To allow 6 concurrent threads, set the maxDbConnections property to 6 in
ConnectionProfile before accessing the package database at the beginning of the
application.
    connectionProfile.MaxDbConnections = 6;

Set Database File Property
You can use setProperty to specify the database file name on the device, such as the
directory of the running program, a specific directory path, or a secure digital (SD) card.

ConnectionProfile cp = SUP101DB.GetConnectionProfile();
cp.SetProperty("databaseFile", "sup101.udb");
cp.Save();

Examples
The databaseFile is created in the /Temp directory of the Windows Mobile device:

/Temp/mydb.udb

The databaseFile is created on an SD card:
"/Storage Card/mydb.udb"

Note: For the database file path and name, the forward slash (/) is required as the path
delimiter, for example /smartcard/supprj.db.

Usage
• Be sure to call this API before the database is created..
• The database is UltraLite™; use a database file name like mydb.udb.
• For DOE applications, the database is SQLite; use a database file name like mydb.db.
• If the device client user changes the file name, he or she must make sure the input file name

is a valid name and path on the client side.

Note: Sybase recommends using industrial grade SD cards using Single Level Cell (SLC)
technology. SD cards that use SLC technology are generally more reliable and faster than
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MLC cards, although they may be more limited in size and more expensive per unit of storage.
Not all SD cards perform equally, and it is advised that customers evaluate the benchmarks
available from different suppliers.

Synchronization Profile
The Synchronization Profile contains information for establishing a connection with the
Unwired Server's data synchronization channel where the server package has been deployed.
The Sybase.Persistence.ConnectionProfile class manages that information.
By default, this information includes the server host, port, domain name, certificate and public
key that are pushed by the message channel during the registration process.

Settings are automatically provisioned from the Unwired Server. The values of the settings are
inherited from the application connection template used for the registration of the application
connection (automatic or manual). You must make use of the connection and security settings
that are automatically used by the Object API.

Typically, the application uses the settings as sent from the Unwired Server to connect to the
Unwired Server for synchronization so that the administrator can set those at the application
deployment time based on their deployment topology (for example, using relay server, using
e2ee security, or a certificate used for the intermediary, such as a Relay Server Web server).
See the Applications and Application Connection Templates topics in System
Administration.
ConnectionProfile profile = SUP101DB.GetSynchronizationProfile();
profile.DomainName = "default";
profile.ServerName = "host-name";
profile.PortNumber = 2481;
profile.NetworkProtocol = "https";
profile.StreamParams.Trusted_Certificates = "rsa_public_cert.crt";

You can allow clients to compress traffic as they communicate with the Unwired Server by
including "compression=zlib" into the sync parameters:
NetworkStreamParams streamParams = 
MyDatabase.GetSynchronizationProfile().StreamParams;
streamParams.Compression= "zlib";
streamParams.Zlib_Upload_Window_Size= 12;
streamParams.Zlib_Download_Window_Size= 12;

By default, compression is disabled.

You can allow clients to authenticate with a proxy server by including a username and
password in the sync parameters. This feature supports Basic and Digest authentication as
described in RFC 2617. With Basic authentication, passwords are included in HTTP headers
in clear text; however, you can use HTTPS to encrypt the headers and protect the password.
With Digest authentication, headers are not sent in clear text but are hashed.
SUP101DB.GetSynchronizationProfile().NetworkStreamParams += 
";http_userid=supAdmin;http_password=supPwd";
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Connect the Data Synchronization Channel Through a Relay Server
To enable your client application to connect through a relay server, you must make manual
configuration changes in the object API code to provide the relay server properties.

Edit SUP101DB by modifying the values of the relay server properties for your Relay Server
environment.
ConnectionProfile syncProfile = 
SUP101DB.GetSynchronizationProfile();
syncProfile.ServerName = "examplexp-vm1";
syncProfile.PortNumber = 80;
syncProfile.NetworkProtocol = "http";
NetworkStreamParams streamParams = 
GetSynchronizationProfile().StreamParams;
streamParams.Url_Suffix = "/cli/iarelayserver/<FarmName>";
GetSynchronizationProfile().setDomainName("default");

To update properties for the relay server installed on Internet Information Services (IIS) on
Microsoft Windows:
ConnectionProfile syncProfile = 
SUP101DB.GetSynchronizationProfile();
syncProfile.ServerName = "examplexp-vm1";
syncProfile.PortNumber = 80;
syncProfile.NetworkProtocol = "http";
NetworkStreamParams streamParams = 
GetSynchronizationProfile().StreamParams;
streamParams.Url_Suffix = "/ias_relay_server/client/rs_client.dll/
<FarmName>";
GetSynchronizationProfile().setDomainName("default");

For more information on relay server configuration, see System Administration and Sybase
Control Center for Unwired Server.

Asynchronous Operation Replay
Upload operation replay records asynchronously.

When an application calls SubmitPending on an MBO on which a create, update, or delete
operation is performed, an operation replay record is created on the device local database.

When Synchronize is called, the operation replay records are uploaded to the server. The
method returns without waiting for the backend to replay those records. The Synchronize
method downloads all the latest data changes and the results of the previously uploaded
operation replay records that the backend has finished replaying in the background. If you
choose to disable asynchronous operation replay, each Synchronize call will wait for the
backend to finish replaying all the current uploaded operation replay records.

This feature is enabled by default. You can enable or disable the feature by setting the
asyncReplay property in the synchronization profile. The following code shows how to
disable asynchronous replay:
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SUP101DB.GetSynchronizationProfile().AsyncReplay = false;

You can specify an upload-only synchronization where the client sends its changes to the
server, but does not download other changes from the server. This type of synchronization
conserves device resources when receiving changes from the server.
public static void 
BeginSynchronize(Sybase.Collections.GenericList<Sybase.Persistence.
ISynchronizationGroup> sgs,object context, bool uploadOnly)

When asynchronous replay is enabled and the replay is finished, the OnSynchronize callback
method is invoked with a SynchronizationStatus value of
SynchronizationStatus.ASYNC_REPLAY_COMPLETED. Use this callback
method to invoke a synchronize call to pull in the results, as shown in the following callback
handler.
public virtual SynchronizationAction OnSynchronize( 
  Sybase.Collections.GenericList<ISynchronizationGroup> groups,
  SynchronizationContext context)
{
  switch(context.Status)
  {
    case SynchronizationStatus.ASYNC_REPLAY_UPLOADED:
      LogMessage("AsyncReplay uploaded");
      break;
    case SynchronizationStatus.ASYNC_REPLAY_COMPLETED:
      // operation replay finished
      if (busy)
      {
        // if busy, don't do synchronize now
        return SynchronizationAction.CANCEL;
      }
      break;
    default:
      break;
  }
            return SynchronizationAction.CONTINUE;
}

Authentication APIs
You can log in to the Unwired Server with your user name and credentials and use the X.509
certificate you installed in the task flow for single sign-on.

Logging In
The generated package database class provides a default synchronization connection profile
according to the Unwired Server connection profile and server domain selected during code
generation. You can log in to the Unwired Server with your user name and credentials.

The package database class provides methods for logging in to the Unwired Server:
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• OnlineLogin() –  authenticates credentials against the Unwired Server.

Sample Code
Illustrates importing the certificate and setting up login credentials, as well as other APIs
related to certificate handling:

// SUP101DB is a generated database class
// First install certificates on your emulator, for example 
"Sybase101.p12"

//Getting certificate from certificate store 
CertificateStore myStore = 
CertificateStore.GetDefault();                     
string filter1 = "Sybase";
StringList labels = myStore.CertificateLabels(filter1, null);        
string aLabel = labels.Item(0);
LoginCertificate lc = myStore.GetSignedCertificate(aLabel, 
"password");

// Save the login certificate to your synchronization profile
SUP101DB.GetSynchronizationProfile().Certificate = lc;

//Perform synchronization
SUP101DB.Synchronize();

// Save the login certificate to your data vault
DataVault vault = null;
if (!DataVault.VaultExists("myVault"))
{
  vault = DataVault.CreateVault("myVault", "password", "salt");
}
else
{
  vault = DataVault.GetVault("myVault");
}
vault.Unlock("password", "salt");
lc.Save("myLabel", vault);

// Get certificate that was previously loaded from the data vault 
LoginCertificate newLc = LoginCertificate.Load("myLabel", vault);

// Delete the certificate from the data vault
LoginCertificate.Delete("myLabel", vault);

Single Sign-On With X.509 Certificate Related Object API
Use these classes and attributes when developing mobile applications that require X.509
certificate authentication.

• CertificateStore class - wraps platform-specific key/certificate store class, or file
directory
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• LoginCertificate class - wraps platform-specific X.509 distinguished name and
signed certificate

• ConnectionProfile class - includes the certificate attribute used for Unwired Server
synchronization.

Refer to the API Reference for implementation details.

Importing a Certificate into the Data Vault
Obtain a certificate reference and store it in a password-protected data vault to use for X.509
certificate authentication.

The difference between importing a certificate from a system store or a file directory is
determined by how you obtain the CertificateStore object. In either case, only a label
and password are required to import a certificate blob, which is a digitally signed copy of the
public X.509 certificate.

//Obtain a reference to the certificate store
CertificateStore myStore = CertificateStore.GetDefault();

//List all certificate labels from the certificate store
StringList labels = myStore.CertificateLabels();

//List the certificate labels filtered by subject
String filter1 = "Sybase";
labels = myStore.CertificateLabels(filter1, null);

//Get a LoginCertificate from the certificate store
string aLabel = ... //ask user to select a label
string password = ... //prompt user for password
LoginCertificate lc = myStore.GetSignedCertificate(aLabel, 
password);

//Save/Load/Delete...LoginCertificate 
//Create or lookup a data vault
DataVault vault = null;
if (!DataVault.VaultExists("myVault"))
{
    vault = DataVault.CreateVault("myVault", "password", "salt");
}
else
{
    vault = DataVault.GetVault("myVault");
}

Selecting a Certificate for Unwired Server Connections
Select the X.509 certificate from the data vault for Unwired Server authentication.

//Unlock the vault before using it
vault.Unlock("password", "salt");
//Save the certificate with specified label
lc.Save("myLabel", vault);
//load the certificate from data vault by label
LoginCertificate newLc = LoginCertificate.Load("myLabel", vault);
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//Delete the certificate from the data vault
LoginCertificate.Delete("myLabel", vault);

Connecting to Unwired Server with a Certificate
Once the certificate property is set, use the LoginToSync or OnlineLogin API with no
parameters to connect to Unwired Server with the login certificate.

//connect to Unwired Server with the login certificate
SUP101DB.GetSynchronizationProfile().Certificate = lc;
SUP101DB.OnlineLogin();  

Personalization APIs
Personalization keys allow the application to define certain input parameter values that are
personalized for each mobile user. Personalization parameters provide default values for
synchronization parameters when the synchronization key of the object is mapped to the
personalization key while developing a mobile business object. The Personalization APIs
allow you to manage personalization keys, and get and set personalization key values.

Type of Personalization Keys
There are three types of personalization keys: client, server, and transient (or session). Client
personalization keys are persisted in the local database. Server personalization keys are
persisted on the Unwired Server. Session personalization keys are not persisted and are lost
when the device application terminates.

A personalization parameter can be a primitive or complex type.

A personalization key is metadata that enables users to store their search preferences on the
client, the server, or by session. The preferences narrow the focus of data retrieved by the
mobile device (also known as the filtering of data between client and Unwired Server). Often
personalization keys are used to hold backend system credentials, so that they can be
propagated to the EIS. To use a personalization key for filtering, it must be mapped to a
synchronization parameter. The developer can also define personalization keys for the
application, and can use built-in personalization keys available in Unwired Server. Two built-
in (session) personalization keys — username and password — can be used to perform single
sign-on from the device application to the Unwired Server, authentication and authorization
on Unwired Server, as well as connecting to the back-end EIS using the same set of
credentials. The password is never saved on the server.

Getting and Setting Personalization Key Values
The PersonalizationParameters class is generated automatically for managing
personalization keys. When a personalization parameter value is changed, the call to save
automatically propagates the change to the server.

Client Object API Usage

94 Sybase Unwired Platform



An operation can have a parameter that is one of the Sybase Unwired Platform list types (such
as IntList, StringList, or ObjectList). This code shows how to set a
personalization key, and pass an array of values and an array of objects:
PersonalizationParameters pp = 
SUP101DB.GetPersonalizationParameters();
pp.MyIntPK = 10002;
pp.Save();
Sybase.Collections.IntList il = new Sybase.Collections.IntList();
il.Add(10001);
il.Add(10002);
pp.MyIntListPK = il;
pp.Save();
Sybase.Collections.GenericList<MyData> dl = new 
Sybase.Collections.GenericList<MyData>(); //MyData is a structure 
type defined in tooling
MyData md = new MyData();
md.IntMember = 123;
md.StringMember = "abc";
dl.Add(md);
pp.MyDataListPK = dl;
pp.Save();

If a synchronization parameter is personalized, you can overwrite the value of that parameter
with the personalization value.

A personalization parameter cannot have a value of null. When you create a personalization
parameter in Sybase Unwired WorkSpace that allows null as a valid value, and the default
value is null, the parameter may be invalid. Ensure that you enter a valid value for the
password, when you create the parameter, or by specifying a value in your application.

Synchronization APIs
You can synchronize mobile business objects (MBOs) based on synchronization parameters,
for individual MBOs, or as a group, based on the group's synchronization policy.

Note: The LoginToSync API is now deprecated. Call Synchronize or
BeginSynchronize before saving synchronization parameters. After saving the
synchronization parameters, call Synchronize or BeginSynchronize again to
retrieve the new values filtered by those parameters.

Changing Synchronization Parameters
Synchronization parameters let an application change the parameters that retrieve data from
an MBO during a synchronization session.

The primary purpose of synchronization parameters is to partition data. Change the
synchronization parameters to affect the data you are working with (including searches), and
synchronization.
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When a synchronization parameter value is changed, the call to Save automatically
propagates the change to the Unwired Server.
CustomerSynchronizationParameters sp = 
Customer.SynchronizationParameters;
            sp.State = "CA";
            sp.Save();

Note: The Sybase Unwired Platform server will not send MBO data to a device if an MBO has
synchronization parameters defined, unless the application client code calls the Save
method. The next synchronize call will retrieve data from the server. This is true even if default
values are defined for its synchronization parameters.

Performing Mobile Business Object Synchronization
A synchronization group is a group of related MBOs. A mobile application can have
predefined synchronization groups. An implicit default synchronization group includes all the
MBOs that are not in any other synchronization group.

This code synchronizes an MBO package using a specified connection:
SUP101DB.Synchronize (string synchronizationGroup) 

The package database class includes two synchronization methods. You can synchronize a
specified group of MBOs using the synchronization group name:
SUP101DB.Synchronize("my-sync-group");

Or, you can synchronize all synchronization groups:
SUP101DB.Synchronize();

There is a default synchronization group within every package. The default synchronization
group includes all MBOs except those already included by other synchronization groups. To
synchronize a default synchronization group call
SUP101DB.BeginSynchronize("default"); or
SUP101DB.Synchronize("default");
If there is no other synchronization group, call SUP101DB.BeginSynchronize(); or
SUP101DB.Synchronize();
To synchronize a synchronization group asynchronously:
GenericList<SynchronizationGroup> syncGroups = new 
GenericList<SynchronizationGroup>();
syncGroups.add(SUP101DB.GetSynchronizationGroup("my-sync-group"));
SUP101DB.BeginSynchronize(syncGroups, "");

When an application uses a create, update, or delete operation in an MBO and calls the
SubmitPending metod, an OperationReplay object is created for that change. The
application must invoke either the Synchronize or BeginSynchronize method to
upload the OperationReplay object to the server to replay the change on the backend data

Client Object API Usage

96 Sybase Unwired Platform



source. The IsReplayQueueEmpty API is used to check if there are unsent operation
replay objects and decide whether a synchronize call is needed.

Message-Based Synchronization APIs
The message-based synchronization APIs enable a user application to subscribe to a server
package, to remove an existing subscription from the Unwired Server, to suspend or resume
requests to the Unwired Server, and to recover data related to the package from the server.

Note: The BeginOnlineLogin, SuspendSubscription,
ResumeSubscription, and VacuumDatabasen methods are for use with DOE-based
applications only.

BeginOnlineLogin
Sends a login message to the Unwired Server with the username and password.

Typically, the generated package database class already has a valid synchronization
connection profile and you can log in to the Unwired Server with your username and
credentials.

beginOnlineLogin sends a message to the Unwired Server with the username and password.
The Unwired Server responds with a message to the client with the login success or failure.

When the login succeeds, the OnLoginSuccess method of the ICallbackHandler is
invoked. When the login fails, the OnLoginFailure method of the ICallbackHandler is
invoked.

Syntax
public static void BeginOnlineLogin(string username, string 
password)

Parameters

• userName – the user name.
• password – the password.

Returns

None.

Examples

• Begin an Online Login – Start logging in with "supAdminID" for the user name and
"supPass" for the password.
SUP101DB.BeginOnlineLogin("supAdminID", "supPass");
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Subscribe
Subscribes to a server package. A subscription message is sent to the Unwired Server and the
application receives a subscription request result notification from the Unwired Server. If the
subscription succeeds, the OnSubscribeSuccess method of the ICallbackHandler is
invoked. If the subscription fails, the OnSubscribeFailure method of the
ICallbackHandler is invoked.

Prerequisites for using subscribe:

• The mobile application is compiled with the client framework and deployed to a mobile
device, together with the Sybase Unwired Platform client process.

• The device application has already configured Unwired Server connection information.

Syntax
public static void Subscribe()

Parameters

• None – subscribe has no parameters.

Returns

None.

Examples

• Subscribe to a Sample Application – Subscribe to SUP101DB.
SUP101DB. Subscribe();

Unsubscribe
Removes an existing subscription to a server package. An unsubscription message is sent to
the Unwired Server and the application receives a subscription request result notification from
the Unwired Server as a notification. The data on the local database is cleaned. If the
unsubscribe succeeds, the OnSubscribeSuccess method of the ICallbackHandler is
invoked. If it fails, the OnSubscribeFailure method of the ICallbackHandler is invoked.

The device application must already have a subscription with the server.

Syntax
public static void Unsubscribe()

Parameters

• None – unsubscribe has no parameters.
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Returns

None.

Examples

• Unsubscribe from a Sample Application – Unsubscribe from SUP101DB.
SUP101DB.Unsubscribe();

SuspendSubscription
Sends a suspend request to the Unwired Server to notify the server to stop delivering data
changes. A suspend subscription message is sent to the Unwired Server and the application
receives a suspend subscription request result notification from the Unwired Server as a
notification. If the suspend succeeds, the OnSuspendSubscriptionSuccess method
of the ICallbackHandler is invoked. If the suspend fails, the
OnSuspendSubscriptionFailure method of the ICallbackHandler is invoked.

Syntax
public static void SuspendScription()

Parameters

• None – suspendSubscription has no parameters.

Returns

None.

Examples

• Suspend a Subscription – Suspend the subscription to SUP101DB.
SUP101DB.SuspendScription();

BeginSynchronize
Sends a message to the Unwired Server to synchronize data between the client and the server.
There are two different beginSynchronize APIs, one with no parameters that synchronizes all
the groups, and one that takes a list of groups.

The synchronization completes in the background through an asynchronous message
exchange with the server. If application code needs to know when the synchronization is
complete, a callback handler that implements the onSynchronize method must be
registered with the database class.
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Syntax
public static void 
BeginSynchronize(Sybase.Collections.GenericList<Sybase.Persistence. 
ISynchronizationGroup> synchronizationGroups, string context)

Parameters

• synchronizationGroups – specifies a list of a list of
SynchronizationGroupISynchronizationGroup objects representing the
groups to be synchronized. If omitted, begin synchronizing data for all groups.

Note: This parameter is not relevant for DOE packages; pass a null value to this parameter.

Returns
None.

Examples

• Synchronize Data between Client and Server – Synchronize data for SampleAppDB for
SUP101DB group.
SUP101DB.BeginSynchronize(null, "your context");

ResumeSubscription
Sends a resume request to the Unwired Server.

The resume request notifies the Unwired Server to resume sending data changes for the
subscription that had been suspended. On success, onResumeSubscriptionSuccess callback
handler method is called. On failure, onResumeSubscriptionFailure callback handler is
called.

Syntax
public static void ResumeSubscription()

Parameters

• None – resumeSubscription has no parameters.

Returns

None.

Examples

• Resume a Subscription – Resume the subscription to SUP101DB.
SUP101DB.ResumeScription();
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VacuumDatabase
Reclaims unused database space left when records are deleted, reducing the size of the
database file.

When a large amount of data is deleted from the database file it leaves behind empty space, or
"free" database pages. Running VacuumDatabase to rebuild the database reclaims this
space. The size of the database file is reduced by the amount of space reclaimed.

Syntax
public static void VacuumDatabase()

Parameters

• None – VacuumDatabase has no parameters.

Returns

None.

Examples

• Reclaim Empty Space in Database – Reclaim empty space in SUP101DB database.
SUP101DB.VacuumDatabase();

Push Synchronization Applications
Clients receive device notifications when a data change is detected for any of the MBOs in the
synchronization group to which they are subscribed.

Sybase Unwired Platform uses a messaging channel to send change notifications from the
server to the client device. By default, change notification is disabled. You can enable the
change notification of a synchronization group: If you see that setInterval is set to 0, then
change detection is disabled, and notifications will not be delivered. Enable change detection
and notification delivery by setting an appropriate value. For recommendations, see
Configuring Synchronization Groups in Sybase Control Center Online Help.

ISynchronizationGroup sg = 
SUP101DB.GetSynchronizationGroup("TCNEnabled");

if (!sg.EnableSIS)
{
  sg.EnableSIS = true;
  sg.Interval = 2;
  sg.Save();
  SUP101DB.Synchronize("TCNEnabled");
}

When the server detects changes in an MBO affecting a client device, and the synchronization
group of the MBO has change detection enabled, the server will send a notification to client
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device through messaging channel. By default, a background synchronization downloads the
changes for that synchronization group. The application can implement the onSynchronize
callback method to monitor this condition, and either allow or disallow background
synchronization.
public int OnSynchronize(GenericList<ISynchronizationGroup> groups, 
SynchronizationContext context)
{
  int status = context.Status;
  if (status == SynchronizationStatus.STARTING_ON_NOTIFICATION)
  {
    // There is changes on the synchronization group
    if (busy)
    {
      return SynchronizationAction.CANCEL;
    }
    else
    {
      return SynchronizationAction.CONTINUE;
    }
  }

  // return CONTINUE for all other status
  return SynchronizationAction.CONTINUE;
}

Retrieving Information about Synchronization Groups
The package database class provides the following two methods for querying the
synchronized state and the last synchronization time of a certain synchronization group:

/// Determines if the synchronization group was synchronized
public static bool IsSynchronized(string synchronizationGroup)

/// Retrieves the last synchronization time of the synchronization 
group
public static System.DateTime GetLastSynchronizationTime(string 
synchronizationGroup)

Log Record APIs
The Log Record APIs allow you to customize aspects of logging.

• Writing and retrieving log records (successful operations are not logged).
• Configuring log levels for messages reported to the console.
• Enabling the printing of server message headers and message contents, database

exceptions, and LogRecord objects written for each import.

• Viewing detailed trace information on database calls.
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• The change log can be enabled or disabled with the EnableChangeLog and
DisableChangeLog methods. You can retrieve the change log by calling the
GetChangeLogs method.

Log records are automatically created when an operation replay fails in the Unwired Server. If
an operation replay succeeds, there is no LogRecord created by default (note that an SAP
default result checker may write a log record even when the SAP operation succeeds). To get
the confirmation when an operation replay succeeds, register a CallbackHandler and
implement the CallbackHandler.onReplaySuccess method. See Developer Guide:
BlackBerry Object API Applications > Client Object API Usage > Callback and Listener
APIs.

LogRecord API
LogRecord stores two types of logs.

• Operation logs on the Unwired Server. These logs can be downloaded to the device.
• Client logs. These logs can be uploaded to the Unwired Server.

SUP101DB.GetLogger – gets the log API. The client can write its own records using the
log API. For example:
ILogger logger = SUP101DB.GetLogger();
    logger.Debug("Write this string to the log records table");
    SUP101DB.SubmitLogRecords();

SUP101DB.GetLogRecords – gets the log records received from the server. For
example:
Query query = new Query();
query.TestCriteria = 
Sybase.Persistence.AttributeTest.Equal("component", "Customer");
Sybase.Persistence.SortCriteria sortCriteria = new 
Sybase.Persistence.SortCriteria();         
sortCriteria.Add("requestId", 
Sybase.Persistence.SortOrder.DESCENDING);           
query.SortCriteria = sortCriteria;

GenericList<ILogRecord> loglist = SUP101DB.GetLogRecords(query);

This sample code shows how to find the corresponding MBO with the LogRecord and to
delete the log record when a record is processed.
private void processLogRecords()
  {
    Query query = new Query();
    GenericList<ILogRecord> logRecords = 
SUP101DB.GetLogRecords(query);
    bool callSync = false;
    foreach (ILogRecord log in logRecords)
    {
      // log warning message
      BenchmarkUtils.AddInfo("log " + log.Component + ":" 
        + log.EntityKey
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    + " code:" + log.Code
        + " msg:" + log.Message);
            
      if (log.Component.Equals("Customer"))
      {
        long surrogateKey = Convert.ToInt64(log.EntityKey);
    Customer c = Customer.Find(surrogateKey);
    if (c.IsPending)
    {
      c.CancelPending();
    }
                
    log.Delete();
    log.SubmitPending();
    callSync = true;
      }
    }
        
      if (callSync)
      {
       SUP101DB.BeginSynchronize(null, null);
      }
  }

Logger APIs
Use the Logger API to set the log level and create log records on the client.

Each package has a Logger. To obtain the package logger, use the GetLogger method in
the generated database class.
Logger logger = SUP101DB.GetLogger();

// set log level to debug
logger.LogLevel = LogLevel.DEBUG;

// create a log record with ERROR level and the error message.
logger.Error("Some error message");

Change Log API
The change log allows a client to retrieve entity changes from the back end. If a client
application already has a list view constructed, it simply needs to add, modify, or delete entries
in the list according to the change logs.

A single ChangeLog is generated for each changed entity. If the changed entity is a child of a
composite relationship, there is also a ChangeLog for its parent root entity.

EntityType
Returns the entity type.
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Syntax
int EntityType

Parameters
None.

Returns
Returns the entity type. The entity type values are defined in the generated C# class
EntityType.cs for the package.

Examples

• Get the Entity Type

EntityType

GetOperationType
Returns the operation type of the MBO.

Syntax
char OperationType

Parameters
None.

Returns
The operation type of the MBO. Possible values are 'U' for update and insert, and 'D' for
delete.

Examples

• Get the Operation Type

OperationType

GetRootEntityType
Returns the name of the root parent entity type

Syntax
int RootEntityType

Parameters
None.
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Returns
Returns the root entity type which is the root of the object graph.

Examples

• Get the Root Entity Type

RootEntityType

GetRootSurrogateKey
Returns the surrogate key of the root parent entity.

Syntax
long RootSurrogateKey

Parameters
None.

Returns
The surrogateKey of the root entity.

Examples

• Get the Root Surrogate Key

RootSurrogateKey

GetSurrogateKey
Returns the surrogate key of the entity.

Syntax
long SurrogateKey

Parameters
None.

Returns
The surrogate key of the affected entity. Note that the change log contains all affected entities,
including children of the object graph.
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Examples

• Get the Surrogate Key

SurrogateKey

Methods in the Generated Database Class
You can use generated methods in the package database class to manage change logs.

EnableChangeLog
By default, Change Log is disabled. To enable the change log, invoke the
enableChangeLog API in the generated database class. The next synchronization will
have change logs sent to the client.

Syntax
EnableChangeLog();

Returns

None.

Examples

• Enable Change Log

SUP101DB.EnableChangeLog();

GetChangeLogs
Retrieve a list of change logs.

Syntax
GetChangeLog();

Returns

Returns a GenericList of type <Change Log>.

Examples

• Get Change Logs

SUP101DB.GetChangeLog();
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DeleteChangeLogs
You are recommended to delete all change logs after the application has completed processing
them. Use the deleteChangeLogs API in the generated database class to delete all change
logs on the device.

Syntax
DeleteChangeLogs();

Returns

None.

Examples

• Delete Change Logs

SUP101DB.DeleteChangeLogs();

Usage

Ensure that when calling deleteChangeLogs(), there are no change logs created from a
background synchronization that are not part of the original change log list returned by a
specific query:
GenericList<IChangeLog> changes = SUP101DB.GetChangeLogs(myQuery);

You should only call deleteChangeLogs() in the onSynchronize() callback where
there are no multiple synchronizations occurring simulatenously.

DisableChangeLog
Creating change logs consumes some processing time, which can impact application
performance. The application may can disable the change log using the
disableChangeLog API.

Syntax
DisableChangeLog();

Returns

None.
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Examples

• Disable Change Log

SUP101DB.DisableChangeLog();

Code Samples
Enable the change log and list all changes, or only the change logs for a particular entity,
Customer.

SUP101DB.EnableChangeLog();
SUP101DB.Synchronize();

// Retrieve all change logs
GenericList<IChangeLog> logs = SUP101DB.GetChangeLogs(new Query());
Console.WriteLine("There are " + logs.Count + " change logs");
foreach (IChangeLog log in logs)
{
Console.WriteLine(log.EntityType
+ "(" + log.SurrogateKey
+ "): " + log.OperationType);
}

// Retrieve only the change logs for Customer:
Query query = new Query();
AttributeTest at = new AttributeTest("entityType", 
SUP101.EntityType.Customer,
AttributeTest.EQUAL);
query.TestCriteria = at;
logs = SUP101DB.GetChangeLogs(query);
Console.WriteLine("There are " + logs.size() + " change logs for 
Customer");
foreach (IChangeLog log in logs)
{
Console.WriteLine(log.EntityType
+ "(" + log.SurrogateKey
+ "): " + log.OperationType);
}

Security APIs
The security APIs allow you to customize some aspects of connection and database security.

Connect Using a Certificate
You can set certificate information in ConnectionProfile.

ConnectionProfile profile = SUP101DB.GetSynchronizationProfile();
profile.DomainName = "default";        
profile.ServerName = "host-name";
profile.PortNumber = 2481;
profile.NetworkProtocol = "https";
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Encrypt the Database
You can set the encryption key of a local database. Set the key during application initialization,
and before creating or accessing the client database.

The length of the encyption key cannot be fewer than 16 characters.

The encryption key must follow the rules applicable to DBKEY in UltraLite:

• Any leading or trailing spaces in parameter values are ignored.
• The value cannot include leading single quotes, leading double quotes, or semicolons.

ConnectionProfile profile = SUP101DB.GetConnectionProfile();
profile.EncryptionKey = "Your encryption key"; //Encryption key can 
be of arbitrary length. Generally the longer, the better.

You can use the generateEncryptionKey() method to encrypt the local database with
a random encryption key.
SUP101DB.GenerateEncryptionKey();
// store the encryption key at somewhere for reuse later
ConnectionProfile profile = SUP101DB.GetConnectionProfile();
String key = profile.EncryptionKey;
...
SUP101DB.CreateDatabase();

End to End Encryption and Compression Support APIs
Use encryption communication parameters to ensure end to end encryption and eliminate any
WAP gap security problems.

You can use the Client Object API to set up end to end encryption, supported by Ultralite, and
HTTPS items in the synchronization profile. Encryption is not enabled by default, but must be
explicitly set.

Refer to the following APIs when setting up end to end encryption and compression support:

• Sybase.Persistence.ConnectionProfile.StreamParams
• Sybase.Persistence.NetworkStreamParams.E2ee_Public_Key
• Sybase.Persistence.NetworkStreamParams.E2ee_Type
• Sybase.Persistence.NetworkStreamParams.Tls_Type
• Sybase.Persistence.NetworkStreamParams.Trusted_Certificate

s
• Sybase.Persistence.NetworkStreamParams.Trusted_Certificate

s
• Sybase.Persistence.NetworkStreamParams.Url_Suffix
• Sybase.Persistence.NetworkStreamParams.Zlib_Download_Windo

w_Size
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• Sybase.Persistence.NetworkStreamParams.Zlib_Upload_Window_
Size

The following code example shows how to set SUP101:
ConnectionProfile conn=SUP101DB.GetSynchronizationProfile();
conn.NetworkProtocol = "HTTP"; 
conn.PortNumber = 2480;
conn.StreamParams().E2ee_Type = "rsa";
conn.StreamParams().E2ee_Public_Key = "e2ee_public_key.key";
conn.Save();

DataVault
The DataVault class provides encrypted storage of occasionally used, small pieces of data.
All exceptions thrown by DataVault methods are of type DataVaultException.

If you have installed the utility files DataVault.cs and DataVaultException.cs
into your application, you can use the DataVault class for on-device persistent storage of
certificates, database encryption keys, passwords, and other sensitive items. Use this class to:

• Create a vault
• Set a vault's properties
• Store objects in a vault
• Retrieve objects from a vault
• Change the password used to access a vault

The contents of the data vault are strongly encrypted using AES-256. The DataVault class
allows you create a named vault, and specify a password and salt used to unlock it. The
password can be of arbitrary length and can include any characters. The password and salt
together generate the AES key. If the user enters the same password when unlocking, the
contents are decrypted. If the user enters an incorrect password, exceptions occur. If the user
enters an incorrect password a configurable number of times, the vault is deleted and any data
stored within it becomes unrecoverable. The vault can also relock itself after a configurable
amount of time.

Typical usage of the DataVault is to implement an application login screen. Upon
application start, the user is prompted for a password, which unlocks the vault. If the unlock
attempt is successful, the user is allowed into the rest of the application. User credentials for
synchronization can also be extracted from the vault so the user need not reenter passwords.

CreateVault
Creates a new secure store (a vault).

A unique name is assigned, and after creation, the vault is referenced and accessed by that
name. This method also assigns a password and salt value to the vault. If a vault with the same
name already exists, this method throws an exception. A newly created vault is in the unlocked
state.
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Syntax
public static DataVault CreateVault(
   string sDataVaultID,
   string sPassword,
   string sSalt
)

Parameters

• sDataVaultID –

an arbitrary name for a DataVault instance on this device. This name is effectively the
primary key for looking up DataVault instances on the device, so it cannot use the same
name as any existing instance. If it does, this method throws an exception with error code
INVALID_ARG. The name also cannot be empty or null.

• sPassword – the initial encryption password for this DataVault. This is the password
needed for unlocking the vault. If null is passed, a default password is computed and used.

• sSalt – the encryption salt value for this DataVault. This value, combined with the
password, creates the actual encryption key that protects the data in the vault. If null is
passed, a default salt is computed and used.

Returns

Returns the newly created instance of the DataVault with the provided ID. The returned
DataVault is in the unlocked state with default configuration values. To change the default
configuration values, you can immediately call the "set" methods for the values you want to
change.

If a vault already exists with the same name, a DataVaultException is thrown with the
reason ALREADY_EXISTS.

Examples

• Create a data vault – creates a new data vault called myVault.

DataVault vault = null;
if (!DataVault.VaultExists("myVault"))
{
   vault = DataVault.CreateVault("myVault", "password", "salt");
}
else
{
   vault = DataVault.GetVault("myVault");
}
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VaultExists
Tests whether the specified vault exists.

Syntax
public static bool VaultExists(string sDataVaultID)

Parameters

• sDataVaultID – the vault name.

Returns

Returns true if the vault exists; otherwise returns false.

Examples

• Check if a data vault exists – checks if a data vault called myVault exists, and if so,
deletes it.
if (DataVault.VaultExists("myVault"))
{
   DataVault.DeleteVault("myVault");          
}

GetVault
Retrieves a vault.

Syntax
public static DataVault GetVault(string sDataVaultID)

Parameters

• sDataVaultID – the vault name.

Returns

GetVault returns a DataVault instance.

If the vault does not exist, a DataVaultException is thrown.

DeleteVault
Deletes the specified vault from on-device storage.

If the vault does not exist, this method throws an exception. The vault need not be in the
unlocked state, and can be deleted even if the password is unknown.
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Syntax
public static void DeleteVault(string sDataVaultID)

Parameters

• sDataVaultID – the vault name.

Examples

• Delete a data vault – deletes a data vault called myVault.

if (DataVault.VaultExists("myVault"))
{
   DataVault.DeleteVault("myVault");          
}

GetDataNames
Retrieves information about the data names stored in the vault.

The application can pass the data names to GetValue or GetString to retrieve the data
values.

Syntax
public byte[] GetValue(string sName)

Parameters
None.

Returns

Returns a DVPasswordPolicy object, as an array of DVDataName structure objects.

Examples

• Get data names

// Call getDataNames to retrieve all stored element names from our 
data vault.
DataVault.DVDataName[] dataNameArray = oDataVault.GetDataNames();
for ( int i = 0; i < dataNameArray.GetLength( 0 ); i++ )
{
 if ( dataNameArray[ i ].type == DataVault.DVDataType.String )
  {
    String thisStringValue = 
oDataVault.GetString( dataNameArray[ i ].name );
  }
  else if ( dataNameArray[ i ].type == 
DataVault.DVDataType.Binary )
  {
    byte[] thisBinaryValue = 
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oDataVault.GetValue( dataNameArray[ i ].name );
  }
}

SetPasswordPolicy
Stores the password policy and applies it when ChangePassword is called, or when
validating the password in the Unlock method.

If the application has not set a password policy using this method, the data vault does not
validate the password in the CreateVault or ChangePassword methods. An exception
is thrown if there is any invalid (negative) value in the passwordPolicy object.

Syntax
public void SetPasswordPolicy(DataVault.PasswordPolicy oPolicy)

Parameters

• oPolicy – the password policy constraints.

Examples

• Set a password policy

// SetPasswordPolicy() will always lock the vault to ensure the 
old password
// conforms to the new password policy settings.
oDataVault.SetPasswordPolicy( oPasswordPolicy );

Password Policy Structure
A structure defines the policy used to generate the password.

Table 1. Password Policy Structure

Name Type Description

defaultPasswordAllowed Boolean Indicates if client application is
allowed to use default password
for the data Vault. If this is set to
TRUE and if client application
uses default password then min-
Length, hasDigits, hasUpper,
hasLower and hasSpecial pa-
rameters in the policy are ignor-
ed.

minimumLength Integer The minimum length of the
password.
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Name Type Description

hasDigits Boolean Indicates if the password must
contain digits.

hasUpper Boolean Indicates if the password must
contain uppercase characters.

hasLower Boolean Indicates if the password must
contain lowercase characters.

hasSpecial Boolean Indicates if the password must
contain special characters. The
set of special characters is: “~!
@#$%^&*()-+”.

expirationDays Integer Specifies password expiry days
from the date of setting the pass-
word. 0 indicates no expiry.

minUniqueChars Integer The minimum number of
unique characters in the pass-
word. For example, if length is 5
and minUniqueChars is 4 then
“aaate” or “ababa” would be in-
valid passwords. Instead,
“aaord” would be a valid pass-
word.

lockTimeout Integer The timeout value (in seconds)
after which the vault will be
locked from the unlock time. 0
indicates no timeout. This value
overrides the value set by set-
LockTimeout method.

retryLimit Integer The number of failed unlock at-
tempts after which data vault is
deleted. 0 indicates no retry lim-
it. This value overrides the value
set by the setRetryLimit
method.

Settings for Password Policy
The client applications uses these settings to fill the PasswordPolicy structure. The default
values are used by the data vault when no policy is configured. The defaults are also used in
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Sybase Control Center in the default template. The Sybase Unwired Platform administrator
can modify these settings through Sybase Control Center. The application must set the
password policy for the data vault with the administrative (or alternative) settings.

Note: Setting the password policy locks the vault. The password policy is enforced when
unlock is called (because the password is not saved, calling unlock is the only time that the
policy can be evaluated).

• PROP_DEF_PWDPOLICY_ENABLED – Boolean property with a default value of
false. Indicates if a password policy is enabled by the administrator.

• PROP_DEF_PWDPOLICY_DEFAULT_PASSWORD_ALLOWED – Boolean
property with a default value of false. Indicates if the client application is allowed to use the
default password for the data vault.

• PROP_DEF_PWDPOLICY_MIN_LENGTH – Integer property with a default value of
0. Defines the minimum length for the password.

• PROP_DEF_PWDPOLICY_HAS_DIGITS – Boolean property with a default value of
false. Indicates if the password must contain digits.

• PROP_DEF_PWDPOLICY_HAS_UPPER – Boolean property with a default value of
false. Indicates if the password must contain at least one uppercase character.

• PROP_DEF_PWDPOLICY_HAS_LOWER – Boolean property with a default value of
false. Indicates if the password must contain at least one lowercase character.

• PROP_DEF_PWDPOLICY_HAS_SPECIAL –  Boolean property with a default value
of false. Indicates if the password must contain at least one special character. A special
character is a character in this set “~!@#$%^&*()-+”.

• PROP_DEF_PWDPOLICY_EXPIRATION_DAYS – Integer property with a default
value of 0. Specifies the number of days in which password will expire from the date of
setting the password. Password expiration is checked only when the vault is unlocked.

• PROP_DEF_PWDPOLICY_MIN_UNIQUE_CHARS – Integer property with a
default value of 0. Specifies minimum number of unique characters in the password. For
example, if minimum length is 5 and minUniqueChars is 4 then “aaate” or “ababa” would
be invalid passwords. Instead, “aaord” would be a valid password.

• PROP_DEF_PWDPOLICY_LOCK_TIMEOUT – Integer property with a default
value of 0. Specifies timeout value (in seconds) after which the vault is locked from the
unlock time. 0 indicates no timeout.

• PROP_DEF_PWDPOLICY_RETRY_LIMIT –  Integer property with a default value
of 0. Specifies the number of failed unlock attempts after which data vault is deleted. 0
indicates no retry limit.
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Password Errors
Password policy violations cause exceptions to be thrown.

Table 2. Password Errors

Name Description

PASSWORD_REQUIRED Indicates that a blank or null password was used
when the password policy does not allow default
password.

PASSWORD_UNDER_MIN_LENGTH Indicates that the password length is less than the
required minimum. 

PASSWORD_REQUIRES_DIGIT Indicates that the password does not contain dig-
its.

PASSWORD_REQUIRES_UPPER Indicates that the password does not contain up-
per case characters.

PASSWORD_REQUIRES_LOWER Indicates that the password does not contain low-
er case characters.

PASSWORD_REQUIRES_SPECIAL Indicates that the password does not contain one
of these special characters:  ~!@#$%^&*()-+.

PASSWORD_UNDER_MIN_UNIQUE Indicates that the password contains fewer than
the minimum required number of unique charac-
ters.

PASSWORD_EXPIRED Indicates that the password has been in use longer
than the number of configured expiration days.

GetPasswordPolicy
Retrieves the password policy set by SetPasswordPolicy.

Use this method once the DataVault is unlocked.

Syntax
public DataVault.PasswordPolicy GetPasswordPolicy()

Parameters
None.

Returns

Returns a PasswordPolicy structure that contains the policy set by
SetPasswordPolicy.
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Returns a DVPasswordPolicy object with the default values if no password policy is set.

Examples

• Get the current password policy

// Call getPasswordPolicy() to return the current password policy 
settings.
         DataVault.PasswordPolicy oCurrentPolicy = 
oDataVault.GetPasswordPolicy();

IsDefaultPasswordUsed
Checks whether the default password is used by the vault.

Use this method once the DataVault is unlocked.

Syntax
public bool IsDefaultPasswordUsed()

Returns

Returns Indicates

true Both the default password and the default salt are used to encrypt the
vault.

false Either the default password or the default salt are not used to encrypt the
vault.

Examples

• Check if default password used

// Call isDefaultPasswordused() to see if we are using an 
automatically
// generated password (which we are).
bool isDefaultPasswordUsed = oDataVault.IsDefaultPasswordUsed();

This code example lacks exception handling. For a code example that includes exception
handling, see Developer Guide: Windows and Windows Mobile Object API Applications
> Client Object API Usage > Security APIs > DataVault > Code Sample.

Lock
Locks the vault.

Once a vault is locked, you must unlock it before changing the vault’s properties or storing
anything in it. If the vault is already locked, lock has no effect.

Syntax
public void Lock()
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Examples

• Locks the data vault – prevents changing the vaults properties or stored content.
vault.Lock();

IsLocked
Checks whether the vault is locked.

Syntax
public bool IsLocked()

Returns

Returns Indicates

true The vault is locked.

false The vault is unlocked.

Unlock
Unlocks the vault.

Unlock the vault before changing the its properties or storing anything in it. If the incorrect
password or salt is used, this method throws an exception. If the number of unsuccessful
attempts exceeds the retry limit, the vault is deleted.

The password is validated against the password policy if it has been set using
SetPasswordPolicy. If the password is not compatible with the password policy, an
IncompatiblePassword exception is thrown. In that case, call ChangePassword to
set a new password that is compatible with the password policy.

Syntax
public void Unlock(string sPassword, string sSalt)

Parameters

• sPassword – the encryption password for this DataVault. If null is passed, a default
password is computed and used.

• sSalt – the encryption salt value for this DataVault. This value, combined with the
password, creates the actual encryption key that protects the data in the vault. This value
may be an application-specific constant. If null is passed, a default salt is computed and
used.

Returns

If an incorrect password or salt is used, a DataVaultException is thrown with the reason
INVALID_PASSWORD.

Client Object API Usage

120 Sybase Unwired Platform



Examples

• Unlocks the data vault – once the vault is unlocked, you can change its properties and
stored content.
if (vault.IsLocked())
{
   vault.Unlock("password", "salt");
}

SetString
Stores a string object in the vault.

An exception is thrown if the vault is locked when this method is called.

Syntax
public void SetString(
   string sName,
   string sValue
)

Parameters

• sName – the name associated with the string object to be stored.
• sValue – the string object to store in the vault.

Examples

• Set a string value – creates a test string, unlocks the vault, and sets a string value
associated with the name "testString" in the vault. The finally clause in the
try/catch block ensures that the vault ends in a secure state even if an exception
occurs.
string teststring = "ABCDEFabcdef";
try
{
   vault.Unlock("password", "salt");
   vault.SetString("testString", teststring);
}
catch (DataVaultException e)
{
   Console.WriteLine("Exception: " + e.ToString());
}
finally
{
   vault.Lock();
}

GetString
Retrieves a string value from the vault.

An exception is thrown if the vault is locked when this method is called.
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Syntax
public string GetString(string sName)

Parameters

• sName – the name associated with the string object to be retrieved.

Returns

Returns a string data value, associated with the specified name, from the vault.

Examples

• Get a string value – unlocks the vault and retrieves a string value associated with the name
"testString" in the vault. The finally clause in the try/catch block ensures
that the vault ends in a secure state even if an exception occurs.

try
{
   vault.Unlock("password", "salt");
   String retrievedstring = vault.GetString("testString");
}
catch (DataVaultException e)
{
   Console.WriteLine("Exception: " + e.ToString());
}
finally
{
   vault.Lock();
}

SetValue
Stores a binary object in the vault.

An exception is thrown if the vault is locked when this method is called.

Syntax
public void SetValue(
   string sName,
   byte[] baValue
)

Parameters

• sName – the name associated with the binary object to be stored.
• baValue – the binary object to store in the vault.
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Examples

• Set a binary value – unlocks the vault and stores a binary value associated with the name
"testValue" in the vault. The finally clause in the try/catch block ensures that
the vault ends in a secure state even if an exception occurs.

try
{
   vault.Unlock("password", "salt");
   vault.SetValue("testValue", new byte[] { 1, 2, 3, 4, 5});
}
catch (DataVaultException e)
{
   Console.WriteLine("Exception: " + e.ToString());
}
finally
{
   vault.Lock();
}

GetValue
Retrieves a binary object from the vault.

An exception is thrown if the vault is locked when this method is called.

Syntax
public byte[] GetValue(string sName)

Parameters

• sName – the name associated with the binary object to be retrieved.

Returns

Returns a binary data value, associated with the specified name, from the vault.

Examples

• Get a binary value – unlocks the vault and retrieves a binary value associated with the
name "testValue" in the vault. The finally clause in the try/catch block
ensures that the vault ends in a secure state even if an exception occurs.

try
{
   vault.Unlock("password", "salt");
   byte[] retrievedvalue = vault.GetValue("testValue");
}
catch (DataVaultException e)
{
   Console.WriteLine("Exception: " + e.ToString());
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}
finally
{
   vault.Lock();
}

DeleteValue
Deletes the specified value.

Syntax
public static void DeleteValue(string sName)

Parameters

• sName – the name of the value to be deleted.

Examples

• Delete a value – deletes a value called myValue.

DataVault.DeleteValue("myValue");          

ChangePassword (two parameters)
Changes the password for the vault. Use this method when the vault is unlocked.

Modifies all name/value pairs in the vault to be encrypted with a new password/salt. If the
vault is locked or the new password is empty, an exception is thrown.

Syntax
public void ChangePassword(
   string sPassword,
   string sSalt
)

Parameters

• sPassword – the new password.
• sSalt – the new encryption salt value.

Examples

• Change the password for a data vault – changes the password to "newPassword".
The finally clause in the try/catch block ensures that the vault ends in a secure
state even if an exception occurs.
try
{
   vault.Unlock("password", "salt");
   vault.ChangePassword("newPassword", "newSalt");
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}
catch (DataVaultException e)
{
   Console.WriteLine("Exception: " + e.ToString());
}
finally
{
   vault.Lock();
}

ChangePassword (four parameters)
Changes the password for the vault. Use this method when the vault is locked

This overloaded method ensures the new password is compatible with the password policy,
uses the current password to unlock the vault, and changes the password of the vault to a new
password. If the current password is not valid an InvalidPassword exception is thrown.
If the new password is not compatible with the password policy set in
setPasswordPolicy then an IncompatiblePassword exception is thrown.

Syntax
public void ChangePassword(
    string sOldPassword,
    string sOldSalt,
    string sNewPassword,
    string sNewSalt
)

Parameters

• sOldPassword – the current encryption password for this data vault. If a null value is
passed, a default password is computed and used.

• sOldSalt – the current encryption salt value for this data vault. If a null value is passed, a
default password is computed and used.

• sNewPassword – the new encryption password for this data vault. If a null value is passed,
a default password is computed and used.

• sNewSalt – the new encryption salt value for this data vault. This value, combined with the
password, creates the actual encryption key that protects the data in the vault. This value
may be an application-specific constant. If a null value is passed, a default password is
computed and used.

Examples

• Change the password for a data vault

// Call changePassword with four parameters, even if the vault is 
locked.
// Pass null for oldSalt and oldPassword if the defaults were 
used.
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oDataVault.ChangePassword( null, null, "password!1A", 
"saltD#ddg#k05%gnd[!1A" );

Code Sample
Create a data vault for encrypted storage of application data.

 public void DataVaultSampleCode()
   {
      try
      {
         DataVault oDataVault = null;

         // If this dataVault already exists, then get it by calling 
getVault()
         // Else create this new dataVault by calling createVault()
         if ( DataVault.VaultExists( "DataVaultExample" ) )
            oDataVault = DataVault.GetVault( "DataVaultExample" );
         else
            oDataVault = DataVault.CreateVault( "DataVaultExample", 
"password!1A", "saltD#ddg#k05%gnd[!1A" );

         // Call setLockTimeout(). This allows you to set the timeout 
of the vault in seconds
         oDataVault.SetLockTimeout( 1500 );
         int iTimeout = oDataVault.GetLockTimeout();

         // Call setRetryLimit(). This allows you to set the number of 
retries before the vault is destroyed
         oDataVault.SetRetryLimit( 10 );
         int iRetryLimit = oDataVault.GetRetryLimit();

         // Call setPasswordPolicy(). The passwordPolicy also includes 
the retryLimit and LockTimeout that we set above.
         DataVault.PasswordPolicy oPasswordPolicy = new 
DataVault.PasswordPolicy();
         oPasswordPolicy.defaultPasswordAllowed = true;
         oPasswordPolicy.minimumLength = 4;
         oPasswordPolicy.hasDigits = true;
         oPasswordPolicy.hasUpper = true;
         oPasswordPolicy.hasLower = true;
         oPasswordPolicy.hasSpecial = true;
         oPasswordPolicy.expirationDays = 20;
         oPasswordPolicy.minUniqueChars = 3;
         oPasswordPolicy.lockTimeout = 1600;
         oPasswordPolicy.retryLimit = 20;

         // SetPasswordPolicy() will always lock the vault to ensure 
the old password
         // conforms to the new password policy settings.
         oDataVault.SetPasswordPolicy( oPasswordPolicy );

         // We are now locked and need to unlock before we can access 
the vault.
         oDataVault.Unlock( "password!1A", "saltD#ddg#k05%gnd[!1A" );
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         // Call getPasswordPolicy() to return the current password 
policy settings.
         DataVault.PasswordPolicy oCurrentPolicy = 
oDataVault.GetPasswordPolicy();

         // Call setString() by giving it a name:value pair to encrypt 
and persist 
         // a string data type within your dataVault.
         oDataVault.SetString( "stringName", "stringValue" );

         // Call getString to retrieve the string we just stored in our 
data vault!
         String storedStringValue = 
oDataVault.GetString( "stringName" );

         // Call setValue() by giving it a name:value pair to encrypt 
and persist 
         // a binary data type within your dataVault.
         byte[] binaryValue = { 1, 2, 3, 4, 5, 6, 7 };
         oDataVault.SetValue( "binaryName", binaryValue );

         // Call getValue to retrieve the binary we just stored in our 
data vault!
         byte[] storedBinaryValue = 
oDataVault.GetValue( "binaryName" );

         // Call getDataNames to retrieve all stored element names 
from our data vault.
         DataVault.DVDataName[] dataNameArray = 
oDataVault.GetDataNames();
         for ( int i = 0; i < dataNameArray.GetLength( 0 ); i++ )
         {
            if ( dataNameArray[ i ].type == 
DataVault.DVDataType.String )
            {
               String thisStringValue = 
oDataVault.GetString( dataNameArray[ i ].name );
            }
            else if ( dataNameArray[ i ].type == 
DataVault.DVDataType.Binary )
            {
               byte[] thisBinaryValue = 
oDataVault.GetValue( dataNameArray[ i ].name );
            }
         }

         // Call changePassword with 2 parameters. Vault must be 
unlocked.
         // If you pass null parameters as your new password or your 
new salt,
         // it will generate a default password or default salt, 
respectively.
         oDataVault.ChangePassword( null, null );

         // Call isDefaultPasswordused() to see if we are using an 
automatically
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         // generated password (which we are).
         bool isDefaultPasswordUsed = 
oDataVault.IsDefaultPasswordUsed();

         // Lock the vault.
         oDataVault.Lock();

         // Call changePassword with 4 parameters even if the vault is 
locked.
         // Here, we pass null for oldSalt and oldPassword because 
defaults were used.
         oDataVault.ChangePassword( null, null, "password!1A", 
"saltD#ddg#k05%gnd[!1A" );

         // Call isDefaultPasswordused() and we will see that the 
default password is NOT used anymore.
         isDefaultPasswordUsed = oDataVault.IsDefaultPasswordUsed();
      }
      catch ( DataVaultException dvex )
      {
         // Handle datavault exception.
      }
      catch ( Exception ex )
      {
         // Handle exception.
      }
      finally
      {
         // Because this is a test example, we will delete our vault at 
the end.
         // This means we will forever lose all data we persisted in 
our data vault.
         if ( DataVault.VaultExists( "DataVaultExample" ) )
            DataVault.DeleteVault( "DataVaultExample" );
      }
   }

Callback and Listener APIs
The callback and listener APIs allow you to optionally register a callback handler and listen
for device events, application connection events, and package synchronize and replay events.

ICallbackHandler API
The ICallbackHandler interface is invoked when any database event occurs. A default
callback handler is provided, which basically does nothing. You should implement a custom
CallbackHandler to register important events. The callback is invoked on the thread that
is processing the event. To receive callbacks for database changes, you must register a
CallBackHandler with the generated database class, the entity class, or both. You can
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create a handler by extending the DefaultCallbackHandler class or by implementing
the com.sybase.persistence.CallbackHandler interface.

To allow the CallbackHandler to be called, you must use asynchronous synchronization, for
example by calling BeginSynchronize() instead of Synchronize().

In your handler, override the particular callback that you are interested in (for example, void
OnReplayFailure(Object entity) ). The callback is executed in the thread that is
performing the action (for example, replay). When you receive the callback, the particular
activity is already complete.

Table 3. Callbacks in the ICallbackHandler Interface

Callback Description

void OnImport(Object entity) This method is invoked when an import message
is successfully applied to the local database.
However, it is not committed. One message from
server may have multiple import entities and they
would be committed in one transaction for the
whole message.

Note:

1. Stale data may be read from the database at
this time before commit of the whole mes-
sage. Developers are encouraged to wait until
the next OnTransactionCommit()
is invoked, then to read from the database to
obtain the updated data.

2. Both CallbackHandlers registered for the
MBO class of the entity and Package DB will
be invoked.

Parameters:

• entity – the Mobile Business Object that was
just imported.

void OnLoginFailure() This method will be invoked when login failed for
a beginOnlineLogin call.

Note: Only the CallbackHandler regis-

tered for package DB will be invoked.
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Callback Description

void OnLoginSuccess() This method is invoked when login succeeds for a
beginOnlineLogin call.

Note: Only the CallbackHandler registered for
package DB is invoked.

void OnReplayFailure(Object
entity)

This method is invoked when a replay request
fails.

Note: CallbackHandlers registered for both the
MBO class of the entity and the Package DB are
invoked.

Parameters:

• entity – the Mobile Business Object to replay.

void OnReplaySuccess(Object
entity)

This method is invoked when a replay request
succeeds.

Note: CallbackHandlers registered for both the
MBO class of the entity and the Package DB are
invoked.

Parameters:

• entity – the Mobile Business Object to replay.

void OnSearchFailure(Object
entity)

This method is invoked when a back-end search
fails.

Note: CallbackHandlers registered for both the
MBO class of the entity and the Package DB are
invoked.

Parameters:

• entity – the back-end search object.
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Callback Description

void OnSearchSuccess(Object
entity)

This method is invoked when a back end search
succeeds.

Note: CallbackHandlers registered for both the
MBO class of the entity and the Package DB are
invoked.

Parameters:

• entity – the back-end search object.

void OnSubscribeFailure() This method is invoked when subscribe fails.

Note: CallbackHandlers registered for both the
MBO class of the entity and the Package DB are
invoked.

void OnSubscribeSuccess() This method is invoked when subscribe succeeds.

Note: Only the CallbackHandler registered for
the Package DB is invoked.

Client Object API Usage

Developer Guide: Windows and Windows Mobile Object API Applications 131



Callback Description

SynchronizationAction On-
Synchronize( Generic-
List<IsynchronizationGroup>
groups, SynchronizationCon-
text context)

This method is invoked at different stages of the
synchronization. This method is called by the da-
tabase class synchronize or begin-
Synchronize methods when the client ini-

tiates a synchronization, and is called again when
the server responds to the client that synchroni-
zation has finished, or that synchronization failed.
The status of the synchronization context, con-
text.Status, specifies the stage of the syn-

chronization.

Parameters:

• groups – a list of synchronization groups.

• context – the synchronization context.

Returns: Either SynchronizationAc-
tion.CONTINUE or Synchroniza-
tion.CANCEL. If Synchronizatio-
nAction.CANCEL is returned, the syn-

chronize is cancelled if the status of the synchro-
nization context is one of the following.

• SynchronizationSta-
tus.STARTING

• SynchronizationSta-
tus.ASYNC_REPLAY_COMPLETED

• SynchronizationSta-
tus.STARTING_ON_NOTIFICA-
TION

The return value has no effect if the status is not in
the above list.

void OnSuspendSubscription-
Failure()

This method is invoked when suspend subscrip-
tion fails.

Note: Only the CallbackHandler registered for
the Package DB is invoked.
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Callback Description

void OnSuspendSubscription-
Success()

This method is invoked when suspend subscrip-
tion succeeds.

Note: Only the CallbackHandler registered for
the Package DB is invoked.

void OnResumeSubscriptionFai-
lure()

This method is invoked when resume subscrip-
tion fails.

Note: Only the CallbackHandler registered for
the Package DB is invoked.

void OnResumeSubscriptionSuc-
cess()

This method is invoked when resume subscrip-
tion succeeds.

Note: Only the CallbackHandler registered for
the Package DB is invoked.

void OnUnsubscribeFailure() This method is invoked when unsubscribe fails.

Note: Only the CallbackHandler registered for
the Package DB is invoked.

void OnUnsubscribeSuccess() This method is invoked when unsubscribe suc-
ceeds.

Note: Only the CallbackHandler registered for
the Package DB is invoked.

void OnMessageException(Ex-
ception ex)

This method is invoked when an exception occurs
in the processing of a message.

Note: In DefaultCallbackHandlers, onMessa-
geException re-throws the Exception so

that the messaging layer can retry the message.
The application developer has the option to im-
plement a custom CallbackHandler that does not
re-throw the exception, based on exception types
or other conditions, so that the message is not
retried.

Parameters:

• ex – the exception thrown when processing a
message.
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Callback Description

void OnTransactionCommit() This method is invoked after a message is pro-
cessed and committed.

Note: Only the CallbackHandler registered for
the Package DB is invoked.

void OnTransactionRollback() This method is invoked after a message is rolled
back. It only happens when an Exception was
thrown when processing the message, or from a
custom Callback method.

Note: Only the CallbackHandler registered for
the Package DB is invoked.

void OnResetSuccess() This method is invoked when all data is cleared by
the reset.

Note: Only the CallbackHandler registered for
the Package DB is invoked.

void OnRecoverSuccess() This method is invoked when recover succeeds.

Note: Only the CallbackHandler registered for
the Package DB is invoked.

void OnRecoverFailure() This method is invoked when recover fails.

Note: Only the CallbackHandler registered for
the Package DB is invoked.

void OnSubscriptionEnd() This method is invoked when a subscription is re-
registered or unsubscribed. This method deletes
all MBO data on the device.

Note: Only the CallbackHandler registered for
the Package DB is invoked.

void OnImportSuccess() This method is invoked when all data has been
successfully imported.

Note: Only the CallbackHandler registered for
the Package DB is invoked.
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Callback Description

void BeforeImport(Object en-
tity)

This method is invoked before importing the
specified entity.

Note: Only the CallbackHandler registered for
the Package DB is invoked.

Parameters:

• entity – the Mobile Business Object to be
imported.

This code shows how to create and register a handler to receive callbacks:
public class MyCallbackHandler : DefaultCallbackHandler
{
    // implementation
}

CallbackHandler handler = new MyCallbackHandler();
MyPackageDB.RegisterCallbackHandler(handler);

IApplicationCallback API
This callback interface is invoked by events of interest to a mobile application.

You must register an IApplicationCallback implementation to your
Sybase.Mobile.Application instance to receive these callbacks.

Table 4. Callbacks in the IApplicationCallback Interface

Callback Description

void OnApplicationSetting-
sChanged(Sybase.Collec-
tions.StringList names)

Invoked when one or more application settings
have been changed by the server administration.

void OnConnectionStatu-
sChanged(int connectionSta-
tus, int errorCode, string
errorMessage)

Invoked when the connection status changes. The
possible connection status values are defined in
the ConnectionStatus class.

void OnDeviceCondition-
Changed(int deviceCondition)

Invoked when a condition is detected on the mo-
bile device that may be of interest to the applica-
tion or the application user. The possible device
condition values are defined in the Device-
Condition class.
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Callback Description

void OnRegistrationStatu-
sChanged(int registrationSta-
tus, int errorCode, string
errorMessage)

Invoked when the registration status changes. The
possible registration status values are defined in
the RegistrationStatus class.

void OnHttpCommunicationEr-
ror(int errorCode, string er-
rorMessage, Sybase.Collec-
tions.StringProperties re-
sponseHeaders);

Invoked when an HTTP communication server
rejects HTTP communication with an error code.

• errorCode – Error code returned by the
HTTP server. For example: code 401 for au-
thentication failure, code 403 for authoriza-
tion failure.

• errorMessage – Error message returned by
the HTTP server.

• responseHeaders – Response headers re-
turned by the HTTP server.

SyncStatusListener API
You can implement a synchronization status listener to track synchronization progress.

Note: This topic is not applicable for DOE-based applications.

Create a listener that implements the SyncStatusListener interface.

public interface SyncStatusListener 
{
    bool ObjectSyncStatus(ObjectSyncStatusData statusData);
}

public class MySyncListener : SyncStatusListener
{
// implementation
}

Pass an instance of the listener to the synchronize methods.
MySyncListener listener = new MySyncListener();
SUP101DB.synchronize("sync_group", listener);
// or SUP101DB.synchronize(listener); if we want to synchronize all
// synchronization groups

As the application synchronization progresses, the ObjectSyncStatus method defined
by the SyncStatusListener interface is called and is passed an
ObjectSyncStatusData object. The ObjectSyncStatusData object contains
information about the MBO being synchronized, the connection to which it is related, and the
current state of the synchronization process. By testing the State property of the
ObjectSyncStatusData object and comparing it to the possible values in the
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SyncStatusState enumeration, the application can react accordingly to the state of the
synchronization.

The method returns false to allow synchronization to continue. If the method returns true,
the synchronization is aborted.

Possible uses of ObjectSyncStatus method include changing form elements on the
client screen to show synchronization progress, such as a green image when the
synchronization is in progress, a red image if the synchronization fails, and a gray image when
the synchronization has completed successfully and disconnected from the server.

Note: The ObjectSyncStatus method of SyncStatusListener is called and
executed in the data synchronization thread. If a client runs synchronizations in a thread other
than the primary user interface thread, the client cannot update its screen as the status changes.
The client must instruct the primary user interface thread to update the screen regarding the
current synchronization status.

This is an example of SyncStatusListener implementation:

public class SyncListener : syncStatusListener
{
  public bool ObjectSyncStatus(ObjectSyncStatusData data)
  {
    switch (data.SyncStatusState) {
    case SyncStatusState.ApplicationSyncDone:
      //implement your own UI indicator bar
      break;
    case SyncStatusState.ApplicationSyncError:
      //implement your own UI indicator bar
      break;
    case SyncStatusState.SyncDone:
      //implement your own UI indicator bar
      break;
    case SyncStatusState.SyncStarting:
      //implement your own UI indicator bar
      break;
    ...
    }
    return false;
  }
}

Query APIs
The Query API allows you to retrieve data from mobile business objects, to page data, and to
retrieve a query result by filtering. You can also use the Query API to filter children MBOs of a
parent MBO in a one to many relationship.
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Retrieving Data from Mobile Business Objects
You can retrieve data from mobile business objects through a variety of queries, including
object queries, arbitrary find, and through filtering query result sets.

Object Queries
To retrieve data from a local database, use one of the static Object Query methods in the MBO
class.

Object Query methods are generated based on the object queries defined by the modeler in
Unwired WorkSpace. Object Query methods carry query names, parameters, and return types
defined in Unwired WorkSpace. Object Query methods return either an object, or a collection
of objects that match the specified search criteria.

The following examples demonstrate how to use the Object Query methods of the Customer
MBO to retrieve data.

This method retrieves all customers:
public static Sybase.Collections.GenericList<Customer> FindAll()

Sybase.Collections.GenericList<Customer> customers = 
Customer.FindAll();

This method retrieves all customers in a certain page:
public static Sybase.Collections.GenericList<Customer> FindAll(int 
skip, int take)

Sybase.Collections.GenericList<Customer> customers = 
Customer.FindAll(10, 5);

Suppose the modeler defined the following Object Query for the Customer MBO in Sybase
Unwired Workspace:

• name – findByFirstName
• parameter – String firstName
• query definition – SELECT x.* FROM Customer x WHERE x.fname = :firstName
• return type – Sybase.Collections.GenericList

public static Sybase.Collections.GenericList<Customer> 
FindByFirstName(string firstName)

com.sybase.collections.ObjectList customers = 
Customer.FindByFirstName("fname");
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Query and Related Classes
The following classes define arbitrary search methods and filter conditions, and provide
methods for combining test criteria and dynamically querying result sets.

Table 5. Query and Related Classes

Class Description

Query Defines arbitrary search methods and can be com-
posed of search conditions, object/row state filter
conditions, and data ordering information.

AttributeTest Defines filter conditions for MBO attributes.

CompositeTest Contains a method to combine test criteria using the
logical operators AND, OR, and NOT to create a
compound filter.

QueryResultSet Provides for querying a result set for the dynamic
query API.

SelectItem Defines the entry of a select query. For example,
"select x.attr1 from MBO x", where "X.attr1" rep-
resents one SelectItem.

Column Used in a subquery to reference the outer query's
attribute.

In addition queries support select, where, and join statements.

Arbitrary Find
The arbitrary find method lets custom device applications dynamically build queries based on
user input. The Query.DISTINCT property lets you exclude duplicate entries from the
result set.

The arbitrary find method also lets the user specify a desired ordering of the results and object
state criteria. A Query class is included in the client object API. The Query class is the single
object passed to the arbitrary search methods and consists of search conditions, object/row
state filter conditions, and data ordering information.

Define these conditions by setting properties in a query:

• TestCriteria – criteria used to filter returned data.
• SortCriteria – criteria used to order returned data.
• Skip – an integer specifying how many rows to skip. Used for paging.
• Take – an integer specifying the maximum number of rows to return. Used for paging.
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Set the Query.Distinct property to true to exclude duplicate entries from the result set.
The default value is false for entity types, and its usage is optional for all other types.

Query query1 = new Query();
query1.Distinct = true;

TestCriteria can be an AttributeTest or a CompositeTest.

TestCriteria
You can construct a query SQL statement to query data from a local database. You can create a
TestCriteria object (in this example, AttributeTest) to filter results. You can also
query across multiple tables (MBOs) when using the executeQuery API.

Query query2 = new Query();
query2.Select("c.fname,c.lname,s.order_date,s.region");
query2.From("Customer", "c");
//
// Convenience method for adding a join to the query
// Detailed construction of the join criteria
query2.Join("Sales_order", "s", "c.id", "s.cust_id");
AttributeTest ts = new AttributeTest();
ts.Attribute = ("fname");
ts.TestValue = "Beth";
query2.Where(ts);
QueryResultSet resultSet = SUP101DB.ExecuteQuery(query2);

Note: You must use explicit column names in select clauses; you cannot use wildcards.

AttributeTest
An AttributeTest defines a filter condition using an MBO attribute, and supports
multiple conditions.

• IS_NULL
• NOT_NULL
• EQUAL
• NOT_EQUAL
• LIKE
• NOT_LIKE
• LESS_THAN
• LESS_EQUAL
• GREATER_THAN
• GREATER_EQUAL
• CONTAINS
• STARTS_WITH
• ENDS_WITH
• DOES_NOT_START_WITH
• DOES_NOT_END_WITH
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• DOES_NOT_CONTAIN
• IN
• NOT_IN
• EXISTS
• NOT_EXISTS

For example, the C# .NET code shown below is equivalent to this SQL query:
SELECT * from A where id in [1,2,3]
Query query = new Query();
  AttributeTest test = new AttributeTest();
  test.Attribute = "id";
  Sybase.Collections.ObjectList v = new 
Sybase.Collections.ObjectList();
    v.Add("1");
    v.Add("2");
    v.Add("3");

  test.Value = v;
  test.Operator = AttributeTest.IN;
  query.Where(test);

When using EXISTS and NOT_EXISTS, the attribute name is not required in the
AttributeTest. The query can reference an attribute value via its alias in the outer scope.
The C# .NET code shown below is equivalent to this SQL query:
SELECT a.id from AllType a where exists (select b.id from AllType b 
where b.id = a.id)
Sybase.Persistence.Query query = new Sybase.Persistence.Query();
query.Select("a.id");
query.From("AllType", "a");
Sybase.Persistence.AttributeTest test = new 
Sybase.Persistence.AttributeTest();
Sybase.Persistence.Query existQuery = new 
Sybase.Persistence.Query();
existQuery.Select("b.id");
existQuery.From("AllType", "b");
Sybase.Persistence.Column cl = new Sybase.Persistence.Column();
cl.Alias = "a";
cl.Attribute = "id";
Sybase.Persistence.AttributeTest test1 = new 
Sybase.Persistence.AttributeTest();
test1.Attribute = "b.id";
test1.Value = cl;
test1.Operator = Sybase.Persistence.AttributeTest.EQUAL;
existQuery.Where(test1);
test.Value = existQuery;
test.SetOperator(Sybase.Persistence.AttributeTest.EXISTS);
query.Where(test);
Sybase.Persistence.QueryResultSet qs = SUP101DB.ExecuteQuery(query);
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SortCriteria
SortCriteria defines a SortOrder, which contains an attribute name and an order type
(ASCENDING or DESCENDING).

For example,
Query query = new Query();

query.Select("c.lname, c.fname");
query.From("Customer", "c");

AttributeTest aTest = new AttributeTest();
aTest.Attribute = "state";
aTest.TestValue = "CA" ;
aTest.TestType = AttributeTest.EQUAL;
query.TestCriteria = aTest;

SortCriteria sort = new SortCriteria();
sort.Add("lname", SortOrderType.ASCENDING);
sort.Add("fname", SortOrderType.ASCENDING);
query.SortCriteria = sort;

Paging Data
On low-memory devices, retrieving up to 30,000 records from the database may cause the
custom client to fail and throw an OutOfMemoryException.
Consider using the Query object to limit the result set:
Query props = new Query();
props.Skip =10;
props.Take = 5;

GenericList<Customer> customers = Customer.FindWithQuery(props);

Aggregate Functions
You can use aggregate functions in dynamic queries.

When using the Query.Select(String) method, you can use any of these aggregate
functions:

Aggregate Function Supported Datatypes

COUNT integer

MAX string, binary, char, byte, short, int, long, integer,
decimal, float, double, date, time, dateTime

MIN string, binary, char, byte, short, int, long, integer,
decimal, float, double, date, time, dateTime

SUM byte, short, int, long, integer, decimal, float, dou-
ble
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Aggregate Function Supported Datatypes

AVG byte, short, int, long, integer, decimal, float, dou-
ble

If you use an unsupported type, a PersistenceException is thrown.

Query query1 = new Query();
query1.Select("MAX(c.id), MIN(c.name) as minName");

Grouping Results
Apply grouping criteria to your results.

To group your results according to specific attributes, use the Query.GroupBy(String
groupByItem) method. For example, to group your results by ID and name, use:

String groupByItem = ("c.id, c.name");
Query query1 = new Query();

//other code for query1

query1.GroupBy(groupByItem);

Filtering Results
Specify test criteria for group queries.

You can specify how your results are filtered by using the
Query.having(com.sybase.persistence.TestCriteria) method for
queries using GroupBy. For example, limit your AllType MBO's results to c.id attribute
values that are greater than or equal to 0 using:
Query query2 = new Query();
query2.Select("c.id, SUM(c.id)");
query2.From("AllType", "c");
ts = new AttributeTest();
ts.Attribute = "c.id";
ts.TestValue = "0";
ts.Operator = AttributeTest.GREATER_EQUAL;
query2.Where(ts);
query2.GroupBy("c.id");

ts2 = new AttributeTest();
ts2.Attribute = "c.id";
ts2.TestValue = "0"; 
ts2.Operator = AttributeTest.GREATER_EQUAL; 
query2.Having(ts2);

Concatenating Queries
Concatenate two queries having the same selected items.

The Query class methods for concatenating queries are:
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• Union(Query)
• UnionAll(Query)
• Except(Query)
• Intersect(Query)
This example obtains the results from one query except for those results appearing in a second
query:
Query query1 = new Query(); 
... ... //other code for query1

Query query2 = new Query();
... ... //other code for query 2

Query query3 = query1.Except(query2);
SUP101DB.ExecuteQuery(query3);

Subqueries
Execute subqueries using clauses, selected items, and attribute test values.

You can execute subqueries using the Query.from(Query query, String alias)
method. For example, the C# .NET code shown below is equivalent to this SQL query:
SELECT a.id FROM (SELECT b.id FROM AllType b) AS a WHERE a.id = 1

Use this C# .NET code:
Query query1 = new Query();
query1.Select("b.id");
query1.From("AllType", "b");
Query query2 = new Query();
query2.Select("a.id");
query2.From(query1, "a");
AttributeTest ts = new AttributeTest();
ts.Attribute = "a.id";
ts.Value = 1;
query2.Where(ts);
Sybase.Persistence.QueryResultSet qs = 
SUP101DB.ExecuteQuery(query2);

You can use a subquery as the selected item of a query. Use the SelectItem to set selected
items directly. For example, the C# .NET code shown below is equivalent to this SQL query:
SELECT (SELECT count(1) FROM AllType c WHERE c.id >= d.id) AS cn, id
FROM AllType d

Use this C# .NET code:

Query selQuery = new Query();
selQuery.Select("count(1)");
selQuery.From("AllType", "c");
AttributeTest ttt = new AttributeTest();
ttt.Attribute = "c.id";
ttt.Operator = AttributeTest.GREATER_EQUAL;
Column cl = new Column();
cl.Alias = "d";
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cl.Attribute = "id";
ttt.Value = cl;
selQuery.Where(ttt);

Sybase.Collections.GenericList<Sybase.Persistence.SelectItem> 
selectItems = new 
Sybase.Collections.GenericList<Sybase.Persistence.SelectItem>();
SelectItem item = new SelectItem();
item.Query = selQuery;
item.AsAlias = "cn";
selectItems.Add(item);
item = new SelectItem();
item.Attribute = "id";
item.Alias = "d";
selectItems.Add(item);
Query subQuery2 = new Query();
subQuery2.SelectItems = selectItems;
subQuery2.From("AllType", "d");
Sybase.Persistence.QueryResultSet qs = 
SUP101DB.ExecuteQuery(subQuery2);

CompositeTest
A CompositeTest combines multiple TestCriteria using the logical operators AND,
OR, and NOT to create a compound filter.

Complex Example
This example shows the usage of CompositeTest, SortCriteria, and Query to
locate all customer objects based on particular criteria.

• FirstName = John AND LastName = Doe AND (State = CA OR State = NY)
• Customer is New OR Updated
• Ordered by LastName ASC, FirstName ASC, Credit DESC
• Skip the first 10 and take 5

Query props = new Query();
  //define the attribute based conditions
  //Users can pass in a string if they know the attribute name. R1 
column name = attribute name.
  CompositeTest innerCompTest = new CompositeTest();
  innerCompTest.Operator = CompositeTest.OR;
  innerCompTest.Add(new AttributeTest("state", "CA", 
AttributeTest.EQUAL));
  innerCompTest.Add(new AttributeTest("state", "NY", 
AttributeTest.EQUAL));
  CompositeTest outerCompTest = new CompositeTest();
  outerCompTest.Operator = CompositeTest.OR;
  outerCompTest.Add(new AttributeTest("fname", "Jane", 
AttributeTest.EQUAL));
  outerCompTest.Add(new AttributeTest("lname", "Doe", 
AttributeTest.EQUAL));
  outerCompTest.Add(innerCompTest);
  //define the ordering
  SortCriteria sort = new SortCriteria();
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  sort.Add("fname", SortOrder.ASCENDING);
  sort.Add("lname", SortOrder.ASCENDING);
  //set the Query object
  props.TestCriteria = outerCompTest;
  props.SortCriteria = sort;
  props.Skip = 10;
  props.Take = 5;
  Sybase.Collections.GenericList<Customer> customers2 = 
Customer.FindWithQuery(props);

Note: "Order By" is not supported for a long varchar field.

QueryResultSet
The QueryResultSet class provides for querying a result set from the dynamic query API.
QueryResultSet is returned as a result of executing a query.

The following example shows how to filter a result set and get values by taking data from two
mobile business objects, creating a Query, filling in the criteria for the query, and filtering the
query results:
Sybase.Persistence.Query query = new Sybase.Persistence.Query();
  query.Select("c.fname,c.lname,s.order_date,s.region");
  query.From("Customer ", "c");
  query.Join("SalesOrder ", "s", " s.cust_id ", "c.id");
  AttributeTest at = new AttributeTest();
  at.Attribute = "lname";
  at.TestValue = "Devlin";
  query.TestCriteria = at;
  QueryResultSet qrs = SUP101DB.ExecuteQuery(query);
  while(qrs.Next())
  {
    Console.Write(qrs.GetString(1));
    Console.Write(",");
    Console.WriteLine(qrs.GetStringByName("c.fname"));

    Console.Write(qrs.GetString(2));
    Console.Write(",");
    Console.WriteLine(qrs.GetStringByName("c.lname"));

    Console.Write(qrs.GetString(3));
    Console.Write(",");
    Console.WriteLine(qrs.GetStringByName("s.order_date"));

    Console.Write(qrs.GetString(4));
    Console.Write(",");
    Console.WriteLine(qrs.GetStringByName("s.region"));
  }
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Retrieving Relationship Data
A relationship between two MBOs allows the parent MBO to access the associated MBO. A
bidirectional relationship also allows the child MBO to access the associated parent MBO.

Assume there are two MBOs defined in Unwired Server. One MBO is called Customer and
contains a list of customer data records. The second MBO is called SalesOrder and contains
order information. Additionally, assume there is an association between Customers and
Orders on the customer ID column. The Orders application is parameterized to return order
information for the customer ID.
Customer customer = Customer.FindByPrimaryKey(101);
            Sybase.Collections.GenericList<SalesOrder> orders = 
customer.Orders;

Query props = new Query();
… // set query parameters
Sybase.Collections.GenericList<SalesOrder> orders = 
customer.GetOrdersFilterBy(props);

Persistence APIs
The persistence APIs include operations and object state APIs.

Operations APIs
Mobile business object operations are performed on an MBO instance. Operations in the
model that are marked as create, update, or delete (CUD) operations create non-static
instances of operations in the generated client-side objects.

Any parameters in the create, update, or delete operation that are mapped to the object’s
attributes are handled internally by the client object API, and are not exposed. Any parameters
not mapped to the object’s attributes are left as parameters in the generated object API. The
code examples for create, update, and delete operations are based on the fill from attribute
being set. Different MBO settings affect the operation methods.

Note: If the Sybase Unwired Platform object model defines one instance of a create operation
and one instance of an update operation, and all operation parameters are mapped to the
object’s attributes, then a Save method can be automatically generated which, when called
internally, determines whether to insert or update data to the local client-side database. In
other situations, where there are multiple instances of create or update operations, methods
such as Save cannot be automatically generated.

Create Operation
The Create operation allows the client to create a new record in the local database. To
execute a create operation on an MBO, create a new MBO instance, and set the MBO
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attributes, then call the Save() or Create() operation. To propagate the changes to the
server, call SubmitPending.

Customer cust = new Customer();
cust.Fname  =  "supAdmin" ;
cust.Company_name =   "Sybase";
cust.Phone = "777-8888";
cust.Create();// or cust.Save();
cust.SubmitPending();

Update Operation
The Update operation updates a record in the local database on the device. To execute update
operations on an MBO, get an instance of the MBO, set the MBO attributes, then call either the
Save() or Update() operation. To propagate the changes to the server, call
SubmitPending.

Customer cust = Customer.FindByPrimaryKey(101);
cust.Fname = "supAdmin";
cust.Company_name = "Sybase";
cust.Phone = "777-8888";
cust.Update();// or cust.Save();
cust.SubmitPending();

To update multiple MBOs in a relationship, if the relationship is a composite, call
submitPending() on the parent MBO. If the relationship is not a composite, call
submitPending() on each MBO within the relationship:

Customer cust = Customer.FindByPrimaryKey(101);
Sybase.Collections.GenericList<SalesOrder> orders = cust.Orders;
SalesOrder order = orders[0];
order.Order_date = DateTime.Now;
order.Save();
cust.SubmitPending();

Delete Operation
The Delete operation allows the client to delete a new record in the local database. To
execute delete operations on an MBO, get an instance of the MBO, set the MBO attributes,
then call the Delete operation. To propagate the changes to the server, call
SubmitPending.

Customer cust = Customer.FindByPrimaryKey(101);
cust.Delete();

For MBOs in a relationship, perform a delete as follows:
Customer cust = Customer.FindById(101);
Sybase.Collections.GenericList<SalesOrder> orders = cust.Orders;
SalesOrder order = orders[0];
order.Delete();
cust.SubmitPending();
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Save Operation
The Save operation saves a record to the local database. In the case of an existing record, a
Save operation calls the Update operation. If a record does not exist, the Save operation
creates a new record.

//Update an existing customer
Customer cust = Customer.FindById(101);
cust.Save();

//Insert a new customer
Customer cust = new Customer();
cust.Save();

Other Operation
Operations other than Create, Update, or Delete operations are called "other"
operations. An Other operation class is generated for each operation in the MBO that is not a
Create, Update, or Delete operation.

Suppose the Customer MBO has an Other operation "other", with parameters "p1" (string),
"p2" (int), and "p3" (date). This results in a CustomerOtherOperation class being
generated, with "p1", "p2" and "p3" as its attributes.

To invoke the Other operation, create an instance of CustomerOtherOperation, and set
the correct operation parameters for its attributes. This code provides an example:
CustomerOtherOperation other = new CustomerOtherOperation();
other.P1 = "somevalue";
other.P2 = 2;
other.P3 = System.DateTime.Now;
other.Save();
other.SubmitPending();

Cascade Operations
Composite relationships are cascaded. Cascade operations allow a single synchronization to
execute a chain of related CUD operations. Multi-level insert is a special case for cascade
operations. Multilevel insert allows a single synchronization to execute a chain of related
insert operations, creating parent and children objects.

Multilevel Insert
Consider creating a Customer and a new SalesOrder at the same time on the client side, where
the SalesOrder has a reference to the new Customer identifier. The following example
demonstrates a multilevel insert:
Customer customer = new Customer();
customer.Fname = “firstName”;
customer.Lname = “lastName”;
customer.Phone = “777-8888”;
customer.Save();
SalesOrder order = new SalesOrder();

Client Object API Usage

Developer Guide: Windows and Windows Mobile Object API Applications 149



order.Customer = customer;
order.Order_date = DateTime.Now;
order.Region = "Eastern";
order.Sales_rep = 102;
customer.Orders.Add(order);
//Only the parent MBO needs to call Save()
customer.Save();
//Must submit parent
customer.SubmitPending();

To insert an order for an existing customer, first find the customer, then create a sales order
with the customer ID retrieved:
Customer customer = Customer.FindByPrimaryKey(102);
SalesOrder order = new SalesOrder();
order.Customer = customer;
order.Order_date = DateTime.UtcNow;
order.Region = "Eastern";
order.Sales_rep = 102;
customer.Orders.Add(order);
order.Save();
customer.SubmitPending();

See the Sybase Unwired Platform online documentation for information on defining
relationships that support cascading (composite) operations, and for specific multilevel insert
requirements.

Pending Operation
You can manage the pending state.

You can group multiple operations into a single transaction for improved performance:
// load the customer MBO with customer ID 100
Customer customer = Customer.FindByPrimaryKey(100);
        
// Change phone number of that customer
customer.Phone = "8005551212";
        
// use one transaction to do save and submitPending
Sybase.Persistence.LocalTransaction tx = 
SUP101DB.BeginTransaction();
try
{
  customer.Save();
  customer.SubmitPending();
  tx.Commit();
}
catch (Exception e)
{
  tx.Rollback();
}

• CancelPending – cancels the previous create, update, or delete operations on the MBO. It
cannot cancel submitted operations.
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• SubmitPending – submits the operation so that it can be replayed on the Unwired Server.
A request is sent to the Unwired Server during a synchronization.

• SubmitPendingOperations – submits all the pending records for the entity to the
Unwired Server. This method internally invokes the SubmitPending method on each
of the pending records.

• CancelPendingOperations – cancels all the pending records for the entity. This method
internally invokes the CancelPending method on each of the pending records.

Note: Use the SubmitPendingOperations and CancelPendingOperations
methods only when there are multiple pending entities on the same MBO type. Otherwise, use
the MBO instance’s SubmitPending or CancelPending methods, which are more
efficient if the MBO instance is already available in memory.

Customer customer = Customer.FindByPrimaryKey(101);
if(errorHappened) 
{
  Customer.CancelPending();
}
else 
{
  customer.SubmitPending();
}

Complex Attribute Types
Some back-end datasources require complex types to be passed in as input parameters. The
input parameters can be any of the allowed attribute types, including primitive lists, objects,
and object lists. The MBO examples have attributes that are primitive types (such as int,
long, or string), and make use of the basic database operations (create, update, and
delete).

Passing Structures to Operations
An Unwired WorkSpace project includes an example MBO that is bound to a Web service data
source that includes a Create operation that takes a structure as an operation parameter.
MBOs differ depending on the data source, configuration, and so on, but the principles are
similar.

The SimpleCaseList MBO contains a create operation that has a number of parameters,
including one named _HEADER_ that is a structure datatype named
AuthenticationInfo, defined as:

AuthenticationInfo
   userName: String
   password: String
   authentication: String
   locale: String
   timeZone: String

Structures are implemented as classes, so the parameter _HEADER_ is an instance of the
AuthenticationInfo class. The generated code for the Create operation is:
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public void Create(Authentication _HEADER_,string escalated,string 
hotlist,
string orig_Submitter,string pending,string workLog);

This example demonstrates how to initialize the AuthenticationInfo class instance
and pass it, along with the other operation parameters, to the Create operation:

AuthenticationInfo authen = new AuthenticationInfo();
authen.UserName = "Demo";

           
SimpleCaseList newCase = new SimpleCaseList();
newCase.Case_Type = "Incident";
newCase.Category = "Networking";
newCase.Department = "Marketing";
newCase.Description = "A new help desk case.";
newCase.Item = "Configuration";
newCase.Office = "#3 Sybase Drive";
newCase.Submitted_By = "Demo";
newCase.Phone_Number = "#0861023242526";
newCase.Priority = "High";
newCase.Region = "USA";
newCase.Request_Urgency = "High";
newCase.Requester_Login_Name = "Demo";
newCase.Requester_Name = "Demo";
newCase.Site = "25 Bay St, Mountain View, CA";
newCase.Source = "Requester";
newCase.Status = "Assigned";
newCase.Summary = "Mark was here to fix it.";
newCase.Type = "Access to Files/Drives";
newCase.Create_Time = System.DateTime.Now;

newCase.Create (authen, "Other", "Other", "false", "work log");
newCase.SubmitPending();  

Object State APIs
The object state APIs provide methods for returning information about the state of an entity in
an application.

Entity State Management
The object state APIs provide methods for returning information about entities in the
database.

All entities that support pending state have the following attributes:

Name Type Description

IsNew bool Returns true if this entity is new, but has not yet been
created in the client database.
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Name Type Description

IsCreated bool Returns true if this entity has been newly created in the
client database, and one of the following is true:

• The entity has not yet been submitted to the server
with a replay request.

• The entity has been submitted to the server, but the
server has not finished processing the request.

• The server rejected the replay request (replay-
Failure message received).

IsDirty bool Returns true if this entity has been changed in memory,
but the change has not yet been saved to the client
database.

IsDeleted bool Returns true if this entity was loaded from the database
and subsequently deleted.

IsUpdated bool Returns true if this entity has been updated or changed
in the database, and one of the following is true:

• The entity has not yet been submitted to the server
with a replay request.

• The entity has been submitted to the server, but the
server has not finished processing the request.

• The server rejected the replay request (replay-
Failure message received).

Pending bool Returns true for any row that represents a pending
create, update, or delete operation, or a row

that has cascading children with a pending operation.

PendingChange char If pending is true, this attribute's value is 'C' (create),
'U' (update), 'D' (delete), or 'P' (to indicate that this
MBO is a parent in a cascading relationship for one or
more pending child objects, but this MBO itself has no
pending create, update or delete operations). If pend-
ing is false, this attribute's value is 'N'.

ReplayCounter long Returns a long value that is updated each time a row

is created or modified by the client. This value is a
unique value obtained from KeyGenera-
tor.GenerateID method. Note that the value

increases every time it is retrieved.
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Name Type Description

ReplayPending long Returns a long value. When a pending row is sub-

mitted to the server, the value of ReplayCounter
is copied to ReplayPending. This allows the cli-

ent code to detect if a row has been changed since it was
submitted to the server (that is, if the value of Re-
playCounter is greater than ReplayPend-
ing).

ReplayFailure long Returns a long value. When the server responds with

a ReplayFailure message for a row that was

submitted to the server, the value of Replay-
Counter is copied to ReplayFailure, and

ReplayPending is set to 0.

Entity State Example
Shows how the values of the entities that support pending state change at different stages
during the MBO update process. The values that change between different states appear in
bold.

Note these entity behaviors:

• The IsDirty flag is set if the entity changes in memory but is not yet written to the
database. Once you save the MBO, this flag clears.

• The ReplayCounter value that gets sent to the Unwired Server is the value in the
database before you call SubmitPending. After a successful replay, that value is
imported from the Unwired Server.

• The last two entries in the table are two possible results from the operation; only one of
these results can occur for a replay request.

Client Object API Usage

154 Sybase Unwired Platform



Description Flags/Values

After reading from the database, before any changes
are made.

IsNew=false

IsCreated=false

IsDirty=false

IsDeleted=false

IsUpdated=false

Pending=false

PendingChange='N'

ReplayCounter=33422977

ReplayPending=0

ReplayFailure=0

One or more attributes are changed, but changes not
saved.

IsNew=false

IsCreated=false

IsDirty=true

IsDeleted=false

IsUpdated=false

Pending=false

PendingChange='N'

ReplayCounter=33422977

ReplayPending=0

ReplayFailure=0
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Description Flags/Values

After entity.Save()[entity save]
or entity.Update()[entity up-
date] is called.

IsNew=false

IsCreated=false

IsDirty=false

IsDeleted=false

IsUpdated=true

Pending=true

PendingChange='U'

ReplayCounter=33424979

ReplayPending=0

ReplayFailure=0

After entity.SubmitPending()[en-
tity submitPending] is called to submit

the MBO to the server.

IsNew=false

IsCreated=false

IsDirty=false

IsDeleted=false

IsUpdated=true

Pending=true

PendingChange='U'

ReplayCounter=33424981

ReplayPending=33424981

ReplayFailure=0
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Description Flags/Values

Possible result: the Unwired Server accepts the up-
date, sends an import and a ReplayResult for

the entity, and then refreshes the entity from the
database.

IsNew=false

IsCreated=false

IsDirty=false

IsDeleted=false

IsUpdated=false

Pending=false

PendingChange='N'

ReplayCounter=33422977

replayPending=0

ReplayFailure=0

Possible result: The Unwired Server rejects the up-
date, sends a ReplayFailure for the entity,

and refreshes the entity from the database

IsNew=false

IsCreated=false

IsDirty=false

IsDeleted=false

IsUpdated=true

Pending=true

PendingChange='U'

ReplayCounter=33424981

ReplayPending=0

ReplayFailure=33424981

Pending State Pattern
When a create, update, delete, or save operation is called on an entity in an
application, the requested change becomes pending. To apply the pending change, call
SubmitPending on the entity, or SubmitPendingOperations on the MBO class:

Customer e = new Customer();
e.Name = "Fred";
e.Address = "123 Four St.";
e.Create(); // create as pending
e.SubmitPending(); // submit to server

Customer.SubmitPendingOperations(); // submit all pending Customer 
rows to server
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SubmitPendingOperations submits all the pending records for the entity to the
Unwired Server. This method internally invokes the SubmitPending method on each of
the pending records.

For message-based sychronization, the call to SubmitPending causes a JSON message to
be sent to the Unwired Server with the Replay method, containing the data for the rows to be
created, updated, or deleted. The Unwired Server processes the message and responds with a
JSON message with the ReplayResult method (the Unwired Server accepts the requested
operation) or the ReplayFailure method (the server rejects the requested operation).

If the Unwired Server accepts the requested change, it also sends one or more Import
messages to the client, containing data for any created, updated, or deleted row that has
changed on the Unwired Server as a result of the Replay request. These changes are written
to the client database and marked as rows that are not pending. When the ReplayResult
message is received, the pending row is removed, and the row remaining in the client database
now contains data that has been imported from and validated by the Unwired Server. The
Unwired Server may optionally send a log record to the client indicating a successful
operation.

If the Unwired Server rejects the requested change, the client receives a ReplayFailed
message, and the entity remains in the pending state, with its ReplayFailed attribute set to
indicate that the change was rejected.

The call to SubmitPending creates a replay record in local database. When the
SUP101DB.Synchronize() method is called, the replay records are uploaded to
Unwired Server. Unwired Server processes the replay records one by one and either accepts or
rejects it.

At the end of the synchronization, the replay results are downloaded to client along with any
created, updated or deleted rows that have changed on the Unwired Server as a result of the
Replay requests. These changes are written to the client database and marked as rows that are
not pending.

When the operation is successful, the pending row is removed, and the row remaining in the
client database now contains data that has been imported from and validated by the Unwired
Server. If the Unwired Server rejects the requested change, the entity remains in the pending
state, with its ReplayFailed attribute set to indicate that the change was rejected. The Unwired
Server may optionally send a log record to the client.

The LogRecord interface has the following getter methods to access information about the
log record:

Method Name Type Description

Component string Name of the MBO for the row for
which this log record was written.
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Method Name Type Description

EntityKey string String representation of the pri-
mary key of the row for which this
log record was written.

Code int One of several possible HTTP er-
ror codes:

• 200 indicates success.

• 401 indicates that the client
request had invalid creden-
tials, or that authentication
failed for some other reason.

• 403 indicates that the client
request had valid credentials,
but that the user does not have
permission to access the re-
quested resource (package,
MBO, or operation).

• 404 indicates that the client
tried to access a nonexistent
package or MBO.

• 405 indicates that there is no
valid license to check out for
the client.

• 500 indicates an unexpected
(unspecified) server failure.

Message string Descriptive message from the
server with the reason for the log
record.

Operation string The operation (create, update, or
delete) that caused the log record
to be written.

RequestId string The ID of the replay message sent
by the client that caused this log
record to be written.

Timestamp System.DateTime Date and time of the log record.

If a rejection is received, the application can use the entity method GetLogRecords to
access the log records and get the reason:
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Sybase.Collections.GenericList<Sybase.Persistence.ILogRecord> logs = 
e.GetLogRecords();
for(int i=0; i<logs.Size(); i++)
{
Console.WriteLine("Entity has a log record:");
Console.WriteLine("Code = {0}",logs[i].Code);
Console.WriteLine("Component = {0}",logs[i].Component);
Console.WriteLine("EntityKey = {0}",logs[i].EntityKey);
Console.WriteLine("Level = {0}",logs[i].Level);
Console.WriteLine("Message = {0}",logs[i].Message);
Console.WriteLine("Operation = {0}",logs[i].Operation);
Console.WriteLine("RequestId = {0}",logs[i].RequestId);
Console.WriteLine("Timestamp = {0}",logs[i].Timestamp);
}

CancelPendingOperations cancels all the pending records for an entity. This method
internally invokes the CancelPending method on each of the pending records.

Refresh Operation
The refresh operation of an MBO allows you to refresh the MBO state from the client
database.

For example:
Customer cust = Customer.FindByPrimaryKey(101);
cust.Fname = "newName";
cust.Refresh();// newName is discarded

Generated Package Database APIs
The generated package database APIs include methods that exist in each generated package
database.

Client Database APIs
The generated package database class provides methods for managing the client database.

public static void CreateDatabase()
public static void DeleteDatabase()
public static bool DatabaseExists()

Typically, CreateDatabase does not need to be called since it is called internally when
necessary. An application may use DeleteDatabase when uninstalling the application.

Use the transaction API to group several transactions together for better performance.
public static Sybase.Persistence.LocalTransaction BeginTransaction()
Customer customer = Customer.FindByPrimaryKey(101);
   // Use one transaction to save and submit pending
   LocalTransaction tx = SUP101DB.BeginTransaction();
   // modify customer information
   customer.Save();
   customer.SubmitPending();
   tx.Commit();
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Large Attribute APIs
Use large string and binary attributes.

You can import large messages containing binary objects (BLOBs) to the client, send new or
changed large objects to the server, and efficiently handle large attributes on the client.

The large attribute APIs allow clients to import large messages from the server or send a replay
message without using excessive memory and possibly throwing exceptions. Clients can also
access or modify a large attribute without reading the entire attribute into memory. In addition,
clients can execute queries without having large attribute valuies automatically filled in the
returned MBO lists or result sets.

BigBinary
An object that allows access to a persistent binary value that may be too large to fit in available
memory. A streaming API is provided to allow the value to be accessed in chunks.

Close
Closes the value stream.

Closes the value stream. Any buffered writes are automatically flushed. Throws a
StreamNotOpenException if the stream is not open.

Syntax
public void Close()

Examples

• – Writes a binary book cover image and closes the image file. In the following example,
book is the instance of an MBO and cover is a BigBinary attribute

Book book = Book.FindByPrimaryKey(bookID);
Sybase.Persistence.BigBinary image = book.Cover;
image.OpenForWrite(256);
// ...
image.Close();

CopyFromFile
Overwrites this BigBinary object with data from the specified file.

Any previous contents of the file will be discarded. Throws an
ObjectNotSavedException if this BigBinary object is an attribute of an entity that
has not yet been created in the database. Throws a StreamNotClosedException if the
object is not closed.

Syntax
public void CopyFromFile(string filepath)
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Parameters

• filepath – The file containing the data to be copied.

CopyToFile
Overwrites the specified file with the contents of this BigBinary object.

Any previous contents of the file are discarded. Throws an ObjectNotSavedException
if this BigBinary object is an attribute of an entity that has not yet been created in the
database. Throws a StreamNotClosedException if the object is not closed.

Syntax
public void CopyToFile(string filepath)

Parameters

• filepath – The file to be overwritten.

Flush
Flushes any buffered writes.

Flushes any buffered writes to the database. Throws a StreamNotOpenException if the
stream is not open.

Syntax
public void Flush()

OpenForRead
Opens the value stream for reading.

Has no effect if the stream was already open for reading. If the stream was already open for
writing, it is flushed before being reopened for reading. Throws an
ObjectNotSavedException if this BigBinary object is an attribute of an entity that
has not yet been created in the database. Throws an ObjectNotFoundException if this
object is null.

Syntax
public void OpenForRead()

Examples

• – Opens a binary book image for reading.
Book book = Book.FindByPrimaryKey(bookID);
Sybase.Persistence.BigBinary image = book.Cover;
image.OpenForRead();
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OpenForWrite
Opens the value stream for writing.

Any previous contents of the value will be discarded. Throws an
ObjectNotSavedException if this BigBinary object is an attribute of an entity that
has not yet been created in the database.

Syntax
public void OpenForWrite(long newLength)

Parameters

• newLength – The new value length in bytes. Some platforms may allow this parameter to
be specified as 0, with the actual length to be determined later, depending on the amount of
data written to the stream. Other platforms require the total amount of data written to the
stream to match the specified value.

Examples

• – Opens a binary book image for writing.
Book book = Book.FindByPrimaryKey(bookID);
Sybase.Persistence.BigBinary image = book.Cover;
image.OpenForWrite(256);

Read
Reads a chunk of data from the stream.

Reads and returns the specified number of bytes, or fewer if the end of stream is reached.
Throws a StreamNotOpenException if the stream is not open for reading.

Syntax
public byte[] Read(long length)

Parameters

• length – The maximum number of bytes to be read into the chunk.

Returns

Read returns a chunk of binary data read from the stream, or a null value if the end of the
stream has been reached.
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Examples

• – Reads in a binary book image.
Book book = Book.FindByPrimaryKey(bookID);
Sybase.Persistence.BigBinary image = book.Cover;
image.OpenForRead();
byte[] binary = image.Read(bufferLength);
while (binary != null)
{
    binary = image.Read(bufferLength);
}
image.Close();

ReadByte
Reads a single byte from the stream.

Throws a StreamNotOpenException if the stream is not open for reading.

Syntax
public int ReadByte()

Returns

ReadByte returns a byte of data read from the stream, or -1 if the end of the stream has been
reached.

Seek
Changes the stream position.

Throws a StreamNotOpenException if the stream is not open for reading.

Syntax
public void Seek(long newPosition)

Parameters

• newPosition – The new stream position in bytes. Zero represents the beginning of the
value stream.

Write
Writes a chunk of data to the stream.

Writes data to the stream, beginning at the current position. The stream may be buffered, so
use Flush or Close to be certain that any buffered changes have been applied. Throws a
StreamNotOpenException if the stream is not open for writing. Throws a
WriteAppendOnlyException if the platform only supports appending to the end of a
value and the current stream position precedes the end of the value. Throws a
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WriteOverLengthException if the platform requires the length to be predetermined
before writing and this write would exceed the predetermined length.

Syntax
public void Write(byte[] data)

Parameters

• data – The data chunk to be written to the stream.

Examples

• – Opens a binary book image for writing.
Book book = Book.FindByPrimaryKey(bookID);
Sybase.Persistence.BigBinary image = book.Cover;
image.OpenForWrite(256);
byte[] binary = new byte[] { 0, 1, 2, 3, 4, 5, 6, 7, 8, 9 };
image.Write(binary);
image.Close();
book.SubmitPending();

WriteByte
Writes a single byte to the stream.

Writes a byte of data to the stream, beginning at the current position. The stream may be
buffered, so use Flush or Close to be certain that any buffered changes have been applied.
Throws a StreamNotOpenException if the stream is not open for writing. Throws a
WriteAppendOnlyException if the platform only supports appending to the end of a
value and the current stream position precedes the end of the value. Throws a
WriteOverLengthException if the platform requires the length to be predetermined
before writing and this write would exceed the predetermined length.

Syntax
public void WriteByte(byte data)

Parameters

• data – The byte value to be written to the stream.

BigString
An object that allows access to a persistent string value that might be too large to fit in available
memory. A streaming API is provided to allow the value to be accessed in chunks.
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Close
Closes the value stream.

Closes the value stream. Any buffered writes are automatically flushed. Throws a
StreamNotOpenException if the stream is not open.

Syntax
public void Close()

Examples

• – Writes to the biography file, and closes the file.
Author author = Author.FindByPrimaryKey(authorID);
BigString text = author.Biography;
text.OpenForWrite(256);
text.Write("something");
text.Close();

CopyFromFile
Overwrites this BigString object with data from the specified file.

Any previous contents of the value will be discarded. Throws an
ObjectNotSavedException if this BigString object is an attribute of an entity that
has not yet been created in the database. Throws a StreamNotClosedException if the
object is not closed.

Syntax
public void CopyFromFile(string filepath)

Parameters

• filepath – The file containing the data to be copied.

CopyToFile
Overwrites the specified file with the contents of this BigString object.

Any previous contents of the file are discarded. Throws an ObjectNotSavedException
if this BigString object is an attribute of an entity that has not yet been created in the
database. Throws a StreamNotClosedException if the object is not closed.

Syntax
public void CopyToFile(string filepath)
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Parameters

• filepath – The file to be overwritten.

Flush
Flushes any buffered writes.

Flushes any buffered writes to the database. Throws a StreamNotOpenException if the
stream is not open.

Syntax
public void Flush()

OpenForRead
Opens the value stream for reading.

Has no effect if the stream was already open for reading. If the stream was already open for
writing, it is flushed before being reopened for reading. Throws an
ObjectNotSavedException if this BigString object is an attribute of an entity that
has not yet been created in the database.

Syntax
public void OpenForRead()

Examples

• – Opens the biography file for reading.
Author author = Author.FindByPrimaryKey(authorID);
BigString text = author.Biography;
text.OpenForRead();

OpenForWrite
Opens the value stream for writing.

Any previous contents of the value will be discarded. Throws an
ObjectNotSavedException if this BigString object is an attribute of an entity that
has not yet been created in the database.

Syntax
public void OpenForWrite(long newLength)

Parameters

• newLength – The new value length in bytes. Some platforms may allow this parameter to
be specified as 0, with the actual length to be determined later, depending on the amount of
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data written to the stream. Other platforms require the total amount of data written to the
stream to match the specified value.

Examples

• – Opens the biography file for writing.
Author author = Author.FindByPrimaryKey(authorID);
BigString text = author.Biography;
text.OpenForWrite(256);

Read
Reads a chunk of data from the stream.

Reads and returns the specified number of characters, or fewer if the end of stream is reached.
Throws a StreamNotOpenException if the stream is not open for reading.

Syntax
public byte[] Read(long length)

Parameters

• length – The maximum number of characters to be read into the chunk.

Returns

Read returns a chunk of string data read from the stream, or a null value if the end of the
stream has been reached.

Examples

• – Reads in the biography file.
Author author = Author.FindByPrimaryKey(authorID);
BigString text = author.Biography;
text.OpenForRead();
int bufferLength = 1024;

string something = text.Read(bufferLength); //null if EOF
while (something != null)
{
    something = text.Read(bufferLength);
}
text.Close();

ReadChar
Reads a single character from the stream.

Throws a StreamNotOpenException if the stream is not open for reading.
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Syntax
public int ReadChar()

Returns

ReadChar returns a single character read from the stream, or -1 if the end of the stream has
been reached.

Seek
Changes the stream position.

Throws a StreamNotOpenException if the stream is not open for reading.

Syntax
public void Seek(long newPosition)

Parameters

• newPosition – The new stream position in characters. Zero represents the beginning of the
value stream.

Write
Writes a chunk of data to the stream.

Writes data to the stream, beginning at the current position. The stream may be buffered, so
use Flush or Close to be certain that any buffered changes have been applied. Throws a
StreamNotOpenException if the stream is not open for writing. Throws a
WriteAppendOnlyException if the platform only supports appending to the end of a
value and the current stream position precedes the end of the value. Throws a
WriteOverLengthException if the platform requires the length to be predetermined
before writing and this write would exceed the predetermined length.

Syntax
public void Write(string data)

Parameters

• data – The data chunk to be written to the stream.

Examples

• – Writes to the biography file, and closes the file.
Author author = Author.FindByPrimaryKey(authorID);
BigString text = author.Biography;
text.OpenForWrite(256);
text.Write("something");
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text.Close();
author.SubmitPending();

WriteChar
Writes a single character to the stream.

Writes a character of data to the stream, beginning at the current position. The stream may be
buffered, so use Flush or Close to be certain that any buffered changes have been applied.
Throws a StreamNotOpenException if the stream is not open for writing. Throws a
WriteAppendOnlyException if the platform only supports appending to the end of a
value and the current stream position precedes the end of the value. Throws a
WriteOverLengthException if the platform requires the length to be predetermined
before writing and this write would exceed the predetermined length.

Syntax
public void WriteChar(char data)

Parameters

• data – The character value to be written to the stream.

MetaData and Object Manager API
The MetaData and Object Manager API allows you to access metadata for database, classes,
entities, attributes, operations, and parameters.

MetaData and Object Manager API
Some applications or frameworks can operate against MBOs generically by invoking MBO
operations without prior knowledge of MBO classes. This can be achieved by using the
MetaData and Object Manager APIs.

These APIs allow retrieving the metadata of packages, MBOs, attributes, operations, and
parameters during runtime. The APIs are especially useful for a runtime environment without
a reflection mechanism such as J2ME.

You can generate metadata classes using the –md code generation option. You can use the –rm
option to generate the object manager class. You can also generate metadata classes by
selecting the option Generate metadata classes or Generate metadata and object manager
classes option in the code generation wizard in the mobile application project.

ObjectManager
The ObjectManager class allows an application to call the Object API in a reflection style.
The Object Manager is useful for platforms without native reflection support (such as J2ME).
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IObjectManager rm = new MyDatabase_RM();
ClassMetaData customer = MyDatabase.Metadata.GetClass("Customer");
AttributeMetaData lname = customer.GetAttribute("lname");
OperationMetaData save = customer.GetOperation("save");
object myMBO = rm.NewObject(customer);
rm.SetValue(myMBO, lname, "Steve");
rm.Invoke(myMBO, save, new ObjectList());

DatabaseMetaData
The DatabaseMetaData class holds package-level metadata. You can use it to retrieve
data such as synchronization groups, the default database file, and MBO metadata.

Any entity for which "allow dynamic queries" is enabled generates attribute metadata.
Depending on the options selected in the Eclipse IDE, metadata for attributes and operations
may be generated for all classes and entities.
DatabaseMetaData dmd = SUP101DB.Metadata;
  foreach (String syncGroup in dmd.SynchronizationGroups)
  {
    Console.WriteLine(syncGroup);
  }

ClassMetaData
The class holds metadata for the MBO, including attributes and operations.

AttributeMetaData lname = customerMetaData.GetAttribute("lname");
OperationMetaData save = customerMetaData.GetOperation("save");
...

EntityMetaData
The EntityMetaData class holds metadata for the MBO, including attributes and
operations.

EntityMetaData customerMetaData = Customer.GetMetaData();
    AttributeMetaData lname = 
customerMetaData.GetAttribute("lname");
    OperationMetaData save = customerMetaData.GetOperation("save");

AttributeMetaData
The AttributeMetaData class holds metadata for an attribute such as attribute name,
column name, type, and maxlength.

Console.WriteLine(lname.Name);
Console.WriteLine(lname.Column);
Console.WriteLine(lname.MaxLength);
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Exceptions
Reviewing exceptions allows you to identify where an error has occurred during application
execution.

Handling Exceptions
The Client Object API defines server-side and client-side exceptions.

Server-Side Exceptions
A server-side exception occurs when a client tries to update or create a record and the Unwired
Server throws an exception.

A server-side exception results in a stack trace in the server log, and a log record
(LogRecordImpl) imported to the client with information on the problem.

HTTP Error Codes
Unwired Server examines the EIS code received in a server response message and maps it to a
logical HTTP error code, if a corresponding error code exists. If no corresponding code exists,
the 500 code is assigned to signify either a Sybase Unwired Platform internal error, or an
unrecognized EIS error. The EIS code and HTTP error code values are stored in log records.

These tables list recoverable and unrecoverable error codes. All error codes that are not
explicitly considered recoverable are considered unrecoverable.

Table 6. Recoverable Error Codes

Error Code Probable Cause

409 Backend EIS is deadlocked.

503 Backend EIS is down, or the connection is terminated.

Table 7. Unrecoverable Error Codes

Error Code Probable Cause Manual Recovery Action

401 Backend EIS credentials wrong. Change the connection information, or
backend user password.

403 User authorization failed on Un-
wired Server due to role con-
straints (applicable only for
MBS).

N/A
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Error Code Probable Cause Manual Recovery Action

404 Resource (table/Web service/BA-
PI) not found on backend EIS.

Restore the EIS configuration.

405 Invalid license for the client (ap-
plicable only for MBS).

N/A

412 Backend EIS threw a constraint
exception.

Delete the conflicting entry in the EIS.

500 Sybase Unwired Platform internal
error in modifying the CDB
cache.

N/A

Error code 401 is not treated as a simple recoverable error. If the
SupThrowCredentialRequestOn401Error context variable is set to true (the
default), error code 401 throws a CredentialRequestException, which sends a
credential request notification to the user's inbox. You can change this behavior by modifying
the value of the SupThrowCredentialRequestOn401Error context variable in
Sybase Control Center. If SupThrowCredentialRequestOn401Error is set to false,
error code 401 is treated as a normal recoverable exception.

Mapping of EIS Codes to Logical HTTP Error Codes
A list of SAP® error codes mapped to HTTP error codes. By default, SAP error codes that are
not listed map to HTTP error code 500.

Note: These JCO error codes are not applicable for DOE-based applications.

Table 8. Mapping of SAP Error Codes to HTTP Error Codes

Constant Description HTTP Error Code

JCO_ERROR_COMMUNICATION Exception caused by net-
work problems, such as
connection breakdowns,
gateway problems, or un-
availability of the remote
SAP system.

503

JCO_ERROR_LOGON_FAILURE Authorization failures dur-
ing login. Usually caused
by unknown user name,
wrong password, or invalid
certificates.

401
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Constant Description HTTP Error Code

JCO_ERROR_RESOURCE Indicates that JCO has run
out of resources such as
connections in a connec-
tion pool.

503

JCO_ERROR_STATE_BUSY The remote SAP system is
busy. Try again later.

503

Client-Side Exceptions
Device applications are responsible for catching and handling exceptions thrown by the client
object API.

Note: See Callback Handlers.

Exception Classes
The Client Object API supports exception classes for queries and for the messaging client.

• SynchronizeException – thrown when an error occurs during synchronization.
• PersistenceException – thrown when trying to access the local database.
• ObjectNotFoundException – thrown when trying to load an MBO that is not inside the

local database.
• NoSuchOperationException – thrown when trying to call a method (using the Object

Manager API) but the method is not defined for the MBO.
• NoSuchAttributeException – thrown when trying to access an attribute (using the Object

Manager API) but the attribute is not defined for the MBO.
• ApplicationRuntimeException – thrown when a call to start the connection, register the

application, or unregister the application cannot be completed due to an error.
• ConnectionPropertyException – thrown when a call to start the connection, register the

application, or unregister the application cannot be completed due to an error in a
connection property value or application identifier.

Query Exception Classes
Exceptions thrown by SUPStatementBuilder when building an SUPQuery, or by
SUPQueryResultSet during processing of the results. These exceptions occur if the
query called for an entity or attribute that does not exist, or tried to access results with the
wrong datatype.

• SUPAbstractClassException.h – thrown when the query specifies an abstract class.
• SUPInvalidDataTypeException.h – thrown when the query tries to access results with

an invalid datatype.
• SUPNoSuchAttributeException.h – thrown when the query calls for an atttribute that

does not exist.
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• SUPNoSuchClassException.h – thrown when the query calls for a class that does not
exist.

• SUPNoSuchParameterException.h – thrown when the query calls for a parameter that
does not exist.

• SUPNoSuchOperationException.h – thrown when the query calls for an operation that
does not exist.

• SUPWrongDataTypeException.h – thrown when the query tries to access results with
an incorrect datatype definition.

Client Object API Usage
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